## Contents

**GETTING STARTED** ................................................................................................................. 8  
  Introduction .............................................................................................................................. 8  
  Opening the application .......................................................................................................... 9  

**FILE BASICS** .......................................................................................................................... 14  
  Overview .................................................................................................................................. 14  
  Multiple document support ..................................................................................................... 14  
  Saving files ............................................................................................................................... 15  

**MEDIA BASICS** ......................................................................................................................... 16  
  Offline Media ............................................................................................................................ 16  
  MediaLooks MultiFormat ........................................................................................................ 17  
  Media Helper Files .................................................................................................................. 17  
  Associate a media file ............................................................................................................... 19  
  Create helper files (Indexing process) .................................................................................... 20  

**SCREEN LAYOUT BASICS** ....................................................................................................... 22  
  Toolbox Collapse ...................................................................................................................... 24  
  Compact View .......................................................................................................................... 25  
  List View .................................................................................................................................. 29  
  Media timeline .......................................................................................................................... 30  
  Subtitle display ....................................................................................................................... 31  
  Timeline View .......................................................................................................................... 34  
  Video window ........................................................................................................................... 37  
  Video controls ........................................................................................................................... 38  

**CREATE A NEW SUBTITLE FILE** ............................................................................................. 40  
  Create file from shot changes / speech ................................................................................... 41  

**EDITING BASICS** ..................................................................................................................... 43  
  Navigating and selecting text .................................................................................................... 43  
  Cut, Copy and Paste .................................................................................................................. 44  
  Navigating the subtitle list ........................................................................................................ 44  
  GotoSubtitle ............................................................................................................................. 44  
  Create and delete subtitles ....................................................................................................... 45  
  Basic input keystrokes ............................................................................................................. 46  
  Find and Replace ..................................................................................................................... 47  
  Set position and justification ................................................................................................. 48  
  Lock position and justification .............................................................................................. 49  
  Raising subtitles ...................................................................................................................... 49  
  Positioning multiple subtitles ............................................................................................... 50  
  Configure the file font .............................................................................................................. 53  
  Configure the file colour ......................................................................................................... 55  
  Open a subtitle file ................................................................................................................... 58  
  Print a subtitle file .................................................................................................................... 59
ADD-ON SUBTITLES ................................................................................................. 150
OPEN / CLOSED CAPTION FILES ............................................................................ 152
  Change background effect ..................................................................................... 152
  Configure the subtitle font, style and size ............................................................. 153
  Change case ........................................................................................................... 154
  Create Open Caption subtitles in a Teletext file .................................................. 156
  Forced subtitles (Open Captioning) ....................................................................... 156
  Closed Caption editing ......................................................................................... 157

COMMENTS ................................................................................................................. 158
  Displaying comments ............................................................................................ 158
  Navigating comments ............................................................................................ 158
  Adding comments .................................................................................................. 159
  Editing comments .................................................................................................. 159
  Clearing comments ................................................................................................ 159
  Exporting files containing comments .................................................................... 160

MODES ....................................................................................................................... 160
SHORTFORMS ............................................................................................................... 161
STENOGRAPH INPUT .................................................................................................. 163
TEXT SPLITTING .......................................................................................................... 164
  Text splitting via SpeakTitle .................................................................................. 167
  Text splitting options ............................................................................................. 169

TIMECODE .................................................................................................................. 170
  Timecodes in offline subtitling ............................................................................... 170
  Timecode display .................................................................................................... 171
  Timecode status ...................................................................................................... 172
  Supported timecode formats .................................................................................. 172
  Adjust timecodes for a range of subtitles .............................................................. 172
  Clear timecodes for a range of subtitles ................................................................. 173
  Edit timecodes graphically ................................................................................... 176
  Re-Sync timecodes ................................................................................................ 177
  Sort timecodes ....................................................................................................... 177
  Timecode compression ......................................................................................... 178
  Set In and Out times .............................................................................................. 179
  Edit timecodes manually ...................................................................................... 180

TIMING RULES ............................................................................................................ 182
  Configuration ........................................................................................................... 182
  Example narrative ................................................................................................... 185

REPLAY SUBTITLES ..................................................................................................... 188
WINCAPS Q4 DVD BUILDER ....................................................................................... 188
Homophones list .............................................................................................................256
Default File Colours .....................................................................................................257
Text splitting ..................................................................................................................258
Spelling supplements .....................................................................................................259
File personality ..............................................................................................................260
Settings and data file locations ......................................................................................263
User-specific files .........................................................................................................263

EXPORT ............................................................................................................................264
Boxing .............................................................................................................................264
DLP Cinema ....................................................................................................................267
DVD Builder ...................................................................................................................269
EBU ................................................................................................................................270
FCP ................................................................................................................................272
MCA ................................................................................................................................272
SAMI ...............................................................................................................................272
Text .................................................................................................................................276
DFXP ...............................................................................................................................277
Ultech DV3000 ...............................................................................................................278
Ultech L21 .......................................................................................................................279

IMPORT ............................................................................................................................280
PAC ................................................................................................................................280
Text .................................................................................................................................281
Print options ...................................................................................................................281

VPEDAL VIDEO CONTROLLER ....................................................................................286

WINCAPS Q4 PROFESSIONAL TOOLS ......................................................................287
Speech input basics .........................................................................................................287
Configure Dragon Naturally Speaking ............................................................................290
Dragon controls ............................................................................................................291
Respeak text via integrated Dragon input .......................................................................293
Respeak Text via SpeakTitle Window .............................................................................295
Using the Aligner ..........................................................................................................298
Aligner basics ...............................................................................................................300
Enable/Disable Aligner .................................................................................................302
Section markers .............................................................................................................302
Manage House Styles ...................................................................................................305

REFERENCE MANUAL ..................................................................................................308

SYSTEM TYPES AND LICENSING .............................................................................311

TROUBLESHOOTING COMMON PROBLEMS ..........................................................312
Error 6 ............................................................................................................................312
Error 4 ............................................................................................................................312
Error 1A Clock Tampering ............................................................................................312
Video playback ..............................................................................................................313
Text splitting .................................................................313
File Export .................................................................313
Getting Started

Introduction

This is a reference guide for the Screen Systems Wincaps Q4 Subtitling Software, simply referred to as Wincaps Q4 throughout the text. To get the most out of this help you should be familiar with the use of a Windows PC and standard text processing software as well as general PC and subtitling terminology.

Wincaps Q4 comes in two main versions, Wincaps Q4 and Wincaps Q4 Pro, determined by the license.

You can see the version number and license type of your Wincaps Q4 client by selecting Help : About from the main menu:

Wincaps Q4 makes extensive use of keyboard shortcuts to speed up operations. Unless stated otherwise, number keys, mathematic symbols, Ins (0) and Del (.) refer to the numeric keypad only. Arrows, PageUp and PageDown refer to the dedicated keys and not those on the numeric keypad. You should ensure that NumLock is set "on" when working with Wincaps Q4. You should enter numbers using the top row of the standard alphanumeric keyboard. Where a shortcut requires the Alt key you cannot use the Alt Gr key.

You can contact the Screen Systems support team through the support website at www.screensystems.tv or by sending an email to subtitling.support@screensystems.tv
Opening the application

Start Wincaps Q4 by double-clicking the desktop icon. After a short pause the main window appears:

There is a menu bar at the top, and depending on your preferences there may be toolbars beneath the menu bar.

To achieve the layout as shown above, select the Configure menu item, choose Toolbars and enable All. This will cause both toolbars to be displayed while you are learning the system.

To set your preferred path for media files, select the Configure menu item again and choose Default paths... Either browse to the location of your media files or fill in the preferred default path.

Create a new file

To start working with Qu4ntum, you need to open or create a .W32 subtitle file. To create a new file, select the File menu and choose New. Give the file a name (for example SubtitleFile) and click Save.

Wincaps Q4 creates the file and then offers you the opportunity to specify the Programme, Customer and Language. This information is used to access the knowledge base for any specific spellings related to the programme, and to set the display style and timing preferences related to the customer. For now, click OK to use the default settings. We will return to these items later.
The system then opens a file browser labelled **Select Media File**. Navigate to the media file that you want to subtitle and click **Open**. Follow the steps to index the media file if necessary. When indexing is complete, the screen displays the basic “empty file” as shown below:

When a file is open, the screen layout is divided into three main areas: the media area (top left), the Toolbox (bottom left) and the subtitle and timeline display on the right.

Qu4ntum allows you to have more than one file open at a time. When you have multiple files open you can switch between them by clicking on the **file tabs** located directly above the Video Window, as shown below.
Most of the features and functions of Wincaps Q4 also have keyboard shortcuts to help speed up the process. There is a separate document installed with Wincaps Q4 and it can also be found in the Help document: Keyboard Shortcuts for Wincaps Q4.

User preferences
With a file open, you can configure your keyboard and other preferences. Select the Configure tab to the left of the Toolbox, and click on the mauve button labelled Keyboard.

Select whether you prefer to manually grab timecodes using the Numpad Ins/Del keys on their own, which means you need to use Shift Ins/Del to mark sections; or whether you prefer to mark sections using the keys on their own, in which case you use them with Shift to grab timecodes (only needed for Qu4ntum Pro)

Workflow options
Wincaps Q4 offers various workflow options for subtitle origination depending on your preference and requirements for:

- **Transcription** – using imported script, system keyboard or respeaking
- **Timecoding** – manually subtitle by subtitle, aligned section-by-section, or Fixed during replay
- **Translation** – whether the subtitles are in the same language as the audio track

The chosen workflow will depend on the type of programme being subtitled, whether working interlingually or intralingually, whether the subtitle language is supported by a speech recognition system (English, French, Italian, Spanish, German, Dutch) and/or (for intralingual work) the aligner (add Swedish and Romanian to the previous list). The recommendations below may be helpful in making the choice:

Intralingual subtitling
If an accurate script is available then use the **Script Extractor** tool to quickly separate dialogue from other script content and import it into Qu4ntum in preference to transcribing. If a transcript has to be produced, respeaking (Wincaps Q4 Pro only) is generally quicker than retyping.

If the programme audio has reasonable runs of clear dialogue and is free from invasive sound effects, and the language is supported, use the Aligner (Wincaps Q4 Pro only) for section-by-section timecoding – regardless of transcription method.
If the audio is not suitable for alignment, consider using Fix Mode timecoding during a replay pass, otherwise if no other option is suitable enter text and grab timecodes manually on a subtitle-by-subtitle basis.

Translation subtitling
If you are creating a “master file” in the same language as the soundtrack, use one of the workflows above. If the subtitles are being translated as originated, a subtitle-by-subtitle workflow with manual timecode grabbing is probably best.

Regardless of the chosen workflow, Qu4ntum can be configured to provide productivity assistance in the following ways:

Formatting and segmenting text (Text Splitting)
Adjusting timecodes to take account of shot changes, gaps and durations (Timing Rules)
Automatic colouring (Speaker List)

Template, Text Splitting and Timing Rules need to be configured before the full productivity benefits will be achieved. See the associated links.

Timing Rules
When a timecode is grabbed manually or is generated automatically by text-to-speech alignment, Wincaps Q4 can run this timecode through a set of rules to try to optimise its relationship to shot changes and adjacent subtitles. These Timing Rules are normally stored as part of the default template for the customer and so will be loaded automatically if the correct customer is selected when the job is started.

The Timing Rules can be set up or overridden for a specific file by opening the dialogue and making changes to any default values that are present. To access the Timing Rules dialogue, select the **Info** tab in the Toolbox and choose the **File Info** tab from that section. The **Timing rules** button is in the top row as shown below:

Click the button and the dialogue will appear: Enter the following values as a starting point.
Each rule can be enabled or disabled using the tick to the left of the title of the rule: **Enable all** and **Disable all** switch on or off all the ticks.

**Default subtitle display rate** sets the target rate in words per minute of characters per second/minute: the ideal display time can be changed according to the timing of surrounding subtitles.

**Maximum subtitle display rate** affects the size of the percentage steps between green (OK), yellow, orange and red (too fast) in the colour background to the reading rate display in each subtitle.

**Maximum subtitle duration** and **Minimum subtitle duration** are applied after the target rate has been calculated.

**Maximum alignment delay from section start/end** defines the amount that an automatic alignment can drift from the markers which set the start and end times for the aligned sequence. For more detail see the topic on Using the Aligner.

**Width of zone of influence before or after a shot change** defines the distance over which a shot change will exert a “snap to” pull on the In or Out time of a nearby subtitle.

Two values allow the **In time to follow** or the **Out time to precede** a shot change which causes the edge to snap to it.

The **Minimum gap between two successive subtitles** corrects the timecodes to ensure that the specified number of clear frames are left between subtitles when they are adjacent. The **Width of exclusion zone** affecting this gap defines the gap which is not allowed - i.e. either the gap is the fixed minimum value or it is greater than the exclusion value.

The rules also incorporate implicitly the concept of **magnetism**: Two subtitles which are separated by the minimum gap behave as if they are magnetised, so within...
reason if the Out time of the first or the In time of the second is changed, the other follows it and maintains the same spacing.

Application of the Timing Rules
The Timing Rules are designed to summarise all of the various “pulls” on a timecode based on its relationship to shot changes, other subtitles, and the effect on reading speed and duration. The rules are applied every time a subtitle timecode is changed, other than when that change is signalled as being explicit (i.e. it overrides the rules) or an offset is being applied. So if the Aligner creates timecodes based just on speech alignment, they are then run through the Timing Rules. If you grab a timecode or click and drag a subtitle or one of its edges in the Timeline View, the change will be run through the Timing Rules unless you hold down the Ctrl key to signify it as being explicit. If you type in a timecode value, or nudge an existing value, it will be regarded as an explicit change and not subject to the rules.

Because there are a number of possibly competing factors involved, the Timing Rules are applied in sequence and the end result is often a compromise between different parameters. It is not of course mandatory to have all the rules enabled, and you can if you wish restrict the items which are in play. Using the suggested starting values, see Timing Rules Example Narrative for an explanation of how the parameters are applied.

## File basics

### Overview

**Subtitle files** lie at the heart of the Wincaps Q4 system. A Wincaps Q4 subtitle file has the extension .W32 and has the same proprietary format as WinCAPS Multimedia, meaning that Wincaps Q4 can open any existing W32 files from the earlier system.

Wincaps Q4 can import or insert subtitles from other formats (e.g. STL/EBU files) into an existing W32 file containing customer template information. You can also open files in other formats directly, converting them into W32 files in the process. Similarly, Wincaps Q4 can export the finished subtitles to a variety of other formats or interface directly with the DVD Builder to generate bitmaps and control files for use by DVD authoring systems.

### Multiple document support

Wincaps Q4 allows you to open multiple subtitle files and switch between them by clicking on the **file tabs** located above the Video Window as shown in the illustration below:
You should avoid having too many files open at the same time since this may have an adverse impact on system performance.

**Saving files**

Wincaps Q4 does not have an explicit "File Save" capability for subtitle files. Instead, Wincaps Q4 automatically saves your changes as you go along. In other words, as soon as you move from one subtitle to another or create a new subtitle, all changes made to the previous subtitle are automatically written to the file. Wincaps Q4 also saves the file automatically before closing it.

Note that because Wincaps Q4 saves changes automatically, it is not possible to "close the file without saving" in order to back out of an unintended operation that can't be undone. However, you can take periodic manual backups of the file as you go along and revert to one of these backups if required. In addition, Wincaps Q4 takes an automatic backup whenever you perform an operation that makes extensive changes to the file.

**Backup**

You can manually save a version of the file using the Backup feature using Ctrl+S.

See Automatic Backup for the explanation on how to restore previous versions.

**Saving a file with a different name**

You can make a copy of the current file by selecting **File : Save As** from the main menu or by clicking the **Save As** button on the File toolbar. Qu4ntum will prompt you for the location and name of the new file. After you click **Save**, the new file becomes the current document.
Media Basics

Video playback is an essential part of a modern subtitling application. Wincaps Q4 supports a variety of common low resolution digital media file formats as well as the ability to overlay video from an external video source when used with a suitable hardware. Wincaps Q4 provides an excellent representation of the subtitles overlaid on the video window.

When subtitling a program news clip, the associated video is normally provided in the form of digital media. Wincaps Q4 supports a variety of common low res video file formats (and some higher resolution depending on PC processing power) using two video playback options (see below), including:

- MPEG1 (.mpg)
- MPEG4 (.mp4)
- QuickTime (.mov)
- Windows Media Video (.wmv)
- MXF

Note: It is not unusual for only one of the two video playback options, Offline Media and MediaLooks MultiFormat to work on a video file, so always use the one that works best.

While most video media files that play in Windows Media Player and QuickTime also play in Wincaps Q4, there may be some Media encodings that will not be supported. Typically these are HD or high resolution media which require too much processing, less frame accurate media, such as those created using non-professional encoding/transcoding tools or encodings that require proprietary codecs, such as MPEG2. Note that if a particular media file will not play back in either engine then it is unlikely that it will play in Wincaps Q4.

Wincaps Q4 also requires an external standalone professional quality (minimum 256 MB) graphics card for video playback, particularly for WMV encodings as on-board graphics cards can struggle with frame-by-frame video playback.

When a file is created there is a prompt to associate the video;

Offline Media

Wincaps Q4 uses standard Windows DirectShow techniques to display MPG and WMV media. These are typically installed as standard with Windows.
To display MOV and MP4 media, the Apple QuickTime player must be installed on the host PC.

Note regarding QuickTime support: From April 2016, Apple have stated that they will not support QuickTime on Windows Operating Systems.
**MediaLooks MultiFormat**

Wincaps Q4 has introduced a new alternative to Direct Show and QuickTime support, using MediaLooks MultiFormat for the indexing and playback of media files if required. MediaLooks supports the same formats as the Offline Media option, and will also support some extra formats, including:

- MXF
- TS
- ASF
- M4V
- MPEG-2

ℹ️ Note: We have not been able to test out these formats. Please also note that the same restrictions as mentioned in the overview regarding resolution etc may still be relevant with these formats.

**Media Helper Files**

Wincaps Q4 makes use of **helper files** in order to provide frame-accurate display, single-frame stepping and audio scrubbing. Each media file requires an associated set of helper files that are created by processing the media file. This only needs to be done once for each media file. The helper files should be located in the same folder as the media itself and named the same as the original media file. Depending on whether you use 'Offline Media' or MediaLooks MultiFormat, they comprise:

- `.ind/medialooks.ind` - Video frame index
- `.aul/medialooks.aul` - Audio level
- `.soi/medialooks.soi` - Speech presence (Offline only)
- `.scd/medialooks.scd` - Shot changes
- `.wav/medialooks.wav` - Audio wave data
- `.tcc` Timecode offset information
- `.grf/medialooks.grf` - Codec diagnostic file (for Support purposes only)

The helper files may be provided to you along with the media. If Wincaps Q4 opens a media file and does not find the corresponding helper files you will be prompted to create them via the media indexing process.

ℹ️ Note: If you decide to re-index for any reason, then it is recommended to delete the current helper files.

If you are using MediaLooks MultiFormat for video playback and have Helper Files created with Offline Media, these will not work and Wincaps will prompt to re-index the video file with MediaLooks MultiFormat.
If a media file has **embedded timecode** then this will be used to automatically generate the frame index. Where a media file has no embedded timecode, you will be prompted to synchronise the helper files to the **burnt-in timecode** during the indexing process.

The synchronisation process may be re-run at any time via the **Toolbox->File Info->Media->Video sync** button. This is particularly useful if the helper files supplied with the media do not quite match up with the burnt-in timecode.

**Note:** MediaLooks MultiFormat cannot read Offline Media Helper Files and will prompt to create new Helper Files when opening a previously indexed with 'Offline Media' Helper File.

**Multiple audio tracks**

If a media file contains multiple audio tracks then the audio track drop-down will be enabled:

Select the audio track that you want to use. The media indexing process will only index the first audio track by default. If you select an audio track that has not previously been indexed you will be prompted to index it. When you switch audio tracks, the audio waveform section of the media timeline will be updated with the new audio data.

**Note:** The MediaLooks MultiFormat option in Wincaps Q4 does not support multiple audio tracks.
Associate a media file

This article describes how to associate a media file with the current subtitle file (Wincaps Q4 offline) or story (Q-Live).

In Wincaps Q4 Offline, a subtitle file has a single media file associated with it. In Q-Live, each story may have a different media file. Once a media file has been associated, it will be loaded automatically the next time you open the subtitle file (Wincaps Q4 Offline) or select the associated story (Q-Live).

If you have multiple files open, each file may have its own media associated and the active media will change automatically as you switch between documents.

Note that if your system has an overlay card installed, Wincaps Q4 will display an additional prompt that allows you to choose between displaying a media file or the external video input.

You associate a media file as follows:

Start with the subtitle file open (Q4antum offline) or with the relevant story or stories selected (Q-Live).

Click the Toolbox→Info→File Info→Media→Wizard button to launch the media wizard

Select either Offline Media, recommended for Mpeg-1 and WMV or MediaLooks MultiFormat, recommended for MP4, MOV and other supported formats.
If the subtitle file/story already has a media file associated with it you will be given the chance to cancel the operation
Browse to the media file and click Open

If the chosen media has helper files then the video will open.

You can configure the default location where Wincaps Q4 looks for the media files via the Configure : Default paths menu.

Synchronise the helper files to the burnt-in timecode
The Video Timecode dialog allows you to synchronise the media helper files to the burnt-in timecode. This dialog may be displayed in two situations:

If the media file is being indexed by Wincaps Q4 has no embedded timecode, it will be displayed automatically as part of the indexing process
If the helper files supplied with the media do not match the burnt-in timecode, you can synchronise them manually via the Toolbox→File Info→Media→Video sync button
To synchronise the media with the helper files, select the correct frame rate for the media from the drop-down list. Then advance the video a few frames, as the first few frames of a video are often duplicate. Once the burnt-in timecode looks reliable, enter its current value into the Current Timecode box and click OK.

Note: It is important to make sure that the frame rate you set matches that of the Video itself. If indexing takes place with an timecode that doesn't match the video, you will need to delete the TCC file (which will be located in the same place as your video) and re-index with the correct timecode.

Create helper files (Indexing process)

If Wincaps Q4 cannot locate one or more of the helper files in the same folder as the media, you will be asked if you want to create them. Note that if you choose not to create the helper files or cancel the indexing process at any stage, the media timeline information will not be available.

If the media file being indexed has no embedded timecode, Wincaps Q4 will prompt you to synchronise the helper files to the burnt-in timecode.

For MOV media using 'Offline Media' there will be an initial delay whilst Qu4ntum exports the WAV file information. It will then index the file, displaying the following progress screen:
Using MediaLooks MultiFormat the dialog is slightly different:

Any errors encountered during the indexing process will be displayed in this window. If no errors occur, you will see a "success" message and the media timeline information will be displayed.

Note: It is important to make sure that the frame rate you set matches that of the Video itself. If indexing takes place with a timecode that doesn't match the video, you will need to delete the TCC file (which will be located in the same place as your video) and re-index with the correct timecode.

View media file details
You can view the details of the currently assigned media and helper files by clicking the Toolbox->Info->File Info->Media->Files button.

Click on Clear media/Disassociate to disassociate the current media from the subtitle file/current story. Click on Regenerate Helper Files to rerun the indexing process on the selected Video.

The green ticks indicate that the relevant file is present.

The values on the right represent;

For Index, it is the number of 'records' which is typically the number of frames in the video.
For Shot Changes, it is the number of shot changes located on the video.
For Speech Onset, it is the number of 'speech blobs' located by audio software, in the video.
Screen Layout Basics

The illustration below shows Wincaps Q4’s general screen layout:

Wincaps Q4 has three main screen areas:

- **Video window** - located in the upper-left quadrant, displays the video media and associated controls
- **Subtitle view** - located on the right, displays the subtitles in one of three possible Views: **List, Timeline/News** or **Compact**.
- **Toolbox** - located in the lower-left quadrant, provides different functions depending on the workflow context

When the **List** (Wincaps Q4 Pro only) or **News View** is active, the lower area is occupied by the **SpeakTitle window** used for speech input

The **document tabs** allow you to switch between open documents by clicking on the desired tab.

In the **List View** and **Timeline View**, Wincaps Q4 displays a media timeline to the left of the subtitle displays. The **current subtitle** (for editing and display purposes) is indicated by a brown background.

Menus, toolbars and a status bar are also provided in the normal way.

The screen areas are separated by **splitter bars** that you can drag in order to resize the different areas of the screen as desired. The chosen positions will be saved.
between sessions, as will the size and state of the main Wincaps Q4 window itself.

Subtitle views
The right hand area of the screen is occupied by the subtitle view. Subtitles can be created, added, edited and generally managed in this window, in much the same way as managing a file in a word processor application. Wincaps Q4 provides many common keyboard combinations and operations for working with the subtitle file. Subtitles are displayed in the form of a numbered list and can be navigated using familiar methods with both mouse and keyboard.

You can view the subtitles in various different ways:

List View - subtitles are displayed in a uniform list with audio timeline information, used when creating and aligning subtitles
Timeline View - subtitles are proportionately aligned against the full timeline, used to refine and check subtitle timings and display
Compact View - subtitles are shown in a simple list for easy proofreading, allows you to select and modify multiple subtitles

Keyboard navigation
Press the **Esc key** to move focus between the different main areas of the screen.

Press **Alt 1**, **Alt 2** or **Alt 3** to move the focus directly to the corresponding subtitle view.

Status bar
The status bar provides status information and guidance messages.

**Status message** shows context-sensitive status and error messages
**Active voice profile** shows the name of the currently loaded speech engine voice profile
**Customer name** shows the customer that the current file is being produced for
**Programme name** shows the name of the programme associated with the current file
**Language** shows the language of the current file
**Personality** shows the personality of the current file
**Screen position** shows the on-screen position of the top-left corner of the current subtitle in display units or pixels
**Dimensions** shows the on-screen size of the current subtitle in display units or pixels
**Subtitle number** shows the index number of the current subtitle
**Video standard** shows the broadcast video standard associated with the current file
Keyboard **INS/OVR** shows the keyboard insert/overwrite state

**Stenograph status** shows the current status of the Stenograph input device

**DataStore status** shows the current status of the DataStore connection

**Toolbox Collapse**

The subtitle file or Rundown can also be displayed across the whole application by collapsing the Toolbox and Video Window. Go to the menu bar and select Configure> Toolbox Collapse.

This is useful for creating or comparing Translation files.
Compact View

The Compact View allows you to easily proof-read the subtitle text and lets you select multiple subtitles at a time in order to change properties such as colour and position.

In Wincaps Q4 the compact view shows all subtitles in the file

You would typically use the compact view to:

- Make minor changes to the text of individual subtitles
- See check failure locations
- Correct spelling mistakes
- Keep or change homophones/House Styles
- Change the position/justification of subtitle text
- Change the subtitle text colour
- Change the text case
- Copy, paste or delete a range of subtitles
- Perform summary functions and other operations that work on a range of subtitles
- Change the font and background styles for a range of subtitles
- Edit properties for a range of subtitles
- Print a range or selection of subtitles
- Export a range or selection of subtitles
- Run checks on a range or selection of subtitles
- Perform a Find and Replace operation on a range or selection of subtitles
- Change the font and background styles for a range of subtitles
- Edit properties for a range of subtitles
- Print a range or selection of subtitles
- Export a range or selection of subtitles
- Run checks on a range or selection of subtitles
- Perform a Find and Replace operation on a range or selection of subtitles

You would not normally use the compact view for more extensive editing operation such as splitting/merging subtitles or capturing/editing timecodes which are best done in the Timeline View or List View.

The Compact View looks like the illustration below:
Subtitles are displayed as a single row of text for simplicity. The current subtitle is shown with a brown background and is always located in the middle of the list. Any proofing errors are shown with different styles of underline. The grey area to the right of the subtitle text contains the subtitle number and check error lights.

You can change the display settings to alter the size of the subtitle text to improve readability. You also have the option to filter the display of subtitles in the Compact View in order to view only those subtitles with particular attributes of interest.

Navigation
Click on a subtitle to make it the current subtitle. You can use the Page Up and Page Down keys to move to the previous/next subtitle. Additional subtitle navigation keys are described here.

You can double-click on a subtitle and Wincaps Q4 will switch to displaying it in the List View.

Editing subtitles
You can edit the subtitle text using most of the normal editing keystrokes available in the Timeline or List Views.

Spelling errors, homophones and House Styles will be underlined after running the corresponding proofing check. You can use the right-click menu to correct spelling and keep or replace homophones/house styles.

Selecting subtitles
The Compact View allows you to perform operations on entire subtitles, either a single subtitle, a range of consecutive subtitles or a marquee selection of individual subtitles. You can select the subtitles to work with as follows:

To select a **single subtitle**, hold down Ctrl and click on it
To select a **range of subtitles**, click on the first subtitle and hold down Shift, then click on the last subtitle
To **marquee select** individual subtitles, hold down Ctrl and click on each subtitle in turn
To quickly select **all subtitles**, press Ctrl A
To select all subtitles from **current to start of file**, press Shift Home
To select all subtitles from **current to end of file**, press Shift End

Once a selection is made the background of all selected subtitles will change to blue as shown in the illustration below:

| She’s in the Caribbean to regain a lost world record. | 11  |
| One of her rivals recently hit 138 metres. | 12  |
| Now Tanya needs to go deeper | 13  |
| and the warm, clear waters are ideal for setting the score. | 14  |
| Tanya Streeter’s assault on the world record | 15  |
| is being masterminded by her manager and husband Paul. | 16  |
| We started out in Free Diving with him offering me no support, | 17  |
| absolutely not interested, nothing at all. | 18  |
| And it’s taken us a lot to get to the point where we are now, | 19  |
| where we work together and where I trust him implicitly. | 20  |
| Dive safety is Paul’s ultimate responsibility. | 21  |

To cancel a selection, simply change the active subtitle by clicking on a different
subtitle or using the **Page Up/Page Down keys**.
Cutting, copying, pasting and deleting subtitles
To use these functions you must first select one or more subtitles to work with as described above.

To cut the selected subtitles, Press **Ctrl X**
To **copy** the selected subtitles, press **Ctrl C**
To **paste** the copied subtitles, select (i.e. by Ctrl-clicking) the subtitle after which you want the pasted subtitles to appear and press **Ctrl V**
To **delete** the selected subtitles, press the **Delete key**

Wincaps Q4 will prompt you to confirm these operations as they cannot be undone.

The cut, copy and paste functions are also available via the right-click menu.

**Changing properties of multiple subtitles**
When a selection of subtitles is active, pressing the **position** and **colour keys** will affect all the subtitles in the selection.

The following keypad operations affect all selected subtitles:

**Colour selection keystrokes** (7 / 8 / 9 / / * plus **Shift** and **Ctrl** variants)
**Horizontal position keystrokes** (1 / 2 / 3)
**Horizontal justification keystrokes** (Shift 1 / 2 / 3)
**Raise position** (Enter / Shift Enter)

Note that the colour operations will only modify the selected subtitles, i.e. if a selected subtitle contains part of a sentence and the rest of the sentence is contained in unselected subtitles then only the colour of the selected subtitle will change even if the chosen keystroke would normally operate on the entire sentence.

You can also use the right-click pop-up menu to quickly change attributes of selected subtitles.

- **Cut Subtitles**
- **Copy Subtitles**
- **Paste**
- **Text Case**
- **Word Count**
- **Total Duration**
- **Background effect**
- **Font**
- **Colour**
- **Compact subtitle**

Background effect... - change the background effect for the selected subtitles (Open Caption subtitles only)
Font... - change the font, size and style of the selected subtitles (Open Caption subtitles only)
Colour... - change the foreground and background colours of the selected subtitles...
The following operations automatically use the current range or marquee selection when invoked from the Compact View:

Summary functions (word count and total duration)
Timecode Offset and Status (Ctrl Shift O)
Clear timecodes
Change case (Ctrl M)
Clear all forced subtitles
Print subtitles (Ctrl P)
Export subtitles

Creating a new subtitle at the start of the file
You can use the Compact View to create a new subtitle at the start of the file. Right-click on the first subtitle and select **Compact subtitle : Subtitle Before**... from the pop-up menu.

The new subtitle will be given a floating In time of 00:00:00:00.

Display settings
For ease of viewing, you can change the size of the font used to display the Compact view text by right-clicking on any subtitle and selecting **Display Settings : Text Increase/Text Decrease** from the pop-up menu. Qu4ntum will remember this setting between sessions.

Filtering the subtitle list
You can use the optional filter to display a particular subset of the subtitles in the Compact View. To activate the filter, right-click on any subtitle and select **Compact Subtitle : Filter**... from the pop-up menu. The **filter subtitles** controls appear at the bottom of the compact view as shown below:
The available filter options are as follows:

**Personality**: Display only those subtitles with a particular personality (useful when working with mixed-personality files)

**Forced**: Filter subtitles by the state of the Forced flag (useful when performing dual Open Caption output and you want to export subtitles of one type only).

You can use the **Default** button to quickly reset all filters to the "All" state.

### List View

The List View displays the list of subtitles alongside a compact media timeline. You would typically use the List View to:

- Originate subtitles via keyboard input
- Originate subtitles via Speech Input (**Wincaps Q4 Pro only**)
- Import, split and reformat subtitles
- Define sections to perform automatic timing of subtitles using the Aligner

The List View is shown in the illustration below:

The List View consists of the compact media timeline on the left and the subtitle displays on the right. At the bottom of the List View is the **SpeakTitle Window** (**Qu4ntum Pro only**) which is used for speech input. The subtitles are displayed in a simple list with each subtitle having a fixed height depending on the number of rows it contains.

The full set of subtitle editing features is available in the List View. The **current subtitle** is highlighted in brown and is always centered in the display unless the vertical scroll bar is moved (see below). Timecodes can be grabbed from the
current media position or entered manually.

In the List View, the subtitle list is not coupled directly to the media timeline as it is in the Timeline View. This means that you can scroll through the subtitle list without changing the current media position.

Navigation
There are several different ways of navigating the subtitle list.

The **vertical scroll bar** allows you to quickly and easily view any part of the subtitle list. The current subtitle (shown in brown) won't change as a result of scrolling the display in this way and nor will the current media position. You can click on any subtitle to make it the current subtitle at which point it will be centered in the display.

You can use the **Page Up** and **Page Down keys** to move to the previous/next subtitle. With the media paused, you can change the current media position in several ways:

- Dragging the **timeline slider** - click the blue line of the slider and drag it to the top or bottom of the timeline to move the video to that position
- Clicking anywhere inside the timeline area will jump the media to that position

You can also move the media position using the video control keystrokes.

- **Ctrl Shift J key** will jump the video to the in-time of the current subtitle.
- **Ctrl J key** will leave the media position unchanged and select the subtitle that is nearest to it.

**Media timeline**

The **media timeline** provides you with a visual representation of the video file, giving you instant visibility of shot changes, audio level and speech presence. When you play the video, the **timeline slider** moves down the timeline showing you the exact position of the current video frame in relation to the timeline.
The illustration above shows the elements of the full media timeline in the Timeline View. The compact timeline used in the List View omits the ruler and the shot change thumbnails but otherwise works in the same way.

**Ruler** - the orange ruler shows timecode values at regular intervals on the timeline

**Timeline slider** - the slider shows the current position of the video playback, i.e. the position that corresponds with the current frame displayed in the Video window. You can click on the slider and drag it backwards and forwards along the timeline

**Audio waveform** - the yellow area shows the level of the audio signal

**Speech block** - the green rectangles indicate where speech is present in the audio track *(Offline only)*

**Shot change** - shot changes are indicated on the timeline using an alternate light/dark grey background. The Timeline View also plots a thumbnail of the first frame of each shot change

**Section markers** - the blue lines show the locations of section start/end markers used by the background Aligner

**Subtitle In/Out times** - in the Timeline View, subtitles are displayed as dark grey rectangles with the top and bottom edges showing the In and Out times respectively

**Graphical subtitle display** - Gives a graphical representation of the subtitle in the timeline.

### Subtitle display

Subtitles are represented by **subtitle displays** which may take different forms.

Wincaps Q4 uses the following subtitle display to show the text, timecode and status of each subtitle in the Timeline and List Views:

The text of the subtitle is shown along with its colours and any bold/italic/underline markup. If the current subtitle has a comment it will be displayed above the subtitle text.
The controls function as follows:

**Subtitle number** - the sequence number of the subtitle in the file/story
**Scene marker indicator** - shows that the subtitle is the start of a new scene
**Comment indicator** - shows that the subtitle has a comment
**Row length** - shows the number of characters in the current row (turns red if maximum row length is exceeded)
**TX disabled indicator** - shows that the subtitle is marked as being disabled from transmission
**Display rate** - the reading rate as calculated using the current timing rules. The background colour indicates if the reading rate is acceptable.
**Forced indicator** - the F symbol shows that the subtitle is forced (Open Caption personality only)
**Add-on indicator** - the + symbol shows that the subtitle is part of an Add-on (Teletext personality only)
**Row position** - the vertical position of the subtitle in rows (r20 = row 20 for Teletext personality) or pixels (for Open Caption personality) from the top of the screen
**In time** - the in time of the subtitle.
**Out time** - the out time of the subtitle
**Duration** - the duration of the subtitle
**Check error lights** - light up if the subtitle fails one or more checks
**Raise indicator** - the vertical raise position of the subtitle in rows from the bottom of the screen (b+x) or from the top of the screen (t+x)
**Lock indicator** - shows that the subtitle is locked for editing by another user
**Transmission indicator** - shows that the subtitle has been transmitted to air

Timecode display
The **In time** and **Out time** of the subtitle are displayed as **HH:MM:SS:FF** (hours:minutes:seconds:frames). The background colour indicates the timecode status as follows:

- **Yellow** - floating timecode
- **White** - fixed timecode
- **Green** - explicit timecode

The **duration** value will turn red if Wincaps Q4 detects a timecode overlap.

Check error lights
The check error lights indicate if the subtitle has failed one or more checks as follows:

- **Red** - timing check(s) failed
- **Orange** - presentation check(s) failed
- **Yellow** - proofing check(s) failed

If no checks have failed for a particular category the corresponding light will be grey.

Navigating the subtitle display
The subtitle text and comment fields and the three timecode fields may all be edited directly. Simply click inside the desired field or use the **Tab key** and **Shift Tab key** to cycle the input focus through the available fields.

Note that the Tab key can be optionally reconfigured to reformat the subtitle text instead of navigating the subtitle display.

Display settings
The WYSIWYG option (accessed via the right-click menu) allows you to view the subtitle text in one of two ways:
1) With the WYSIWYG option enabled, text is displayed with the actual point size and position, as shown below:

The non-WYSIWYG display mode is useful in situations where the WYSIWYG font size and/or positions make the text difficult to see, most noticeably when using high definition video.

Note that the video window will always show the current subtitle overlay in WYSIWYG mode, irrespective of this setting.
You can change the size of the font used to display non-WYSIWYG text via the Text Increase / Decrease options. Selecting Default returns the text size to its default setting.

Wincaps Q4 automatically remembers your choice of WYSIWYG / non-WYSIWYG display mode and text size between sessions.

**Timeline View**

The **Timeline View** gives you an immediate graphical representation of the subtitles plotted alongside the media timeline. You would typically use the Timeline View to:

- Fine tune the subtitle timings
- Check the file for errors
- Replay subtitles against the media

The Timeline View appears as shown below:

The Timeline View consists of the media timeline on the left and the subtitle displays on the right. The in times and out times of each subtitle are plotted accurately against the timeline such that you can immediately see the relative durations of the subtitles by comparing the heights of the subtitle displays. You can also see immediately where the subtitles fall in relation to shot changes and speech presence.
You can edit subtitle text directly in the Timeline View. The current subtitle is highlighted in brown. Timecodes can be grabbed from the current media position or edited manually. You can also use the mouse to move and resize subtitles graphically.

The Timeline View display is closely linked to the media file. Essentially the Timeline View gives you a window on that section of the media timeline around the current video frame, shown by the position of the timeline slider. As you play the video, the timeline slider moves down the screen. When it reaches the bottom, the display scrolls to show you the next section of the media and the timeline slider jumps back to the top of the timeline display.

Navigation
With the video paused, there are several different ways of moving around the timeline.

The vertical scroll bar allows you to move quickly and easily to any part of the timeline display. The current video position will move as you scroll through the timeline but the current subtitle (shown in brown) won't change.

You can also scroll the display by dragging the timeline slider. Click the knob of the slider and drag it to the top or bottom of the screen to scroll the display up or down.

Clicking on the ruler jumps the media to that position. Clicking on a shot change thumbnail jumps the media to the start of the shot change.

Click on a subtitle to make it the current selection. This will not cause the timeline slider to move unless the display needs to scroll to bring the subtitle fully into view, at which point Qu4ntum centres the current subtitle and the timeline shifts accordingly. You can use the Page Up and Page Down keys to move to the previous/next subtitle and the timeline display will scroll as necessary to keep the current subtitle in view. Additional subtitle navigation keys are described here.

You can also move around the timeline using the video control keystrokes. The Ctrl J key selects the subtitle nearest to the current video position and the Ctrl Shift J key to jump the video to the in time of the current subtitle.

Zoom
The zoom slider (located at the bottom of the Timeline View) allows you to expand and contract the timeline, allowing you to zoom in to see more detail or zoom out to view more subtitles at once.

You can set the zoom level between 0 and 10 by dragging the zoom slider. The default zoom setting is "6", as shown in the illustration at the beginning of this topic.

Dragging the zoom slider two notches to the left (i.e. to the "4" position) will increase the number of displayed subtitles as shown below:
Conversely, setting the zoom level to "8" by dragging the slider to the right allows you to view the current subtitle in close-up, as the following illustration demonstrates.
**Video window**

The video window is a subtitle preview area that displays the subtitles superimposed over the video media or external video overlay input. The representation of the output is indicative of what will be seen on air, but is not absolutely accurate. If a file/story has a media file associated with it, the video will be loaded automatically when you open the file (Wincaps Q4 Offline) or select the story (Q-Live). If no media is associated with the current file/story, the display will be blank.

The video window is scaled appropriately for the prevailing media format (e.g. 4:3 or 16:9) as defined by the personality of the subtitle file.

When a media file is open, the timecode display shows the timecode of the current video frame in *hours : minutes : seconds : frames.*

**10:10:41:07**

Wincaps Q4 uses the timecode displayed here for all timing-related operations. This timecode should match up with the burnt-in timecode (BITC) shown on the video (if present). If Wincaps Q4’s timecode display does not match the BITC you can apply a corrective offset via the Video Sync button.
Video controls

Wincaps Q4 provides a comprehensive set of features for controlling the media file playback as shown in the table below. Note that these controls have no effect if external video overlay is being used.

You should ensure that NumLock is set "on".

<table>
<thead>
<tr>
<th>Operation</th>
<th>Keystroke</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| Play/Pause                       | 5             | ![Play/Pause](Image) | Play video clip at normal speed (with audio)  
Select and open video file if no subtitle file loaded |
| Go to Start                      | Ctrl Shift 4  | ![Go to Start](Image) | Jump back to start of video clip                                                              |
| Go to End                        | Ctrl Shift 6  | ![Go to End](Image) | Jump to end of video clip  
Close video file if no subtitle file loaded (if at end of clip)                              |
| Play Slow                        | Shift 5       | ![Play Slow](Image) | Play at half normal speed (pressing Play/Pause returns playback to normal speed)            |
| Step Back/ Rewind                | 4             | ![Step Back/Rewind](Image) | When video is paused, step back one frame (with audio)  
When video is playing, rewind X2/4/8 (press again to increment)                             |
| Frame Forward/ Fast Forward      | 6             | ![Frame Forward/Fast Forward](Image) | When video is paused, step forward one frame (with audio)  
When video is playing, fast forward X2/4/8 (press again to increment)                      |
| Video slider                     |               | ![Video slider](Image) | Drag slider to move quickly to any position in the media                                      |
| Back Frames                      | Shift 4       | ![Back Frames](Image) | Jump back video 10 frames *                                                                     |
| Back Seconds                     | Ctrl 4        | ![Back Seconds](Image) | Jump back video 3 seconds *                                                                    |
| Forward Frames                   | Shift 6       | ![Forward Frames](Image) | Jump forward video 10 frames *                                                                  |
| Forward Seconds                  | Ctrl 6        | ![Forward Seconds](Image) | Jump forward video 3 seconds *                                                                  |
| Full Screen                      | Alt Return    | ![Full Screen](Image) | Switch to full-screen display (use Alt Return or Esc to exit)                                 |
| Back Seconds and play            | Ctrl 5        | ![Back Seconds and play](Image) | Jump back 5 seconds and play *                                                                  |
| Back Seconds and pause           | Ctrl Shift 5  | ![Back Seconds and pause](Image) | Jump back 5 seconds and pause *                                                                 |
| Jump video to Subtitle in-time   | Ctrl Shift J  | ![Jump video to Subtitle in-time](Image) | Jump the video to the in-time of the current subtitle                                          |
| Jump video to Subtitle out-time  | Ctrl Alt J    | ![Jump video to Subtitle out-time](Image) | Jump the video to the out-time of the current subtitle                                          |
| Jump subtitle to video           | Ctrl J        | ![Jump subtitle to video](Image) | Jump the subtitle list to the subtitle with the closest in-time to the current video position |
| Jump video to Subtitle in-time   | Ctrl Enter or Enter | ![Jump video to Subtitle in-time](Image) | Jump the video to the in-time of the current subtitle and play the video                      |
You can close the current media file by right-clicking in the Video window and choosing **Close** from the pop-up menu. The media remains attached to the file/story and can be reopened by pressing **Play**.

As noted, most of the video controls have keyboard shortcuts for speed of operation.

* The back/forward frames/seconds functions have configurable jump times. You can set these values via the Video Jump user preferences.

** These buttons are located on the Sync toolbar.

*** These operations may be mimicked using an optional VPedal foot pedal device if desired

**** You can choose to use the **Enter** key instead of **Ctrl Enter** by changing your keyboard preferences.

If the media contains multiple audio tracks then the audio track drop-down will be enabled:

Select the audio track that you want to use. If the selected track has not been indexed you will be prompted to index it.

Media display options
You access the media display options by right clicking inside the video screen.

The **safe area** border display can be toggled on/off by selecting the **Show safe area/baseline in edit mode** option. The safe area border is normally green, turning red if the current subtitle goes outside the safe area. The safe area displayed for open caption personality and mixed personality files. If an optional baseline has been specified, the safe area border will normally be blue, turning red if the current subtitle goes outside of the baseline area.

You can choose to show or hide the subtitle text by selecting the **Hide subtitle** option or by pressing the **Ctrl W** key. For 16:9 media you can choose between various **widescreen** and **letterbox** presentation options as desired.
Create a New Subtitle File

This topic describes how to create a new blank offline (W32) subtitle file.

You can create a new blank subtitle file in any of the following ways:

Select *File : New* from the main menu
Press the *Ctrl N* key
Click the *File New* button on the File toolbar

You can pre-configure the folder where you want to create the file using the Default file Path.

Creating a subtitle file is a three-step process:

Choose a file name
Select the Programme, Customer and Language for the new file
Associate a media file using the Media Wizard

These steps are described in detail below.

Step 1: Choose a File Name
A standard Windows dialog is displayed. Browse to the folder where you want to create the new file. Note that Wincaps Q4 will remember the last directory you browsed to.

In the *File name* field, enter a name for the new file and click the *Save* button.

Step 2: Select the Programme, Customer and Language
Wincaps Q4 then displays the Select Programme and Customer dialog as shown here:

Choose a Programme and Customer from the drop-down lists or create a new programme or customer as appropriate. Wincaps Q4 defaults to the last programme and customer you selected.

Choosing a programme will automatically activate the correct spelling supplement and load the speaker list template for that programme, if defined. If you create a new programme then the spelling supplement and speaker lists will be empty.

Choosing a customer will cause the new file to be created using the appropriate customer template. This means that the properties and parameters of the subtitle file (e.g. default positioning, Timing Rules) will be automatically configured with the correct settings for the chosen customer. Note that if you choose to create a new customer, the template will be blank and Wincaps Q4 will use internal defaults for the file properties and parameters.

Finally, choose a language for the new file. Wincaps Q4 defaults to the last language you selected but you may choose from any supported language.

Click on OK to continue. Wincaps Q4 loads the relevant information from the DataStore based on your selections and then displays the Select Media File dialog.

Step 3: Associate a media file using the Media Wizard. Wincaps Q4 now launches the Media Wizard which guides you through a series of steps to choose a video file and attach the corresponding index, shot change and audio helper files or create them if they do not already exist.

Once you have selected the media file and the necessary helper files have been loaded or created, Qu4ntum displays the new blank subtitle file ready for use.

Create file from shot changes / speech

This topic describes how to create subtitles automatically using shot change or speech presence information derived from the associated media file.

Wincaps Q4 creates blank subtitles at each shot change or speech onset point. The subtitle In times are fixed to the shot change / speech onset points and any Timing Rules automatically applied. The Out times are simply floated based on the minimum
To create the file, use the following steps:

Create a new subtitle file and associate a media file in the normal way.
From the Tools menu, select **Create file From Speech Onset** or **Create File From Shot Changes** as desired.
A warning is displayed to indicate that any existing subtitles in the file will be lost.
Click **Yes** to continue.
A processing dialog is displayed as the subtitles are created.
The file now contains blank subtitles aligned to the speech onset markers or shot changes.

The following illustration shows a file that has been created using the speech onset markers. The In times of the four subtitles are aligned with the start of the corresponding speech blocks (green rectangles).

The following illustration shows the same file that has been created using shot changes. The In times of the two subtitles are aligned with the start of the corresponding shot changes.
Editing basics

To edit a file, you will normally use Edit Mode. You may edit subtitle text in any of the available Subtitle Views (List, Timeline, Compact or News) and freely switch between them as desired.

Regardless of the view mode, editing always takes place in the current subtitle which is displayed with a brown background.

The illustration below shows a Teletext personality file being edited in the List View. The current editing position is shown with a flashing white cursor.

The basic keys for moving through the subtitle list are Page Up (moves to the previous subtitle) and Page Down (moves to the next subtitle). However there are several other ways of navigating the file as described in navigating the subtitle list.

You have full control over the colour, style and position of each subtitle.

Navigating and selecting text

Wincaps Q4 follows the same conventions as standard word processing software for navigating and selecting text within the current subtitle. For a full list of keystrokes, see Keyboard shortcuts - Wincaps Q4 offline or Keyboard shortcuts - Q-Live.

Note that text selection is restricted to the current subtitle, i.e. you cannot select text across multiple subtitles.
Cut, Copy and Paste

Wincaps Q4 supports standard clipboard functions, allowing you to cut, copy and paste subtitle text between subtitles and to/from other Windows applications. You can access the clipboard operations via standard editing keystrokes, the file toolbar or by right-clicking inside the subtitle display area.

To cut and paste entire subtitles, use the Compact View.

Wincaps Q4 only permits you to open one subtitle file at a time. If you need to copy and paste between two subtitle files then you can start up a second (read-only) instance of Wincaps Q4 and use this to open the copy source file.

Undo and Redo

Undo and Redo of subtitle edits are supported by standard editing keystrokes, the Edit menu and via the file toolbar. Note that some complex editing operations (e.g. re-split subtitles) cannot be undone and Wincaps Q4 will normally warn you where this is the case.

Navigating the subtitle list

The basic keys for moving through the subtitle list are Page Up (moves to the previous subtitle) and Page Down (moves to the next subtitle).

The following additional navigation keystrokes are available in Wincaps Q4 Offline:

Ctrl Page Up/Page Down will take you to the first/last subtitle in the file
Ctrl Shift Page Up/Page Down will move through the list (roughly) a page at a time
Alt Page Up/Page Down will locate the next subtitle with a section marker

See Keyboard shortcuts - Qu4ntum offline for a full list.

Goto Subtitle

The Goto Subtitle command allows you to jump to any subtitle in the current file/story. Press the Ctrl G key and select the subtitle using the following dialog:
If you choose **By time**, Wincaps Q4 will jump to the subtitle with an In time that most closely follows the timecode you enter.

## Create and delete subtitles

This topic describes the basic operations for creating and deleting subtitles using the keyboard.

After creating a new file/story, you will see a blank subtitle with the cursor in place ready for you to start entering the subtitle text.

As you enter characters into the subtitle, the duration and Out time indicators increase, based on the word rate setting.

The subtitle text will automatically wrap to a new line once it has reached the end of the row. You can create an explicit new line at the current cursor position by pressing **Shift Return**.

You can create a new subtitle by pressing **Return**. The new subtitle is added below the current subtitle. The In time of the new subtitle is based on the out time of the previous subtitle, taking into account the minimum gap settings. Timecodes of new subtitles created in this way are always set to floating. When you create a new subtitle in this way it automatically inherits most of the attributes of the previous subtitle, e.g. colour, positioning, style.

To create a new subtitle at the beginning of the file/story, use the Compact View.

You can delete and amended the subtitle text in the same way as in any standard word processor, using the **Backspace** or **Delete** keys. Text can be highlighted and over-typed in the normal way.

Various keys are available for highlighting and moving through the subtitle text, see keyboard shortcuts - Wincaps Q4 Offline or keyboard shortcuts - Q-Live for a full list.

You can delete the current subtitle using **Ctrl Shift Delete**. To delete multiple subtitles in one operation, use the Compact View.
Basic input keystrokes

Text editing in Wincaps Q4 follows normal Windows text processing conventions including clipboard functions (cut/copy/paste), see Keyboard shortcuts - Wincaps Q4 offline or Keyboard shortcuts - Q-Live for a full list.

There are also a few special text formatting keys such as:

- **Ctrl R** - reformats the subtitle text to fill the current row
- **Ctrl Down/Up arrows** - snakes words from one row to the next
- **Ctrl M** - alters capitalisation by toggling between UPPERCASE, Title Case and lowercase

Wincaps Q4 automatically capitalises the start of each new sentence as you type. The sentence end conditions are described here. Non-keyboard characters (accents, symbols etc.) Characters that are not available on the standard keyboard can be entered in several ways:

Copying text to the **clipboard** from another application and then pasting it into Wincaps Q4

Using Windows regional input settings for the relevant language and the **On-Screen Keyboard** (a standard Windows tool, typically found under Programs : Accessories : Accessibility on the Windows Start menu)

Using the **Windows Character Map** (a standard Windows tool, typically found under Programs : Accessories : System Tools on the Windows Start menu)

Using **dead keys** where they are supported by the keyboard language. For example, on a French keyboard you can create characters that have the circumflex accent by pressing the circumflex dead key ^ followed by the character.

Holding down the Alt key while typing the corresponding three digit **ASCII character code** on the numeric keypad - for a list of ASCII character codes refer to on-line resources such as:


**Useful Symbols:**

<table>
<thead>
<tr>
<th>Alt+1</th>
<th>Smiley Face</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+13</td>
<td>Music (Eighth) Note</td>
</tr>
<tr>
<td>Alt+14</td>
<td>Double Music Note</td>
</tr>
<tr>
<td>Alt+171</td>
<td>½ symbol</td>
</tr>
</tbody>
</table>

Holding down the Alt key while typing the corresponding four digit decimal **Unicode character code** on the numeric keypad - for a list of Unicode character codes refer to on-line resources such as:

http://unicode.org/charts/

For example, Alt 0189 will enter the ½ symbol (0x00BD in the Unicode Latin-1 Supplement)

Note that not all characters are valid in all cases. For example, if the file has the Teletext personality you are limited to entering characters that are supported by the Teletext character set for the chosen language. If you try to enter an unsupported
character, an "Invalid character" message will be displayed in the left of the status bar.

Superscripts and Subscripts
Wincaps Q4 has no superscript/subscript font adjustment attribute (unlike Microsoft Word for instance). Therefore all characters, including superscripts and subscripts, must be inherently supported in the selected TrueType font. Enter the character in the same way as any other non-keyboard character (see above). For instance, use Alt 0178 (Unicode 00B2) for a superscript two.

Shortforms
You can use shortforms to reduce the amount of typing required and to ensure consistent spelling of commonly used words or phrases, including the names of people or places for instance. In some respects this feature is similar to the AutoText facility in Microsoft Word. Just type the abbreviated "shortform" followed by a space, punctuation or the return key and Qu4ntum expands it automatically. Learn more about shortforms here.

House Styles (Wincaps Q4 Pro only)
House Styles are similar to shortforms but are activated when text is entered into the SpeakTitle Window, normally during speech input. Learn more about House Styles here.

Find and Replace

You can use find and replace to rapidly locate a word or phrase and/or replace it with a different word or phrase.

By default, Find and Replace operates on the whole file (Wincaps Q4 Offline) or on the current story (Q-Live). You can choose to work with a particular subset of subtitles by first selecting multiple subtitles in the Compact View. In Q-Live, you can perform the operation on multiple stories (or all stories) by first selecting multiple stories in the Story List.

Find and replace operations are performed using the Find pane of the toolbox as shown below:

Find
To find a word, press the Ctrl F key or select Edit : Find from the main menu. The Find pane is displayed.
Enter the word or phrase to locate into the **Find** box and enable any of the options as required. Click the **Find Next** button to locate the next occurrence of the search text, which will be highlighted in the active subtitle display.

If the **Regular Expression** box is checked, then an asterisk (*) or question mark (?) can be used as search wildcards. An asterisk will match any number of characters, whilst a question mark will match any single character.

**Replace**

To replace a word or phrase with a different one, press the **Ctrl H key** or select **Edit : Replace** from the main menu. The **Find pane** is displayed.

Enter the word or phrase to locate into the **Find** box and the replacement text into the **Replace** box. Enable any of the options as required. Click the **Find Next** button to locate the next occurrence of the search text, which will be highlighted in the active subtitle display. Click on **Replace** to replace the highlighted text, or **Find Next** to leave the current text unaltered and locate the next instance. The **Replace All** button allows for the rapid replacement of all matching text throughout the file.

- **This operation cannot be undone except by restoring from the automatic backup**

**Set position and justification**

The positioning of the subtitles on the screen can be specified in three ways:

- **Justification** – the alignment of one row with another within a subtitle
- **Horizontal position** - the alignment of the longest row of the subtitle horizontally across the screen
- **Vertical position** - the vertical position of the whole subtitle block on the screen

You can use the layout toolbar or a positioning keystroke to quickly set the position or justification of the current subtitle to one of the standard choices. The arrow keys can be used to set custom positions, allowing you to position each row separately anywhere on the screen.

You can choose to lock the position and justification keys together.

You can use the Compact View to set the position and justification of multiple subtitles at once.

Subtitles can be raised (to a configurable position) and dropped via a single keystroke.

**Standard positions**

The layout toolbar shows you the position and justification of the current subtitle as indicated by the yellow borders around the buttons. You can hover the mouse over the buttons to learn what each one does.

Click a button to change the position and/or justification of the current subtitle as desired, or alternatively use the corresponding keystroke on the numeric keypad as
Lock position and justification

The lock button can be used to tie position and justification together. When this option is enabled, pressing a justification or position key will set both position and justification to the chosen value (left/centre/right). This option can be preset via the customer template if required.

Custom positions
You can use the four Alt Arrow keys (up/down/left/right) to move a subtitle or its individual rows to any position on the screen.

Alt Arrow - move subtitle 1 pixel/1 Teletext character/4 Closed Caption characters
Ctrl Alt Arrow - move subtitle 10 pixels/2 Teletext characters/1 Closed Caption characters
Shift Alt Arrow - move current row 1 pixel/1 Teletext character/4 Closed Caption character
Ctrl Shift Alt Arrow - move current row 10 pixels/2 Teletext characters/1 Closed Caption characters

To move an individual row (and hence create a split subtitle), first place the cursor anywhere on that row.

Raising subtitles

Subtitles are normally positioned at the bottom of the screen. However you sometimes need to raise a subtitle slightly, e.g. so that it doesn't obscure burnt-in captions. Similarly, if subtitles are positioned at the top of the screen it might be necessary to move them down slightly.
The **Enter key** on the numeric keypad provides a quick way of doing this.

If the subtitle is at the *bottom* of the screen, press **Enter** to raise the subtitle to the bottom of screen raise position. If the subtitle is already raised (i.e. not at the bottom of the screen) then pressing Enter will return it to the bottom of the screen.

If the subtitle is at the *top* of the screen, press **Shift Enter** to drop the subtitle to the top of screen drop position. If the subtitle is already dropped (i.e. not at the top of the screen) then pressing Shift Enter will return it to the top of the screen.

The raise and drop positions are configurable on a per-customer basis.

The raise keystroke can be configured as a user preference if desired.

### Positioning multiple subtitles

To quickly change the position and/or justification of multiple subtitles, first switch to the **Compact View** and select the subtitles to change. Then use the toolbar and/or keystrokes as described above. Note that you can't use the Arrow keys to customise the position of multiple subtitles.

**Examples**

The following examples illustrate the various positioning and justification settings.

- **Left position, left justification**

  ![Left position, left justification](image)

- **Left position, centre justification**

  ![Left position, centre justification](image)

- **Left position, right justification**

  ![Left position, right justification](image)

- **Centre position, left justification**

  ![Centre position, left justification](image)

- **Centre position, centre justification**

  ![Centre position, centre justification](image)
Centre position, right justification

Right position, left justification

Right position, centre justification

Right position, right justification

Top position

Middle position
Custom position (via Alt Shift Arrow keys)

To configure the default positions, click the Position button in the Subtitle defaults & preferences section of the Toolbox->File Info tab.

The Change File Position dialog appears as shown below:
Select the desired option for each of the three positional settings.

The special option allows you to configure a custom value for justification, horizontal and/or vertical position by entering a percentage value (e.g. 88) in the edit box at the bottom of the list. For example, with the horizontal positioning value set to 88 the default position of the subtitle will start 88% of the way along the width of the available display area. If Centre is selected then the line positioning value is automatically entered as 50%, i.e. halfway across the screen.

Teletext and Closed Caption standards permit only limited vertical and horizontal positioning and alignment. Closed Captions cannot be placed in the vertical centre of the screen. Teletext subtitles can only be placed on set Teletext lines and centre positioning can be affected by the space used for non-display control characters. In both cases, centre justification can be affected by one character space either side due to the fixed width font.

**Configure the file font**

This topic describes how to configure the default font used to display Open Caption subtitles. All subtitles in the current file will use these font settings by default.

For a Wincaps Q4 (W32) file, the choice of default display font is normally determined by the customer template used when the file is created and should not normally need to be changed.

To configure the default font, click the **Font** button in the File Properties section of the Toolbox->File Info tab.

Note that the font button is disabled if the document personality is “Teletext” unless Open Caption subtitles are enabled for the Teletext file. Teletext subtitles are
displayed using a fixed font that cannot be changed.

The **File Default Font** dialog appears as shown below:

![File Default Font dialog](image)

Wincaps Q4 allows you to choose any standard Windows TrueType/OpenType font that supports Unicode character encodings. You should ensure that you select a font that contains the full set of characters appropriate to the file language. Character codes not present in the chosen font will be displayed as an 'empty box' and will be picked up by the Chars check.

- **Font name** - select the default font to use for all open-caption subtitles in this file
- **Font size** - select the default font size for all open-caption subtitles in this file. The font size represents the approximate number of television lines from the top to bottom of the character cell (highest ascender/accen to lowest descender)
- **Italic / Bold / Underline** - bold, italics and/or underline styles can be added to the basic font (with some fonts this may have no effect)
- **Space width** - allows the width of "space" characters to be decreased by entering a percentage value between 0 and 100%. For example, if this value is set to 50, then all space characters in the file will be half their normal width. The **Default** button can be used to restore this setting to its normal value (100)
- **Row spacing** - For multi-row subtitles, allows the space between rows to be increased or decreased by a fixed number of pixels. For example, if this value is set to 5, then all rows will be separated by 5 additional pixels. The **Default** button can be used to restore this setting to its normal value (0)
- **Character spacing** - allows the space between character to be increased or decreased by a fixed number of pixels. For example, if this value is set to 2, then all characters will be separated by 2 additional pixels. The **Default** button can be used to restore this setting to its normal value (0)

Note that you can change the font, size and style of individual words or subtitles within the file by using the style toolbar or by right-clicking on the subtitle and selecting **Font...** from the pop-up menu. However, the space width and row/character settings may only be set at the file level, in other words you cannot set...
these values differently for individual subtitles.

Configure the file colour

This topic describes how to manually change the colours of individual words, sentences and subtitles in the current file.

Each file has default settings for foreground and background colours. New subtitles created in the file will use these default colours. You can override the defaults and change the colours of individual words, sentences or subtitles within the file by using the colour control keystrokes located on the numeric keypad.

The colour toolbar supports a limited set of colour operations, i.e. the most commonly-used sentence foreground and background colours.

To change the foreground colour of the *entire sentence* at the current cursor position, simply press the desired key. Note that this may change the colour of adjacent subtitles as well if the current sentence runs across multiple subtitles.

Hold down the **Ctrl key** to change the **background** colour

Hold down the **Shift key** to change all text in the **current subtitle** only.

If you first highlight some text before pressing a key (or a toolbar button) then the colour change will affect only the selected words (unless you use the Shift key as well).

If the current selection is or includes the last subtitle then that attribute also applies (until changed) to any new subtitles added after that.

If the Line break on colour option is enabled, Wincaps Q4 automatically inserts line breaks whenever the foreground colour changes. This ensures that the text for each speaker is placed on a new line.

The picture below summarises the functions of the colour change keystrokes. Note that the most commonly used colours are assigned dedicated keys (7/8/9) whilst the less common colours share the / and * keys.

**IMPORTANT:** These keystrokes only work when the current subtitle has focus
The **colour picker** (* key) behaves differently depending on the personality of the file:

For **Teletext** files, it cycles through the lesser-used colours as follows:

Foreground colours: Magenta/Red/Blue/Black  
Background colours: Yellow/Cyan/Green/White

For **Open Caption** files it displays the **colour picker dialog** that allows you to choose any available colour from the system palette.
Note that if you create custom colours in the palette, Qu4ntum will not remember them once the application is closed down though of course any coloured text in the file will retain the correct values.

You can also set the colours for the current subtitle by right-clicking on the subtitle and selecting Colour... from the pop-up menu. The Change Subtitle Colour dialog is displayed.

The settings are described here. Click OK to apply the changes to the current subtitle. To change the colours of multiple subtitles, switch to the Compact View and select the subtitles to change. Right-click on one of the selected subtitles and choose Colour.. from the pop-up menu.
Open a subtitle file

This topic describes how to open an existing offline (W32) subtitle file.

You can open an existing subtitle file in any of the following ways:

Select **File : Open** from the main menu
Press the **Ctrl O** key
Click the **File Open** button on the File Toolbar
Select the file from the **File : Recent Files** menu

In the first three cases, a standard Windows **Open** dialog is displayed. Browse to the folder containing the file. Note that Wincaps Q4 will remember the last directory you browsed to.

Select the file you want to open and click the **Open** button.

If the file doesn't currently have a programme/customer assigned, you will be prompted to choose them:
The dialog will default to the last selections that you made. Select the desired programme/customer and click OK.

There will be a short wait whilst Wincaps Q4 reads in the subtitle file, downloads the job information from the DataStore and opens the video. Wincaps Q4 then displays the subtitle file ready for use.

If you choose a file from the Recent Files menu it will open directly. The menu shows the last 10 files you opened.

### Print a subtitle file

To print the whole of the current file including subtitle number, text and timecodes, select **File : Printing : Print** from the main menu or press **Ctrl P**.

To print a range or selection of subtitles, first select the subtitles to print using the Compact View before using the above print command.

After you choose one of these options, Wincaps Q4 displays a standard Windows print dialog that lets you select a printer in the normal way.

You can customise the appearance of the printout (e.g. by adding a cover page and/or headers and footers) via configure print options

### Close a subtitle file

You can close the active subtitle file by selecting **File : Close** from the main menu.

You can close all open files by selecting **File : Close All**. A confirmation message will be displayed.

You can also close files by right-clicking on a document's file tab as shown in the illustration below.
Open subtitle files in other formats

This topic describes how to open subtitle files in other formats directly into Wincaps Q4, converting their contents into a W32 file.

You can open an existing subtitle file in any of the following ways:

Select File : Open from the main menu
Press the Ctrl O key
Click the File Open button on the File Toolbar

A standard Windows Open dialog is displayed. Browse to the folder containing the file. Note that Wincaps Q4 will remember the last directory you browsed to.

In the Files of type drop-down list, select Supported files. This will display all subtitle files that Wincaps Q4 is capable of opening. The full list of supported formats is described here.

Select the file you want to open and click the Open button. Wincaps Q4 prompts you for the name of the W32 file that will be created in the process.

When you click Save, Wincaps Q4 launches the Import Wizard to guide you through the process of converting the source file to Wincaps Q4’s native W32 format.

Choose the required options from those presented by the Wizard. Click Finish at any step to complete the process. There will be a short delay whilst Wincaps Q4 converts the subtitle file.

Finally you are prompted to assign a programme and customer to the new file:
The dialog defaults to the last selections that you made. Select the desired programme/customer and click **OK**.

**Qu4ntum** displays the file ready for editing.
Checks basics

Overview

Checks allow you to identify various types of errors in the subtitle file.

You can also use Style Seeker to ensure that a file complies with house style and/or client rules, by creating a report that identifies any subtitles that deviate from the default attributes.

You access the checks via the Checks pane of the Toolbox.

The checks are grouped into three categories:

**Timing** - Default rate, Maximum rate, Sequence, Gaps, Breaks, Duration, Overlaps, Shot Changes

**Presentation** - Chars, Addons, Rows/Spaces, Safe Area

**Proofing** - Spelling, Homophones, House Styles, Shortforms

Click on one of the links above to learn more about a particular check.

Each category is assigned a colour that will display as a traffic light indicator in the subtitle display if an error is detected when running a check.

Timing – Red
Presentation – Orange
Proofing – Yellow

If you hover the mouse over a traffic light, Wincaps Q4 will display more details of the specific check(s) that have failed in a pop-up window:
The traffic lights are cleared down each time the checks are re-run. Note however that the light for a particular category will only be cleared if at least one check is enabled for that category, e.g. running just a spelling check will clear down all the yellow lights but not any red or orange lights.

There are two ways to run the checks:

**Check Only** runs the selected checks and lights the traffic light indicators for each failing subtitle

**Check Review** sets the traffic light indicators as above and also displays a review dialog that allows you to correct errors interactively

After a check has been run you can use the blue go to arrow buttons at the bottom of the toolbox area to locate the failing subtitles:

Alternatively you can use the **Ctrl E** and **Ctrl Shift E** keystrokes to move to the previous/next subtitle that has an active check light.

Running the checks

Checks are only enabled in Edit Mode.

By default, the checks operate on either the whole file (Wincaps Q4 Offline) or on the current story (Q-Live). You can override this as follows:

If you select multiple subtitles in the Compact View then the checks will run on the selected subtitles only
If you select multiple stories in the Story List then the checks will run on all selected stories.

To run **Check Only** use the following steps:

Select the **Toolbox-> Checks** pane
Check/Uncheck the required tick boxes (If all checks are required use the **Tick All** button)
Click on the **Check Only** button
Wincaps Q4 will run each of the selected checks in turn, setting the status traffic lights as appropriate for each subtitle
Use the go to buttons to navigate through the subtitles which have failed

To run **Check Review** use the following steps:
Select the **Toolbox->Checks** pane
Check/Uncheck the required tick boxes (If all checks are required use the **Tick All** button)
Click on the **Check Review** button
Qu4ntum will run each of the selected checks in turn, setting the status traffic lights as appropriate for each subtitle
A series of dialog boxes will be displayed, allowing you to review and correct the errors interactively or you can edit in the file without ending the Check session.

Normally the checks will start from the first subtitle each time. If you choose to cancel a check for some reason (e.g. to make a manual edit to a subtitle) you can use the **Resume** button to restart the checks from the point where you left off.

![Changes made by the Check Review process cannot be undone except by restoring from the automatic backup](image)

The **Spelling check** can also be activated as follows:

By selecting **Edit : Spelling...** from the main menu
By pressing the **Ctrl F7** key

In this case, a new **Spelling** Toolbox tab opens that allows you to run a spell check whilst being able to edit the current subtitle at the same time.

![Spelling Toolbox](image)

Note that the **Spelling** checkbox in the Checks pane needs to be ticked in order for the above to work.
**Homophones check**

Homophones are words that sound alike but have different spelling. For example:

their, there, they're
for, fore, four

If subtitles are created using speech input, the speech engine may choose the wrong words. The homophones check can be used to quickly identify and review all homophones in the file.

The system may be configured with a list of defined homophones for each language. If a homophone list has not been configured for the current language the homophones check will be disabled.

When you run the homophones check, any defined homophones in the subtitle file are underlined with a “dotted line” as shown below:

Once the homophones have been identified you can confirm or change them using one of three methods:

**Check Homophones** dialog
Right-click correction
**Ctrl Shift H** keystroke

The Check Homophones dialog is displayed if you select the Check Review method. Note that the homophones check always starts from the beginning of the file each time you run it.

The word is displayed together with its homophones. You can retain the original word or select one of the homophones to replace it.

The buttons operate as follows:

**Next** - don’t correct this instance (original word remains underlined and the yellow traffic light isn’t cleared)
**Keep** - accept the selected word (underline is removed and the yellow traffic light is cleared)

After clicking either of these buttons the focus will automatically move to the next
homophone in the file.

Click on the Close button to cancel the interactive homophone check.

Right-clicking inside the subtitle display brings up a context-sensitive menu. If you right-click on a homophone (e.g. "There" in the illustration below) you will see a Homophones sub-menu that displays a choice of possible words. Click on the desired word or press the corresponding number key to accept it.

When the cursor is over an underlined word, pressing Ctrl Shift H cycles through the available homophones.

**House Styles check**

The House Styles check allows you to apply a chosen set of House Styles to the subtitle file. Wincaps Q4 will identify any words or phrases that exist in the currently active set of house styles. You can then review the matches and replace them with the corresponding substitutions as required.

After the House Styles check has been run, matching words and phrases are underlined with a "dashed line" as shown below:

In this example, an active House Style is defined for the phrase "do not" in the "Contractions" House Style topic as shown below. This causes any occurrences of "do not" in the subtitle file to be underlined.
The **HouseStyle Review** dialog allows you to review and replace any matching House Styles found by the check. The dialog is activated by running the Check Review method.

The matching phrase is displayed together with its corresponding House Style replacement.

The buttons operate as follows:

- **Find next** - don't replace this phrase (phrase will remain underlined and the yellow traffic light won't be cleared)
- **Ignore** - ignore this phrase (phrase remains unreplaced, underline is removed and the yellow traffic light is cleared)
- **Ignore All** - as above, plus all subsequent occurrences of all phrases are automatically ignored
- **Replace** - replace the phrase with the **Replace** text
Replace All - as above, plus all subsequent occurrences of all phrases are automatically replaced

After clicking any of these buttons the focus will automatically move on to the next House Style or else a "House Style Check complete" message will be displayed if the end of the file is reached.

Click on the Close button to cancel the House Style review.

Presentation checks

Overview
The presentation checks are used to check the subtitle file for character, positioning, spacing and style errors.

Each of the checks is described in more detail in the following sections.

When you run a presentation check using the Check Review method, the following dialog (or similar) is displayed when Wincaps Q4 locates an error. The affected subtitle will be automatically displayed in the center of the view area. The dialog will give a brief description of the error, and you will be prompted to take the appropriate action using the buttons on the right.

The buttons operate as follows:

Next - don't correct this error (the subtitle won't be modified and the orange traffic light won't be cleared)
Ignore - ignore this error (the subtitle won't be modified but the orange traffic light will be cleared)
Ignore All - as above, plus any further errors of the same type will be automatically ignored
Change - correct the error (the subtitle will be modified as described in the message and the orange traffic light will be cleared)
Change All - as above, plus any further errors of the same type will be automatically corrected
After clicking any of these buttons, the focus automatically moves to the next subtitle containing an error. Check errors can also be edited in the Subtitle file during the Check session.

Click on the Cancel button to cancel the interactive check.

Chars check
The chars check checks the current file for invalid characters. For Teletext and Closed Caption personalities, an invalid character is one that is not supported by the transmission system in the specified language. For the Open Caption personality, an invalid character is one that is not supported by the selected font. For more information on the supported character sets, click here.

Example 1: Bad Teletext codes

In this example, the accented é in épée is not supported by the standard British language Teletext character set. Note that this character is supported via packet 26, so this check will not flag an error if the Do not allow packet 26 characters option is disabled in the File Personality->Teletext dialog.

Example 2: Bad font character (Open Caption file)

In this example, the subscript '2' in H2O is not supported by the Arial font. As is normal for Windows, the invalid character is represented by an "empty square".

Addons check
The Addons check reports an error if an add-on subtitle meets either of the following conditions:

The out-time of the base subtitle (i.e. the first subtitle in an add-on sequence) is not the same as all its add-on subtitle(s).

The vertical position of the base subtitle clashes with the following add-on subtitle(s). Note that add-ons are only relevant for Teletext subtitles.

Rows/spaces check
The Rows/spaces check reports an error if any of the following conditions are met, where those conditions are not permitted by the Rows and Spaces properties of the subtitle file.

The subtitle contains more than the maximum number of rows
The subtitle contains extra spaces before, during or after text
The subtitle contains blank rows
The entire subtitle is blank

Safe area check
The Safe area check reports an error if the text of a subtitle extends beyond the safe area configured for the file. Safe area errors are rare, since Qu4ntum automatically wraps the subtitle text in most situations. Any such errors tend to result from a change in the safe area settings after subtitles have been created or a file has been
imported. If the file has an inner baseline defined, this check will identify any subtitles that extend beyond the inner baseline boundaries.

Note that safe area checks are only relevant for Open Caption subtitles. There is an option to display the safe area in the video window. If this is set, the safe area bounding box will be shown in green (or in blue if a baseline has also been configured for the file). This is enabled by right-clicking on the video window and selecting **Show safe area/baseline in edit mode** from the pop-up menu. Subtitles that violate the safe area/baseline boundaries will cause the safe area bounding box to turn red.

**Raised check**
The Raised check reports an error if the vertical position of the subtitle is not bottom-aligned.

**Style check**
The Style check reports an error if a subtitle contains a text style (i.e. bold italic or underline) that differs from the file default.

Note that the Style check is only available in Open Caption personality files.

**Font name check**
The Font name check reports an error if a subtitle contains text with a font name that differs from the file default.

Note that the Font name check is only available in Open Caption personality files.

**Font size check**
The Font size check reports an error if a subtitle contains text with a font size that differs from the file default.

Note that the Font size check is only available in Open Caption personality files.

**Colour check**
The Colour check reports an error if a subtitle contains text with a foreground or background colour that differs from the file default.

Note that the Colour check is only available in Teletext and Open Caption personality files.

**Horizontal position check**
The Horizontal position check reports an error if a subtitle contains text with a horizontal position that differs from the file default.

Note: Pixel positioned text may not be picked up and re-positioned by the horizontal position check.

**Disabled for TX check**
The Disabled for TX check reports any subtitle that has been marked as disabled for transmission.

### Shortforms check

The shortforms check allows you to apply a chosen set of shortforms to the subtitle file. Wincaps Q4 will identify any words that exist in the currently active set of shortforms. You can then review the matches and replace them with the corresponding substitutions as required.
After the shortforms check has been run, matching words and phrases are underlined with a "dashed line" as shown below:

```
It's called fd.
```

In this example, an active shortform is defined for the phrase "Free Diving" in the "Diving Doris" shortform topic as shown below. This causes any occurrences of "fd" in the subtitle file to be underlined.

The **Shortform Review** dialog allows you to review and replace any matching shortforms found by the check. The dialog is activated by running the Check Review method.
The matching phrase is displayed together with its corresponding shortform replacement.

The buttons operate as follows:

- **Find next** - don't replace this word (word will remain underlined and the yellow traffic light won't be cleared)
- **Ignore** - ignore this word (word remains unreplaced, underline is removed and the yellow traffic light is cleared)
- **Ignore All** - as above, plus all subsequent occurrences of *all words* are automatically ignored
- **Replace** - replace the word with the **Replace** text
- **Replace All** - as above, plus all subsequent occurrences of *all words* are automatically replaced

After clicking any of these buttons the focus will automatically move on to the next shortform or else a "Shortform Check complete" message will be displayed if the end of the file is reached.

Click on the **Close** button to cancel the shortform review.

### Spell check

**Overview**
The spell check is used to identify and correct misspelt, duplicate and excluded words in the subtitle file.

Wincaps Q4 uses the **Microsoft Proofing Tools** to provide spell checking. If the spell check function is not available for your primary language then check to make sure that **Microsoft Word** or **Microsoft Office** is installed. If the spell check function is not available for secondary languages, then Microsoft Proofing Tools are missing. Click **here** to learn more about how Microsoft Office settings affect the Wincaps Q4 spell check.

After your run a spell check, any errors are underlined with a "wiggly line" as shown below:

![Image of wiggly line underlined text]

**You must run the spell check in order to show the errors, they are not displayed as you type.**

There are two ways to correct spelling errors:

- Spell Check dialog
- Right-click correction

**Spell Check dialog**
The Spell Check dialog is displayed when you select the Check Review method.
Note that the spell check always starts from the beginning of the file each time you run it.

The failing word is displayed together with any suggestions found in the lexicon files. You can edit the spelling manually in the Word edit box or click on one of the suggested words to replace it. If the error is caused by a duplicate or excluded word, this will be indicated in the dialog text.

The buttons operate as follows:

- **Next** - don't correct this error (word will remain underlined and the yellow traffic light won't be cleared)
- **Ignore** - ignore this word (underline is removed and the yellow traffic light is cleared)
- **Ignore All** - as above, plus all subsequent occurrences of the same word are automatically ignored
- **Replace** - replace the word with the contents of the Word edit box
- **Replace All** - as above, plus all subsequent occurrences of the same word are automatically replaced

After clicking any of these buttons the focus automatically moves to the next spelling error.

If the failing word is actually correct, you can add it to either the Global or Programme spelling supplement by selecting the appropriate lexicon from the drop-down list and clicking Add. Note that if another user is currently editing the spelling supplement you will see a warning message and the word will not be added.

Click on the Close button to cancel the interactive spelling check.

Once a word has been ignored it will not be picked up again if the spell check is re-run on the same file. If you want to re-check the ignored words for the current file you can use the button on the checks toolbar to reset the ignore status of all words in the file.
You can also manually edit the word in the subtitle file.

**Excluded words** may not be ignored or added to a spelling supplement, i.e. they will always be flagged when a spell check is run.

**Right-click correction**

Right-clicking inside the subtitle display brings up a context-sensitive menu. If you right-click on a spelling error (e.g. "gonna" in the illustration below) you will see a **Spelling** sub-menu that displays a choice of replacement words as well as giving you the option of adding the current word to one of the lexicons.

---

**Grammar Check**

There is a basic Grammar check using the MS Proofing Tools. This Check is for reviewing the file and is not done 'on the fly'.

**Summary functions (word count and duration)**

You can use the summary functions to display useful information about the current file/story.

The available summary functions are:

**Word count** - displays the total number of individual words in a range of subtitles

**Total duration** - displays the total on-screen duration of a range of subtitles

To access the summary functions, switch to the **Compact View** and select a range of subtitles to summarise. Then right-click on any of the selected subtitles and select the desired function from the pop-up menu:
Wincaps Q4 User Guide

Wincaps Q4 displays the results in a pop-up message as shown below:

If no subtitles are selected, or if the functions are invoked from the List or Timeline Views then Qu4ntum will display summary information for all subtitles in the file.

Style Seeker report

The Style Seeker can be used to ensure that a file complies with house style and/or client rules, by creating a report that identifies any subtitles that deviate from the standard (default) attributes set in File Properties.

Select File: Export from the main menu and choose Style Seeker Report from the drop-down list as shown below.
Click **OK** to continue. Wincaps Q4 prompts you for the name of the file that will contain the report. Enter a suitable filename and click **Save** to continue. The following dialog is displayed:

Click on the **Settings...** button to configure the Style Seeker options:
Click on each attribute to select or de-select it. Only selected attributes will be logged.

By default, the report will contain a list of subtitle numbers, In times, Out times and whichever attributes you have selected.

Ticking the Subtitle Text box will include the text of the subtitles in the report.

The Field Delimiter option allows you to choose how the fields are separated in the report.

The Advanced... button allows you to configure each selected check to be carried out at the word (default), row or subtitle level.

The report is saved as a rich text (.rtf) log file that can be displayed using WordPad or another compatible text editor.

In the following example of a Style Seeker report file, subtitle 2 has a non-default background colour, subtitles 3 and 4 have a non-default foreground colour and subtitle 4 has a non-default vertical position.
Timing checks

Overview

The Timing checks are used to check the subtitle file for timing related errors, i.e. to identify and correct any subtitles that do not conform to the Timing Rules.

The timing checks are:

**Rate check** - identifies subtitles with high reading rates (greater than the default rate)

**Maximum rate check** - identifies subtitles with very high reading rates (greater than the maximum rate)

**Sequence check** - identifies subtitles that are out of sequence, i.e. where the in-time is earlier than the previous in-time

**Gaps check** - identifies subtitles that break the minimum gap rules

**Breaks check** - identifies subtitles that overlap with chapter break zones

**Duration check** - identifies subtitles that break the minimum/maximum duration rules

**Overlaps check** - identifies overlapping subtitles, i.e. where the out-time is later than the previous out-time

**Shot change check** - identifies subtitles that break the shot change rules

If a particular check is disabled, it means that the corresponding timing rule or feature is not enabled.

Each of the checks is described in more detail below.

When you run a timing check using the Check Review method, the following dialog (or similar) is displayed when Wincaps Q4 locates an error. The affected subtitle is automatically displayed in the center of the view area. The dialog gives a brief description of the error, and you are prompted to take the appropriate action using the buttons on the right.
The buttons operate as follows:

- **Next** - don't correct this error (the subtitle won't be modified and the red traffic light won't be cleared)
- **Ignore** - ignore this error (the subtitle won't be modified but the red traffic light will be cleared)
- **Ignore All** - as above, plus any further errors of the same type will be automatically ignored
- **Change** - correct the error (the subtitle will be modified as described in the message and the red traffic light will be cleared)
- **Change All** - as above, plus any further errors of the same type will be automatically corrected

After clicking any of these buttons the focus automatically moves to the next subtitle containing an error.

Note that some errors can't be corrected using this dialog. In such cases the **Change** and/or **Change All** buttons will be disabled and you will need to edit the subtitle timings manually in order to correct the problems.

Click on the **Cancel** button to cancel the interactive check.

**Correcting one kind of timing error may inadvertently introduce another. Therefore you should re-run the timing checks after making any adjustments.**

### Default rate check

The Default rate check checks the reading rate of each subtitle in the file and identifies any subtitles that exceed 100% of the specified default reading rate. The default reading rate is set by the value of **Default subtitle display rate** in the timing rules dialog.

**Note that the timing rate check will fail if any subtitle is > 100% of the specified default reading rate. This can lead to the situation where a subtitle will fail the reading rate check even though the reading rate display for that subtitle has a green background.**
Maximum rate check

The Maximum rate check checks the reading rate of each subtitle in the file and identifies any subtitles that exceed the specified maximum reading rate. The maximum reading rate is set by the value of Maximum subtitle display rate in the timing rules dialog.

Sequence check

The Sequence check identifies subtitles that have an in-time earlier than that of the previous subtitle.

Gaps check

The Gaps check identifies subtitles where the gap between the previous subtitle and the current subtitle does not conform to the minimum gap timing rules (if enabled).

Breaks check

The Breaks check identifies subtitles that overlap with the defined chapter break zones. Note that Qu4ntum does not currently provide the facility to correct these overlaps from within the interactive checks dialog, i.e. any errors need to be corrected manually.

Duration check

The Duration check identifies subtitles that do not conform to the duration Timing Rules (if enabled) as follows:

Duration is less than the specified Minimum subtitle duration
Duration is greater than the specified Maximum subtitle duration
Duration is negative, i.e. the Out time is less than the In time

Note that the effective duration of an add-on subtitle is the total time that the text will be on-air, not just the duration of that particular subtitle. The duration check takes this into account, i.e. it will not flag an error for a low-duration subtitle if that subtitle is part of a longer add-on sequence.

Overlaps check

The Sequence check identifies subtitles where the Out time is later than the next subtitle's In time.

Shot change check

The Shot change check identifies subtitles where either the In time or Out time do not conform to the shot change Timing Rules (if enabled).

Build times check

This check is designed to identify build time errors in a Closed Caption (Line 21) file. An error means that extra frames are required to complete the transmission of the current subtitle based on the timing of the previous subtitle. To correct this error, either delay the In time of the current subtitle to allow more build time or reduce the number of characters in the current subtitle to decrease the build time. Butting the
subtitle to the previous subtitle will also provide additional build time.

If a file has Build Time errors the 'Frames required for transmission' values are displayed in red.
Toolbox Basics

Toolbox overview

The Toolbox is a multi-purpose area that provides access to configuration, status and utility functions. You will always find the Toolbox in the lower-left quadrant of the screen, so long as at least one document is open.

The Toolbox is organised into panes. The horizontal main panes are:

- **Info** - View and edit the properties of the current job and configure system settings
- **Messages** - View status and error messages
- **Speaker List** - Activate speaker mode and manage the speaker list *(Wincaps Q4 Offline only)*
- **Checks** - Check the current document for timing/presentation/proofing errors
- **Find** - Find and replace text in the current document
- **Live** - Configure and control how live subtitles are transmitted *(Q-Live only)*
- **Compare** - Compare the differences between story versions *(Q-Live only)*
- **Spelling** - Run a spell check whilst also being able to edit the current subtitle

The Info pane has a number of vertical sub-panes as follows:

- **Launch Info** - View basic information about the current job
- **File Info** - Change file properties and preferences, access conversion tools
- **Job Info** - Manage the ancillary data (e.g. House Styles, spelling supplements) used by the current job
- **Configure** - Change customer-specific and user-specific configuration settings
GSI - View/edit the GSI information for the current file

Use the links above to learn more about a particular pane.

Navigating the Toolbox
You can move around the Toolbox using both mouse and keyboard. Keyboard navigation works as follows:

To select the Toolbox area, press the **Esc key** until the focus moves to the Toolbox. The tab of the currently active pane will be highlighted in orange as shown below.

With the focus on a main pane tab, use the **Left/Right Arrow keys** to choose a different main pane.

To access a sub-pane, press the **Tab key** and use the **Up/Down Arrow keys** to choose a different sub-pane. The tab of the currently active sub-pane will be highlighted in orange as shown below.

To move through the various controls within the active pane use the **Tab/Shift Tab keys**. The currently selected control will be highlighted in a bolder colour, as shown below by the "Timing rules" button.

Some panes may contain groups of controls (e.g. buttons) with related functions. You can use the **Left/Right Arrow keys** to access the controls within the active group.
Press the **Spacebar** to activate the currently selected control.

With the focus is inside a sub-pane, use the **Ctrl Tab key** to move the focus back to a different sub-pane.

With the focus on a sub-pane tab, use the **Ctrl Shift Tab key** to move the focus back to a different main pane.

**Info Tab**

**Launch Info pane**

The **Launch Info pane** of the Toolbox displays basic information about the current subtitle file and lets you change the currently assigned programme and customer via the **Change** button.

![Launch Info pane](image)

- **Job file** - The path to the current job
- **Media** - The path to the media files associated with the current file
- **File** - The path to the current file
- **User name** - The Windows login name of the currently active user
- **Language** - The language of the current file
- **Programme** - The programme assigned to the current file
- **Customer** - The customer assigned to the current file

The **Change** button lets you change the **programme** and/or **customer** assigned to the current file. These are initially chosen when a file is first created and do not normally need to be changed.

Note that if you select a different customer then Wincaps Q4 will **not** automatically
reapply the template for the new customer, you will have to do this manually.

Configure pane

The Configure pane of the Toolbox lets you change customer-specific configuration settings and user preferences. In Q-Live, you can configure the location of the Wincaps Q4 File Server and enable a timecode device to control the replay of pre-scripted live subtitles.

Note that some buttons are specific to Wincaps Q4 Offline or Q-Live and will only appear where relevant.

Customer Settings allow you to customise export formats and other preferences for the current customer. Wincaps Q4 stores a different set of configuration settings for each customer. Once configured, Wincaps Q4 will automatically use the appropriate settings for the current customer selection. The customer settings are stored globally in the DataStore.

General Settings enable you to configure various miscellaneous preferences.

User Preferences allow you to customise various aspects of the Qu4ntum user interface to suit your own personal choice.

Job Info pane

The Job Info pane of the Toolbox lets you manage and configure the ancillary data (e.g. House Styles, spelling supplements) used by the current job.

In multi-user systems the ancillary data is held in the Main DataStore. Consequently, you should take care when making changes to global items as they will affect all users of the system.
Use the links below to find out more about what each button does. Note that Wincaps Q4 stores a different set of data for each language. Changes you make will be applied to the data for the **active language**, i.e. the language of the current subtitle file. Similarly, Wincaps Q4 stores a different template for each customer. Any changes you make to the customer template will apply to the **active template**, i.e. the template for the current customer. You can view the current language and customer settings in the Launch Info pane.

**Substitution**

- **House Styles** - Manage House Styles for the active language *(Qu4ntum Pro/Q-Live only)*
- **Shortforms** - Manage personal shortforms for the active language

**Customer Template**

- **Configure** - Configure the parameters of the active template
- **Create** - Recreate the active template using the properties of the current file
- **Import** - Import a TPL file replacing the contents of the active template
- **Export** - Export the current template to a TPL file
- **Apply** - Apply the active template to the current file

**Text Splitting**

- **Configure** - Configure text splitting curves and weights for the active language
- **Import** - Import text splitting files for the active language
- **Export** - Export text splitting files for the active language

**Spelling**
Global - Manage the global spelling supplement for the active language
Programme - Manage the programme spelling supplement for the active programme/language
Exclusions - Manage the spelling exclusion list for the active language

Homophones

Import - Import the homophone list for the active language
Export - Export the homophone list for the active language

File Info pane

The File Info pane allows you to view and change the properties and preferences for the current subtitle file and provides access to tools for converting timecodes and for media management.

Note that some of these options are only available in Wincaps Q4 Offline.

Use the links below to view more details of what each button does.

File Properties

Timing Rules - configure the rules used when aligning and checking timecodes
Personality - choose the personality of the file from one of Teletext, Open Caption or Closed Caption (line21) subtitles
Language - configure the file language
Font - configure the font used to display Open Caption subtitles
**Background** - configure background effects for Open Caption subtitles

**Safe Area** - configure the display safe area for Open Caption subtitles

**Subtitle defaults & preferences**

**Colour** - set the default subtitle foreground and background colours for the current file

**Position** - set the default subtitle positions and justification for the current file

**Punctuation and Size** - configure punctuation rules and subtitle dimensions for the current file

**Splitting** - configure text splitting options for the current subtitle file

**Timecode modification**

**Offset & Status** - adjust timecode offset and status for a range of subtitles

**Clear** - clear all timecodes for a range of subtitles

**Re-Sync** - synchronise timecodes to the current media position

**Compress** - compress or expand video timecodes

**PAL/NTSC Conversion** - convert the current file between PAL/NTSC video standards

**Media**

**Wizard** - associate new video media with the current subtitle file

**Files** - view the details of the currently assigned media and helper files

**Video Sync** - synchronise Wincaps Q4’s timecode display with the media’s burnt-in timecode

**Chapter Breaks** - edit DVD chapter breaks for the current file (Wincaps Q4 offline only)

**Import Breaks** - import DVD chapter breaks from a text file (Wincaps Q4 offline only)

**Clear Breaks** - clear all DVD chapter breaks from the current file (Wincaps Q4 offline only)

**File**

**Locking** - lock selected elements of a file to prevent them from being edited (Wincaps Q4 offline only)

**Audit Trail** - view the history of the current file and add a new record (Wincaps Q4 offline only)

**Line21 Conversion** - convert the current file from Closed Caption (Line21) personality to Teletext (Wincaps Q4 offline only)
GSI pane

The **GSI pane** of the Toolbox allows you to view and edit the **General Subtitler Information** for the current file. The GSI information is stored as part of each subtitle file and will be included where appropriate in any file exports that support GSI data, e.g. files exported in the STL/EBU format. Similarly, when you import a subtitle file into Wincaps Q4 the GSI information will be populated from the imported file. Selected GSI fields can be included when printing the subtitle file by specifying them in the print options.

**IMPORTANT:** Note that when you are editing these values, changes to the currently selected field will not be saved to the file until you move off the field or press the **Return** key.

You can also use the GSI Pane to customise the format of Subtitle Zero when exporting to the PAC subtitle format.

The majority of the fields allow free text entry. Note that the text may be truncated when the file is exported if there is insufficient space for it in the exported file.

The **Revision** field must contain an integer value.

The **Date** fields must be specified using the YY:MM:DD format.

Wincaps Q4 will automatically set the **Creation date** whenever you create a new file. All other changes to GSI data must be made manually, i.e. Wincaps Q4 will not automatically update or maintain these fields for you.

The **Story** field is only used by the following formats: PAC, RAC, EBU Poliscript2, Unipac.

The **Other Comments** field is only used when exporting to the following formats: EBU-TT, EBU Swift, 890.

The three **890** fields are only used in the 890 Cavena/Scantitling file format.

The **Reference Code** field can be used to override the automatic language code selection during PAC export. If this field contains some text then it will be used to specify the `<language code>` in Subtitle Zero of the exported PAC file.
Subtitle Zero

The **Subtitle Zero** button allows you manually specify the contents of subtitle zero, used when exporting to the PAC file format. Normally, subtitle zero is created automatically from the GSI information. However in some cases a custom format of subtitle zero may be required. Click the button to open the subtitle zero editor:

![Subtitle Zero Settings](image)

Enter the text exactly how you want it to appear in the subtitle zero when the file is exported and click **OK** to save. This information can be specified in the customer template if required, meaning that the subtitle zero information will be populated automatically whenever you create a new file.

You can also customise the In time and Out time of subtitle zero if the normal (default) values are inappropriate for your target system.
Messages pane

The Messages pane of the Toolbox lets you view status and error messages reported by Wincaps Q4.

Messages are displayed in a scrolling list with the most recently reported message at the bottom. There are four categories of messages:

- **Errors** - Indicates that a serious problem has occurred that may prevent you from working normally, e.g. a file failed to open or a connection problem with the Main DataStore
- **Warnings** - Indicates that a less serious problem has occurred but that you should still be able to continue working
- **Informational messages** - Status messages, normally used to indicate when an operation succeeds
- **Timing rules messages** - Diagnostic messages that describe in detail how the Timing Rules are applied whenever the Aligner runs or you do a timecode grab

Qu4ntum retains the last 200 messages of all categories.

The buttons allow you to:

- **Clear messages** - Clears the messages list
- **Copy to clipboard** - Copies all messages to the clipboard. The messages can then be posted into a text document or email when reporting problems

Note that the messages pane is common to all open documents.
Speaker List pane

The Speaker List pane of the Toolbox lets you manage the list of speakers for the current subtitle file. You can create and delete speakers, assign speakers to subtitles and set the text colour for individual speakers.

Checks Pane

The Checks pane of the Toolbox lets you check the current file for timing, presentation and proofing errors.
Find pane

The **Find pane** of the Toolbox lets you perform find and replace operations on the subtitle text.
General options and settings

Overview

Wincaps Q4 stores certain configuration settings along with the customer name. This means that when you create a new subtitling job and select the customer, Wincaps Q4 will automatically load the correct settings for that particular customer, thereby simplifying the process of producing subtitle files in the correct format.

Note that you must have a customer assigned to the file or these settings will be disabled.

These settings are stored globally in the Main DataStore and are active for all users of the system. Because they are stored centrally, the latest settings will always be active regardless of which workstation or user is connected.

To modify these settings for a particular customer, open a subtitle document and ensure that the desired customer name is selected in the Launch Info. Then use the appropriate buttons in the configure pane of the Toolbox to change the settings as required and they will be automatically saved in the DataStore.

Configure import

The import preferences are used when you import a file in certain formats.

Text - configure preferences to use when importing unformatted text files.
PAC - configure display of Subtitle Zero. This is used to view subtitle Zero

Configure export

The export preferences are used when you export a file in certain formats.

EBU
Ultech L21
Ultech DV3000
MCA
DLP Cinema
DFXP (also known as TTML)
SAMI (formatted/selected video exports only)
Boxing * (used for image-based exports including Final Cut Pro)
DVD Builder *
Text (configures the character encoding (ANSI / Unicode) for Text and SRT exports)
EBU-TT
FCP (Final Cut Pro)

* Note that these settings are currently stored per-workstation and NOT per-customer

To view or change the general preferences, click the appropriate button in the Toolbox->Configure tab.

**Raising preferences**

Click on the **Raising** button to set the default raise and drop positions for raised subtitles. The following dialog is displayed.

![Configure Subtitle Raising](image)

Enter the desired raise and drop positions and click on **OK** to save. The numbers are calculated as Teletext rows. In other words, the screen is divided vertically into 23 (single-height) rows and hence a bottom raise value of four would raise the subtitle by 4 single height rows (or two double-height rows).

Raising works for both Teletext and Open Caption personality subtitles. In the case of Open Caption subtitles, the screen is divided vertically into 22 virtual rows, the height of each row (in pixels) is calculated as the safe area height / 22.

Note: Wincaps Q4 stores the raising settings as a user preference.

Configure printing
Speech Preferences

Click on the button to display the Speech Options dialog:

Choose the Speech input method to use from the drop-down list:

**Keyboard messages to SpeakTitle**: Selecting this option will route all speech input through the SpeakTitle window. Select this option if you are using a third-party speech engine other than **Dragon Naturally Speaking**. You may also use this mode with Dragon if desired, though the integrated mode is normally better in this case.

**Integrated Dragon Interface**: In this mode, Dragon Naturally Speaking is integrated into Wincaps Q4 and the SpeakTitle window is replaced by a control panel that allows you to configure and manage Dragon from within Wincaps Q4. When you run Wincaps Q4 for the first time, it will default to this mode if it finds a compatible version of Dragon installed.

**Show HouseStyle expansion in SpeakTitle Window**: With this option enabled, the respeaker can see the housestyle longform appear in the SpeakTitle Window. This is off by default. See also SpeakTitle Window Settings.

System

Click the button to configure the timecode source. The following dialog is displayed:

This setting, enabled by default, allows the user to open more than one instance of WQ4 or Q-Live on the same PC.

Disabling the option stops more than one instance of WQ4 or Q-Live being opened on the PC. If the option is disabled and a second instance is opened then this error will appear.

NB: If the option is disabled, it is possible to have WQ4 and Q-Live open on the same PC, if there are available licences to do so.
Section marker preferences

Click on the Section Markers button to display the Markers dialog:

**Auto-insert section start marker** - This option only applies when you are originating text at the bottom of the subtitle list via the SpeakTitle Window or via Direct Dragon speech input. If the option is enabled and you create a new section end marker, Wincaps Q4 will automatically attach a new section start marker to the next (blank) subtitle. The timecode of the new section start marker will be the same as the previous end section marker, i.e. the new section will follow on immediately. Enabling this option may save time for certain workflows.

Video jump preferences

Click on the Media button to display the Media Preferences dialog:

This dialog lets you configure options for video playback.

The **Video jumps** options allow you to control how far the current media position moves when you use the video jump keys. For each key, enter the desired jump interval as Hours:Minutes:Seconds:Frames. The default values are as shown in the illustration above and you can restore them at any time by clicking the Default button.

The **Synchronise paused video...** box controls how the system behaves in Replay Mode when you navigate to a new current subtitle with the media paused. With the box ticked (default), the video will automatically jump to the In time of the new current subtitle. With the box unticked, the video position will not change.

Configure keyboard
Click on the Keyboard button to display the User Keyboard dialog.

![User Keyboard dialog]

This dialog allows you to override certain default keystrokes depending on the type of workflow you are using.

**Alternative fixing keys:** *(Wincaps Q4 Pro only)*

**NumPad Ins/Del:** By default, pressing the Ins and Del keys on their own will toggle section markers whilst using them in conjunction with the Shift key will grab In or Out times. If you are not using the Aligner you can swap these functions over for ease of use.

Note that in Fix Mode, in Q-Live and in Wincaps Q4 Standard, the Ins and Del keys are always used to grab In and Out times irrespective of this setting.

**Alternative numpad return keys:**

**NumPad Enter:** By default, pressing the Enter key toggles the subtitle raise position whilst pressing Ctrl Enter replays the media from the In time of the current subtitle. Depending on your preference, you can swap these over for ease of use. This applies to Edit mode in both Wincaps Q4 and Q-Live.

Note that in Live Mode *(Q-Live only)* the Enter key is always used to raise subtitles regardless of the preference configured here.

**Automatically set the Windows keyboard language to match the file:** If this option is ticked then whenever you create or open a file, Wincaps Q4 will automatically select the Windows keyboard language to match the language of the new file. Note that the Windows keyboard languages must have been previously configured in windows for this to work.
Tab key reformats the current subtitle rather than navigating: Normally the Tab key is used to navigate through the controls in the subtitle display. Tick this option if you want to use Tab to reformat the subtitle text instead.

Fix mode preferences

Click on the Fix button to display the Fix Mode Options dialog:

These options apply when you are fixing subtitles.

Fix mode reaction time (frames) - When you are fixing subtitles, Wincaps Q4 will subtract this value from each timecode that you grab in order to compensate for your reaction time.

Allow different out-time delay (frames) - When fixing subtitles using In and out times, this setting allows for the reaction time for the outtime.

Fix mode behaviour - Select the fix mode to use from the following list:

Show currently fixed subtitle (WYSIWYG) : In this mode, fixing is driven by the Ins key and Wincaps Q4 displays a preview of the next subtitle beneath the video window.
Del driven : In this mode, fixing is driven by the Del key

Configure backup

Click on the Backup button to display the Backup Options dialog:

You can use this option to disable automatic backups if they are not required and to use Zip files for back-ups.
Configure Comments

Click on the Comments button to display the Show All Comments dialog:

Use this option to display all comments in a file. This option is OFF by default.

Configure General

Click on the General button to display User General Settings dialog:

![User General Settings Dialog]

**Autocapitalise after sentence punctuation:** By default, Qu4ntum automatically capitalises the first word of each new sentence as you type. You can turn this feature off if required.

**Create new subtitle when fixing outtime:** With this option enabled, when setting the outtime of a subtitle a new blank subtitle is automatically created. The fixed Out time is also set as the floating In time of the new subtitle.

The Store Timecodes from Video Window option should only be selected when the Clear current subtitle by reading rate option and the Add cued subtitles to queue option, from the Live - customer settings, are selected. If subtitles are cued out faster than the reading rate allows them to be on air, causing the subtitles to be added to the queue and released when the reading rate allows, then the timecodes will be altered to match when they are released to air. (when they appear in the Video Window).

Localisation

You can configure Wincaps Q4 to display menus and dialog boxes in another language if your installation supports this.

Choose the desired language from the list of available languages shown in the Configure : Localisation menu.

The following notes apply:

Whilst most menus and dialog boxes should be translated into the chosen language, there may be some exceptions

Messages logged in the Messages pane of the Toolbox will not be translated
**Default paths**

To configure the default locations where Wincaps Q4 expects to find various types of files, select *Configure : Default paths...* from the main menu.

**Media** - Set the default path to use when browsing for media files

**File** - Set the default path to use when opening a file

The default file paths for Wincaps Q4 and Q-Live are stored separately, so Live (N32) and Offline (W32) files and media can be configured for different locations from the same workstation for each system.

These settings are stored in the same way as the other user options.

**Safe Area**

The safe area provides a facility to ensure that the subtitles appear correctly on-screen, taking into account over-scanning that occurs on most television sets. Wincaps Q4 will prevent the subtitles from extending beyond the margins that define the safe area by automatically wrapping the subtitle text to fit within the defined region.

You can run a safe area check on the current file/story to verify that none of the subtitles extend beyond the defined safe area.

For a Wincaps Q4 (W32) file, the dimensions of the safe area are normally determined by the customer template used when the file is created and should not normally need to be changed. If no safe area is defined in the template, Wincaps Q4 defaults to 32 top/bottom, 56 left/right.

To configure the safe area, click the **Safe Area** button in the File Properties section of the Toolbox->File Info tab.

Note that the Safe Area button is disabled if the document personality is "Teletext" unless Open Caption subtitles are enabled for the Teletext file. See the section on Mixed Personality files.

The **File Safe Area** dialog is displayed as shown below:
The **Safe area settings** are specified in pixels and are similar in function to margin settings in a word processor document. The graphic on the right shows you a preview of the currently defined safe area.

If the **Use default settings** box is checked, the file will use the internal system default settings for the safe area.

The **Definition**, **Standard** and **Aspect ratio** boxes show the basic display attributes (e.g. screen size and aspect ratio) for the current file. These are configured as part of the file personality, and cannot be changed here.

**Baseline**

You can use the **Baseline** settings to further constrain the area where subtitles are allowed to appear, effectively acting like an "inner safe area".

The baseline settings are normally determined by the customer template. If no baseline settings are defined in the template, the baseline is disabled by default, i.e. the full width and height of the safe area is available for subtitles to use.

Click on the **Baseline** tab to view and modify the baseline settings as shown below:
Checking the **Use default settings** box will disable the baseline.

To enable the baseline, uncheck the **Use default settings** box and enter the desired value in pixels for the bottom baseline.

The Safe Area dialog window can also be accessed from the Video Window using right click on the mouse.

If additional margins are required, check the enable margins box and enter them accordingly. The graphic on the right shows you a preview of the currently defined baseline settings.

Note that the baseline offsets are calculated from the full screen dimensions.
Therefore you should ensure that they are bigger than the corresponding safe area margins to avoid any conflicts. Qu4ntum will warn you about any such conflicts when you close the dialog. Also note that in order to have margins, the bottom baseline must be greater than 0, i.e. you cannot have margins with no bottom offset.
DataStore basics

Overview

The **Wincaps Q4 DataStore** is a repository for storing and organising the various ancillary files and settings needed for producing subtitles.

Multi-user systems will have a **Main DataStore** accessed over the network and available to all users. When you start Wincaps Q4 and open a subtitling job, the system will download all the required files and settings from the main DataStore into your **local DataStore cache**. If you make any changes to these files and settings, they will be automatically uploaded to the main DataStore and made available to other users.

Stand-alone systems do not have a Main DataStore and operate using the local cache only.

Under normal conditions DataStore access will operate behind-the-scenes, Wincaps Q4 communicates with the Main DataStore to download new data and upload local changes as required. When operating in this **online mode** the DataStore icon in the bottom left of the status bar will be green indicating that the Main DataStore is available.

If connection is lost to the Main DataStore (e.g. in the case of network problems) then Wincaps Q4 will display an error message and switch to **offline mode**. A typical error message might look like this:

![WinCaps Quantum DataStore connection error](image)

The status icon will turn yellow and Wincaps Q4 will disconnect from the main DataStore and go into **offline mode**. If this happens you can continue to work as normal although any local changes you make to data or settings may be lost when the connection to the Main DataStore is reestablished (see below).

If the Main DataStore is unavailable for some reason when Wincaps Q4 is first started, the status icon will turn red and Wincaps Q4 will start up in offline mode. You can continue to work as above using the information stored in your local cache until the Main DataStore becomes available.

To reconnect to the Main DataStore, select **DataStore : Connect** from the main menu. If the reconnection is successful, the status icon will turn green again.

Reconnecting to the DataStore after working offline
If you continue to work with Qu4ntum when the Main DataStore is unavailable, the data in your local cache may get out-of-step with the data in the Main DataStore. For example, you could edit DataStore content locally or another user who is still online could change the same content that you are using in the Main DataStore. When you reconnect to the Main DataStore, Wincaps Q4 has to resynchronise the content in your local cache with the current contents of the Main DataStore. This is done as follows:

Wincaps Q4 first checks to see if you have changed any data files locally and compares them with the corresponding files in the Main DataStore. If nobody else has changed these files whilst you were offline, Wincaps Q4 will prompt you to upload your local changes to the Main DataStore as shown below:

Click **Yes** to upload your files to the Main DataStore. Click **No** to discard your local changes. Click **Cancel** to remain offline.

Wincaps Q4 then checks to see if another user has already changed any of the files that you have changed. Unfortunately in this case your changes will be lost as Wincaps Q4 does not attempt to merge files that have been changed by several users. Wincaps Q4 warns you that your local files will be replaced by the current contents of the Main DataStore as shown below:

Click **OK** to connect to the Main DataStore or **Cancel** to remain offline.

Finally, Wincaps Q4 brings all the other files in your local cache up-to-date with the current contents of the Main DataStore.

### Standalone DataStore operation

**Overview**

For standalone single-user systems, Wincaps Q4 can operate without the need for a main DataStore. In this configuration, Wincaps Q4 uses the local DataStore cache.
on the client workstation to store all the relevant data.

The choice of standalone vs. main DataStore operation is made when Qu4ntum is installed.

When operating in standalone mode, the DataStore behaves as follows:

The status bar icon always shows as and the status message reports "DataStore offline only"
The connect/disconnect and re-sync items on the DataStore menu are always disabled

In all other respects the DataStore operates in the same way as a multi-user system.

Manage customer templates

Overview

Customer templates are a powerful feature that allow you to easily create subtitle files that are tailored to the requirements of a particular end-user.

A template is a set of parameters that are used to determine the properties of a subtitle file. These properties include personality, default colours and Timing Rules. Wincaps Q4 allows you to create a unique template for each customer in the customer list. If you select a customer when creating a new file then Wincaps Q4 will automatically apply the template to the new file, thereby ensuring that the file takes on the appropriate properties to meet that particular customer's requirements.

An example of a customer template is shown below:
If you select this customer template when creating a new file, the file will have Teletext personality, subtitles will have left position and justification by default, the reading rate will be 150 words per minute and the minimum allowed gap between subtitles will be 1 frame.

Templates are stored in the DataStore and are global to all users of the system in a multi-user environment. Wincaps Q4 stores a separate template for each different language, e.g. CUSTOMER1 could have both an English and a French template defined and the appropriate one will be applied depending on the language of the file.

Templates are stored globally in the Main DataStore and any changes you make to them will apply to all other users of the system. Therefore you should take care whenever you modify templates.

Templates are managed via the Job Info pane of the Toolbox.

The buttons allow you to manage the active template as follows:

**Configure** - Configure the parameters of the active template  
**Create** - Recreate the active template using the properties of the current document  
**Import** - Import a TPL file replacing the contents of the active template  
**Export** - Export the current template to a TPL file  
**Apply** - Apply the active template to the current document
Because templates are both customer and language-specific, the **active template** is determined by the customer and language properties of the currently open subtitle file. In other words, to view or edit the template for a particular customer/language you must first ensure that the current subtitle file is correctly set to use that customer and language.

Create/modify a template

The easiest way to create a new template or to modify an existing one is to configure the current file with the required properties and use the **Create** button to create the template parameters. This method is simple and requires no detailed knowledge of the template syntax. The procedure for doing this is as follows:

1. Open a subtitle file and configure it with the customer/language combination for which you want to create/modify the template.
2. Configure the various file properties as desired.
3. Click the **Create** button - a confirmation message will be displayed since the current contents of the template (if any) will be overwritten.
4. Click **OK** to confirm the operation. The template parameters will be created from the file properties.

Apply a template to the current document

Wincaps Q4 automatically applies a template when a subtitle file is first created. However, the system will **never** automatically reapply a template to an existing subtitle file, even if the template is subsequently modified or the customer/language of the file changed. In these cases, you can use the **Apply** button to reapply the active template to the current file as follows:

1. Open the subtitle file.
2. Click the **Apply** button - a confirmation message will be displayed.
3. Click **OK** to confirm the operation.
4. The file properties will be replaced by the current template parameters. Any subtitles in the file will take on the new characteristics defined by the active template.

Configure a template manually

Template parameters can be inspected and edited manually via the **Configure** button. The **Template Configuration** dialog will be displayed, looking something like this:
Parameters are displayed in alphabetical order. Each template parameter consists of a `<name> = <value>` pair. Click here to see a list of supported name/parameter pairs.

The buttons work as follows:

**OK** - Save any changes you have made.
**Cancel** - discard any changes you have made.
**Import/Export** - Same as the Import/Export buttons
**New** - Add a new template parameter
**Edit** - Modify the currently selected parameter
**Delete** - Delete the currently selected parameter
**Clear** - Delete all parameters

Import/Export templates
Templates can be imported from text files or exported to text files via the **Import** and **Export** buttons. This facility is useful when importing templates from previous SysMedia subtitling products (e.g. WinCAPS Multimedia) or when exchanging templates between systems. Templates files are in plain text format and have the .wct file extension. Note that the system will not validate the contents of an imported template so you should ensure that the template parameters are specified correctly in the file.

**Edit customer templates**

To edit the template for the active customer, click the Toolbox->Info->Job Info->Customer Template->Configure button.
The Template File dialog appears.

Parameters are displayed in alphabetical order. Each template parameter consists of a `<name> = <value>` pair.

Click here to see a list of all supported name/parameter pairs.

The buttons work as follows:

**OK** - Save any changes you have made.
**Cancel** - discard any changes you have made.
**Import/Export** - Same as the Import/Export buttons
**New** - Add a new template parameter
**Edit** - Modify the currently selected parameter
**Delete** - Delete the currently selected parameter
**Clear** - Delete all parameters

Existing properties can be edited as desired, new properties can be added and existing properties deleted. It is not necessary to set values for all possible properties. When creating a new file using a template, defaults will be used for any undefined properties. When applying a template to the current subtitle file, any file properties not defined in the template will remain unchanged.
Validation of template parameters

Wincaps Q4 validates a template at the point where it is applied to a subtitle file. At this point, the template is checked to ensure that each of its identifiers and their values are permissible. If any errors are found, appropriate messages are displayed in the Messages Pane of the Toolbox.

For example, the following error message shows that the font name specified in the template is not valid:

FontName = Times Roman

A line number is reported in order to assist in locating the error. The first line in the template is line 0.

After creating or modifying a template you should always double-check that your changes are valid by applying the template to a dummy test file and ensuring that no errors are reported in the Messages Pane.

Template parameters

When editing an existing customer template, it is essential that the property identifiers added to the template file are of the correct form and have an appropriate value associated with them.

For example, to set the property for word rate per minute (a timing property), the identifier `WordsPerMinute` must be used. No other form of this property is permissible. Moreover, its value must be of a certain data type, in this case an integer number.

The following table lists each of the available properties along with their expected data types and typical values:

<table>
<thead>
<tr>
<th>Property Identifier</th>
<th>Function</th>
<th>Data type</th>
<th>Typical value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BaseLine</td>
<td>safe area</td>
<td>String</td>
<td>Four integers separated by spaces that define the left top right bottom dimensions of the baseline, e.g. 40 -1 40 50. Use -1 to indicate a disabled value.</td>
</tr>
<tr>
<td>CharsPerMinute</td>
<td>timing rules</td>
<td>Integer</td>
<td>1 or greater</td>
</tr>
<tr>
<td>CharsPerSecond</td>
<td>timing rules</td>
<td>Integer</td>
<td>1 or greater</td>
</tr>
<tr>
<td>CharSpacing</td>
<td>default font</td>
<td>Integer</td>
<td>-2, -1, 0, 1, 2</td>
</tr>
<tr>
<td>CheckerName</td>
<td>GSI</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>ColourBack</td>
<td>background</td>
<td>String or hex</td>
<td>Black, Red, Blue, Yellow, Cyan,</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Type</strong></td>
<td><strong>Description</strong></td>
<td></td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>ColourFore</td>
<td>String or hex number</td>
<td>Black, Red, Blue, Yellow, Cyan, Magenta, Green, White or a six-digit hex number corresponding to the (BlueGreenRed) values of the required colour, e.g. A88568</td>
<td></td>
</tr>
<tr>
<td>ColourLocked</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>ColourNewLine</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>ContactDetails</td>
<td>String</td>
<td>GSI</td>
<td></td>
</tr>
<tr>
<td>ContinuationEnabled</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>DotsAfterComma</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>DotsOnSecondSubtitle</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>EditorsName</td>
<td>String</td>
<td>GSI</td>
<td></td>
</tr>
<tr>
<td>EnableBlankSubtitles</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>EnableOpenCaption</td>
<td>Boolean</td>
<td>TRUE or FALSE (Teletext personality only)</td>
<td></td>
</tr>
<tr>
<td>EpisodeTitle</td>
<td>String</td>
<td>GSI</td>
<td></td>
</tr>
<tr>
<td>ExclusionMinimumGap</td>
<td>Integer</td>
<td>0 or greater</td>
<td></td>
</tr>
<tr>
<td>FileLocked</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>FontBold</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>FontItalic</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>FontName</td>
<td>String</td>
<td>The name of a valid Windows font, e.g. Times New Roman</td>
<td></td>
</tr>
<tr>
<td>FontSize</td>
<td>Integer</td>
<td>A valid point size for the chosen font</td>
<td></td>
</tr>
<tr>
<td>FontUnderline</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>GrowDown</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>HardOfHearing</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>HorizontalPosition</td>
<td>Float</td>
<td>A floating point number in the range 0.000-1.000 where 0 is left position, 0.5 is centre and 1.0 is right</td>
<td></td>
</tr>
<tr>
<td>IncludeSpaces</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>Justify</td>
<td>Float</td>
<td>A floating point number in the range 0.000-1.000 where 0 is left justify, 0.5 is centre and 1.0 is right</td>
<td></td>
</tr>
<tr>
<td>Language</td>
<td>String</td>
<td>The name of a supported language, e.g. English</td>
<td></td>
</tr>
<tr>
<td>Language2</td>
<td>String</td>
<td>The name of a supported language, e.g. English</td>
<td></td>
</tr>
<tr>
<td>LineSpacing</td>
<td>Integer</td>
<td>A number between -20 and 20</td>
<td></td>
</tr>
<tr>
<td>LockOnClose</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>LockPositionJustify</td>
<td>Boolean</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
</tbody>
</table>


Screen Subtitling Systems Ltd
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MagnetismEnable</td>
<td>timing rules</td>
<td>Boolean TRUE or FALSE</td>
</tr>
<tr>
<td>MaxAlignmentDelay</td>
<td>timing rules</td>
<td>Integer 0 or greater</td>
</tr>
<tr>
<td>MaxAlignmentEnableDelay</td>
<td>timing rules</td>
<td>Boolean TRUE or FALSE</td>
</tr>
<tr>
<td>MaximumDuration</td>
<td>timing rules</td>
<td>Integer 0 or greater</td>
</tr>
<tr>
<td>MaximumDurationEnable</td>
<td>timing rules</td>
<td>Boolean TRUE or FALSE</td>
</tr>
<tr>
<td>MaximumRowCount</td>
<td>subtitle size</td>
<td>Integer 1 - 20 (0 to disable)</td>
</tr>
<tr>
<td>MaximumRowLength</td>
<td>subtitle size</td>
<td>Integer 1 or greater (0 to disable)</td>
</tr>
<tr>
<td>MaxCharsPerMinute</td>
<td>timing rules</td>
<td>Integer An integer value (\geq) CharsPerMinute</td>
</tr>
<tr>
<td>MaxCharsPerSecond</td>
<td>timing rules</td>
<td>Integer An integer value (\geq) CharsPerSecond</td>
</tr>
<tr>
<td>MaxWordsPerMinute</td>
<td>timing rules</td>
<td>Integer An integer value (\geq) WordsPerMinute</td>
</tr>
<tr>
<td>MinimumDuration</td>
<td>timing rules</td>
<td>Integer 0 or greater</td>
</tr>
<tr>
<td>MinimumDurationEnable</td>
<td>timing rules</td>
<td>Boolean TRUE or FALSE</td>
</tr>
<tr>
<td>MinimumGap</td>
<td>timing rules</td>
<td>Integer 0 or greater</td>
</tr>
<tr>
<td>MinimumGapEnable</td>
<td>timing rules</td>
<td>Boolean TRUE or FALSE</td>
</tr>
<tr>
<td>Personality</td>
<td>personality</td>
<td>String Teletext, Open Caption, Closed Caption</td>
</tr>
<tr>
<td>PositionLocked</td>
<td>file locking</td>
<td>Boolean TRUE or FALSE</td>
</tr>
<tr>
<td>ProgrammeTitle</td>
<td>GSI</td>
<td>String</td>
</tr>
<tr>
<td>ProofReader</td>
<td>GSI</td>
<td>String</td>
</tr>
<tr>
<td>Publisher</td>
<td>GSI</td>
<td>String</td>
</tr>
<tr>
<td>PunctuationSpace</td>
<td>punctuation</td>
<td>String A string of symbol:number pairs where () the number is either 1 (force space before), 2 (force space after) or 3 (both). Omitted symbols are set to ignore. e.g. .\textgroup:1%1,2;3</td>
</tr>
<tr>
<td>ReferenceCode</td>
<td>GSI</td>
<td>String</td>
</tr>
<tr>
<td>RevisionNumber</td>
<td>GSI</td>
<td>String</td>
</tr>
<tr>
<td>SafeArea</td>
<td>safe area</td>
<td>String Four integers separated by spaces that define the left top right bottom dimensions, e.g. 56 32 56 32</td>
</tr>
<tr>
<td>ScreenType</td>
<td>personality</td>
<td>String PAL, PAL Wide, NTSC Drop, NTSC Drop Wide, NTSC NonDrop, NTSC NonDrop Wide, HD1080i/23, HD720P/24, HD1080PsF/30nd, HD1080PsF/60d etc.</td>
</tr>
<tr>
<td>SentencePunctuation</td>
<td>punctuation</td>
<td>String A string containing one or more of the following symbols: ;.):</td>
</tr>
<tr>
<td>ShotchangeZoneWidth</td>
<td>timing rules</td>
<td>Integer 0 or greater</td>
</tr>
<tr>
<td>SpotRateEnable</td>
<td>timing rules</td>
<td>Boolean TRUE or FALSE (enable/disable default subtitle display rate)</td>
</tr>
<tr>
<td>SpotRatePercentage</td>
<td>timing rules</td>
<td>Integer 1 or greater</td>
</tr>
<tr>
<td>Setting</td>
<td>Category</td>
<td>Type</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>SubtitleLocked</td>
<td>file locking</td>
<td>Boolean</td>
</tr>
<tr>
<td>SubtitleZero</td>
<td>GSI</td>
<td>String</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TeletextAddOnTiming</td>
<td>Teletext options</td>
<td>Boolean</td>
</tr>
<tr>
<td>TeletextForceEndBox</td>
<td>Teletext options</td>
<td>Boolean</td>
</tr>
<tr>
<td>TeletextForceSingleHeightCode</td>
<td>Teletext options</td>
<td>Boolean</td>
</tr>
<tr>
<td>TeletextNoAddons</td>
<td>Teletext options</td>
<td>Boolean</td>
</tr>
<tr>
<td>TeletextNoPacket26</td>
<td>Teletext options</td>
<td>Boolean</td>
</tr>
<tr>
<td>TeletextSingleHeight</td>
<td>Teletext options</td>
<td>Boolean</td>
</tr>
<tr>
<td>TextEffect</td>
<td>backgroun d style</td>
<td>String</td>
</tr>
<tr>
<td>TextSpacingRules</td>
<td>subtitle size</td>
<td>String</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ThreeDotsInSecondsPart</td>
<td>punctuation</td>
<td>Boolean</td>
</tr>
<tr>
<td>TimecodeLocked</td>
<td>file locking</td>
<td>Boolean</td>
</tr>
<tr>
<td>TranslatedEpisode</td>
<td>GSI</td>
<td>String</td>
</tr>
<tr>
<td>TranslatedProgramme</td>
<td>GSI</td>
<td>String</td>
</tr>
<tr>
<td>TranslatorContact</td>
<td>GSI</td>
<td>String</td>
</tr>
<tr>
<td>TranslatorName</td>
<td>GSI</td>
<td>String</td>
</tr>
<tr>
<td>UseDash</td>
<td>punctuation</td>
<td>Boolean</td>
</tr>
<tr>
<td>VerticalPosition</td>
<td>default position</td>
<td>Float</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WordsPerMinute</td>
<td>timing rules</td>
<td>Integer</td>
</tr>
<tr>
<td>ZoneFollowShotchange</td>
<td>timing rules</td>
<td>Integer</td>
</tr>
<tr>
<td>ZoneFollowShotchangeEnable</td>
<td>timing rules</td>
<td>Boolean</td>
</tr>
<tr>
<td>ZonePrecedeShotchange</td>
<td>timing rules</td>
<td>Integer</td>
</tr>
<tr>
<td>ZonePrecedeShotchangeEnable</td>
<td>timing rules</td>
<td>Boolean</td>
</tr>
</tbody>
</table>
Manage Shortforms

Shortforms are word substitutions that are active when typing text directly into a subtitle using the keyboard. Shortforms are organised into lists (or topics) which are stored in the DataStore. A typical system may have many shortform lists (or topics) defined. Global and Programme shortforms are shared between all users of the system whereas User shortforms are only available to the user that created them. Each user of the system has their own individual set of active shortform topics which may be freely selected from any of the three categories.

Shortforms are managed via the Job Info pane of the Toolbox.

Click on the Shortforms button to display the Shortforms Window where you can add, delete, edit, activate and deactivate shortforms.

Shortforms window

The Shortforms window is shown below:

Shortforms are grouped into three categories (profiles):

- **Global** - Available to all users, apply to all jobs
- **Programme** - Available to all users, each programme has its own distinct set of topics
- **User** - Available only to the current user, apply to all jobs

Select the desired category to view or edit using the drop-down list. Wincaps Q4 displays the currently active topics for the selected category in the box below.

Topics are displayed in the order in which they were activated, most recently activated at the bottom of the list. Note that the topic order is important when determining precedence. Use the Manage Topics... button to activate topics or create a new topic. Use the Remove Topic button to deactivate topics. Note that Wincaps Q4 allows you to marquee-select multiple topics for removal. Use the Edit Topic... button to add, delete or modify individual shortforms within the currently highlighted topic. Use the View... button to view the contents of the currently highlighted topic without locking it for other users.

![Edit Topic...](image)

If you choose to Edit a Global or Programme shortform topic, the system will lock that topic in the Main DataStore to prevent other users from modifying it at the same time. Consequently, you should keep your edits as short as possible. If you just want to check the contents of a shortform topic, use the View... button as this will not lock the topic.

If you try to edit a topic that is currently locked by another user you will see an error message informing you of that user's login name.

Each group has a special DEFAULT topic that is always active, i.e. it cannot be
removed like the other topics.

**Edit/View topics**
Select a topic and click on the **Edit...** or **View...** buttons to display the list of contained shortforms as shown below:

Shortforms are listed alphabetically. In edit mode, you can create, edit and delete shortforms as required.

To create a shortform, enter the word you wish to replace in **Replace** and the word or phrase you wish to replace it with in **With** and press the **Add** button.

To edit a shortform, highlight the entry you wish to change. Editing in the **Replace** field will give the option to Add and the original shortform will remain.

Editing in the **With** field will give the option to Replace and will overwrite the previous shortform.

To delete a shortform, highlight the entry and press **Delete**.

**Manage topics**
Use the **Manage Topics...** button to activate or create topics:

Available topics are listed alphabetically. The buttons work as follows:

- **Activate Topic** - Activate the selected topic (or topics if marquee selection used). The topic(s) will be added to the bottom of the active list and hence will take priority for topic precedence.
- **Create Topic** - Create a new (empty) topic. Topic names are case insensitive and may contain spaces.
- **Delete Topic** - Delete the selected topic (or topics of marquee selection used).
- **View Topic** - Display the contents of the selected topic.
- **Import Overwrite** - Import a list of shortforms into the selected topic from an external text file. Wincaps Q4 will prompt you for the name of the file to import. Note that any
shortforms already existing in the topic will be replaced.  

**Export** - Export the list of shortforms in the selected topic to an external text file. Wincaps Q4 will prompt you for the name of the file to create, which will default to a .sfm extension.  

*Topic precedence*

If the same shortform exists in more than one category, the following rules of precedence apply:  

**User** (top priority)  
**Programme**  
**Global** (lowest priority)  

If the same shortform exists in more than one topic within the same category, the topic nearest the **bottom** of the list will take precedence, i.e. the DEFAULT topic (which is always at the top of the list) will have the lowest priority.  

Note that when new topics are activated they are always placed at the bottom of the list, i.e. the last topic that you add will have the highest priority.  

The **Report Clashes** option will flag up any duplicate Shortforms and produce a report if duplicates are found;  

![WinCAPS Qu4ntum](image)

The Report Clash currently saves the report in C:\Users\user.txt in 4.24.9 which standard Windows permissions will not allow. This is being repaired.  

Use the **Print** button to produce a print out of the Shortforms in a topic.  

**Programme and Customer selection**  

Wincaps Q4 is designed to make production of subtitles as easy as possible. Whenever a new subtitle file is created, Wincaps Q4 will prompt you to select an active **Programme** and a **Customer** for the new file, as well as the **language**.
Depending on the selections you make, Wincaps Q4 automatically downloads and activates the necessary information from the DataStore as described below:

**Programme:**
- Activate the appropriate programme spelling supplement
- Activate the appropriate speaker colour template
- Load the appropriate programme House Styles

**Customer:**
- Create the new subtitle file with the appropriate customer template
- Activate the appropriate customer-specific configuration settings for file import and export
- Activate the appropriate live output settings (*Q-Live* only)

**Language:**
- Load the text splitting data for the chosen language
- Load the house styles, shortforms, homophone list and spelling supplements for that language

A new system will contain a single **Default** entry for both Programme and Customer.

You can create a new programme or customer by clicking on **New...** A new programme will have an empty programme spelling supplement and a new customer will be created with a blank template and default configuration settings.

**Tip:** If you are adding a new customer or programme you should double-check that it is spelt correctly before entering it as new items cannot easily be changed or deleted.

If you choose to leave one or other of these settings blank then Wincaps Q4’s programme and/or customer settings will be unavailable.

The active customer and programme are stored in the subtitle file for the current job. You can change them at any time via the **Change** button in the Toolbox—Launch Info pane and the new settings will take effect immediately. However, note that if you select a different customer then Wincaps Q4 will **not** automatically reapply the template for the new customer, you will have to do this manually.

Whenever you create a new file, Wincaps Q4 defaults the selection of programme, customer and language to the last used values. Similarly, whenever you open a file
that does not currently have a customer/programme set, Wincaps Q4 will prompt you to select them.

Export a file

Overview

Wincaps Q4 provides facilities for exporting subtitle files in a variety of different formats, including the EBU Subtitle Exchange Format (.STL) used by all common Teletext subtitling packages. It also supports a number of third party file formats, which are used by other subtitling software developers.

Whilst every effort is made to maintain support for other subtitling software manufacturers' formats, Screen Systems cannot guarantee that such facilities will work for all such formats.

Export a file

Use the following procedure to export the current file to another format. Note that several of the export formats require configuration before use.

Note that you must have a customer assigned to the file or the export facility will be disabled.

Some file formats (notably the STL/EBU format) contain metadata such as program name, translator name etc. You should enter this information using the GSI pane of the Toolbox before exporting the file. For PAC exports, you can optionally define a custom format for subtitle zero.

Note that exports are disabled in Replay Mode. You should use Edit Mode to export a file.

Select File : Export from the main menu. The following dialog is displayed:

Choose the desired export format from the drop-down list. The available formats will depend on the personality of the subtitle file being exported, i.e. not all export formats are applicable to all personalities.
A standard **File Save As** dialog is displayed. Choose the name and location for the new file and click on **Save** to start the export process. Wincaps Q4 displays a progress window during the export process. If Wincaps Q4 detects errors during the export process, a warning dialog will be displayed. This allows you to create a report detailing the errors, the report is saved as a plain text (.txt) file in the same location as the exported file. The exported file is now available in the specified location.

### Export a range or selection of subtitles

You can use the Compact View to export just a range or selection of subtitles rather than the entire file. To achieve this, first select the subtitles to export using the **File : Export** command described above. If you have a mixed-personality file and you wish to export subtitles from one personality, you can filter the Compact View to display only the Teletext or Open Caption subtitles before making your selection.

**Supported export formats**

Wincaps Q4 allows you to export subtitles in a wide variety of third-party file formats as detailed in the list below.

Some export formats can be configured to produce variations in the format of the exported files. These configuration settings are stored on a per-customer basis. Click the links in the "configure" column for details.

The "personality" column indicates the type of file personalities (Open Caption/Teletext/Closed Caption) that the export formats were originally intended to support. Whilst Wincaps Q4 allows you to export files in any personality to any format, exporting a file with a personality not listed here is untested and could lead to undefined results.

<table>
<thead>
<tr>
<th>Format</th>
<th>Personality</th>
<th>Configure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>890</td>
<td>O/T</td>
<td></td>
<td>Cavena/ScanTitling</td>
</tr>
<tr>
<td>Closed Caption - Cheetah CAP</td>
<td>C</td>
<td>.CAP (Cheetah)</td>
<td></td>
</tr>
<tr>
<td>Closed Caption - CIN</td>
<td>C</td>
<td>.CIN</td>
<td></td>
</tr>
<tr>
<td>Closed Caption - DVD Caption</td>
<td>C</td>
<td>DVD Caption (.SCC (Daiken/Spruce) .CC (Sonic Solutions))</td>
<td></td>
</tr>
<tr>
<td>Closed Caption - MCA</td>
<td>C</td>
<td>Yes</td>
<td>.MCA</td>
</tr>
<tr>
<td>Closed Caption - Ultech</td>
<td>C</td>
<td>Yes</td>
<td>.ULT and .ULD (Ultech)</td>
</tr>
<tr>
<td>Comments</td>
<td>O/T/C</td>
<td></td>
<td>Export all comments to a text file</td>
</tr>
<tr>
<td>Digital Cinema - DLP</td>
<td>O</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Digital Cinema - DTS</td>
<td>O/T/C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVD Studio Pro (STL)</td>
<td>O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EBU - Cavena</td>
<td>O</td>
<td>STL/EBU</td>
<td></td>
</tr>
<tr>
<td>EBU - Generic</td>
<td>O/T</td>
<td>Yes</td>
<td>Should also work with HD personality and 24 fps (NB: for best results convert to 25 fps)</td>
</tr>
<tr>
<td>EBU - Poliscript</td>
<td>T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EBU - Poliscript 2</td>
<td>T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EBU - Standard</td>
<td>T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EBU - Swift</td>
<td>O/T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EBU - Win2020</td>
<td>O/T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NLE - Adobe Premier EDL</td>
<td>O/T/C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NLE - Final Cut Pro</td>
<td>O</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Format</td>
<td>O/T/C</td>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------</td>
<td>--------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>ProtoScript Plain</td>
<td>O/T/C</td>
<td>Text with speaker names</td>
<td></td>
</tr>
<tr>
<td>ProtoScript Timed</td>
<td>O/T/C</td>
<td>Text and timecodes with speaker names</td>
<td></td>
</tr>
<tr>
<td>RTF</td>
<td>O/T/C</td>
<td>Rich Text</td>
<td></td>
</tr>
<tr>
<td>SAMI - Formatted file</td>
<td>O/T/C</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>SAMI - Selected Video</td>
<td>O/T/C</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>SAMI - Unformatted file</td>
<td>O/T/C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen - PAC</td>
<td>O/T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen - PU2000</td>
<td>O/T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen - RAC</td>
<td>O/T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen - Unipac</td>
<td>O/T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SRT</td>
<td>O/T/C</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Style Seeker Report</td>
<td>O/T/C</td>
<td>Special report that checks for non-standard attributes</td>
<td></td>
</tr>
<tr>
<td>Text - Plain</td>
<td>O/T/C</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Text - Timecoded</td>
<td>O/T/C</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Timed Text - DFXP (MXF)</td>
<td>O</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Timed Text - EBU-TT</td>
<td>O/T</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Ultech DV3000</td>
<td>O</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>WebVTT</td>
<td>O</td>
<td>Beta format as there are several different format styles in the WebVTT spec</td>
<td></td>
</tr>
</tbody>
</table>

Note: Compatibility with third party systems using these proprietary file formats can never be 100% guaranteed. In the event of any difficulty please contact the Screen Systems subtitling support team attaching a copy of the original .W32 file and describing the issue with the target format. Please note also that these file formats provide varying degrees of support for some of the characteristics of the WinCAPS format (including comments, GSI and UDA fields for instance and in some cases also font, colour and positioning data).
Change the file language

This topic describes how to change the language of the current subtitle file.

The choice of language is made when the file is initially created and should not normally need to be changed. Note that if you do change the language of an existing file, Wincaps Q4 will not automatically reapply the customer template for the new language, you will have to do this manually if desired.

To change the language, click the Language button in the File Properties section of the Toolbox->File Info tab.

The File Language dialog is displayed as shown below:

Language - select the desired language from the list of available languages. The list of languages is fixed by the software, contact Screen Systems technical support if the language you require is not displayed.

Hard-of-Hearing - if ticked, the file is marked as containing hard-of-hearing subtitles. This affects the language settings when exporting to the 890 file format.

Forced subtitle language - this option is only relevant when performing dual Open Caption output in Q-Live. It allows you to set an alternate language when exporting forced subtitles. The language of the exported file will be set to the alternate language instead of the main language. The alternate language will only be used if all the exported subtitles have the forced property set, either because all the subtitles in the file/story are forced or because all subtitles in the current selection are forced. This parameter may be stored in the customer template as "Language2".
Configure punctuation rules and subtitle dimensions

This topic describes how you can configure the punctuation rules for the current file and limit the size of the subtitles as well as determining if and where blank spaces are allowed.

For a Wincaps Q4 (W32) file, these settings are usually determined by the customer template chosen when the file was created and should not normally need to be changed.

To configure these settings, click the **Punctuation & Size** button in the Subtitle defaults & preferences section of the Toolbox->File Info tab.

The **Punctuation and Size** dialog is displayed as shown below:

**Punctuation tab**

These settings determine how Wincaps Q4 handles punctuation and continuation dots.

The **Sentence Ending** options allow you to choose additional characters to be treated as sentence ending punctuation for purposes of text-splitting and auto-capitalisation.
These characters are:

<table>
<thead>
<tr>
<th>3 Dots</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bracket</td>
<td>)</td>
</tr>
<tr>
<td>Colon</td>
<td>:</td>
</tr>
</tbody>
</table>

Note that it is not possible to enable **3 Dots** at the same time as continuation dots (see below).

The **Punctuation Rules** are used by the Rows/spaces check. For each punctuation symbol you can choose to flag an error if leading/trailing spaces are not present.

Select a character and choose from the following options:

- **Ignore** - don't apply checks to this character (default)
- **Force space before** - the Rows/spaces check will flag an error where no space exists before the selected character
- **Force space after** - the Rows/spaces check will flag an error where no space exists after the selected character

You can configure Wincaps Q4 to automatically insert **Continuation Dots** when splitting subtitles, e.g. if splitting a long subtitle manually using the **Ctrl Return** key or when inputting a block of text via the SpeakTitle window. If enabled, three dots will be inserted at the end of the first part and two dots at the beginning of the second part. Tick the **Enable automatic insertion while editing box** and select from the following options:

- **Insert after a comma** - if checked, then insert dots even if the last character before the split is a comma
- **Add dots to second part** - if unchecked, then no dots are added to the beginning of the second part
- **Allow dashes in first part** - where there is only one available space for continuation dots at the end of the first part, Wincaps Q4 will insert a 'dash' instead if this option is ticked. If this option is unticked, no dash will be inserted (and hence no indication that a continuation follows)
- **Use three dots in second** - if checked, then three dots (instead of two) are added to the beginning of the second part

**Wincaps Q4 will only insert continuation dots if there is sufficient space on a row to accommodate them after splitting has occurred. Wincaps Q4 will not automatically re-split subtitles to accommodate continuation dots.**
Subtitles tab

The **Subtitle Dimension** settings allow you to control the height and row length of subtitles in the current file.

**Enforce maximum height of** - if checked, then the number of rows of text in a subtitle will be limited. Note that enabling this option does not prevent subtitles being created with more than the specified number of rows. However, subtitles that exceed the limit will be flagged by the Rows/spaces check. Wincaps Q4 will also use this setting to determine how to split subtitles when using automatic text splitting.

**Grow down** - if checked, ensures that as new subtitles are displayed on-screen, the subtitle will grow downwards (rather than upwards by default) to the specified number of rows.

**Enforce maximum row length of** - if checked, then the number of characters in each subtitle row will be limited. The text will be wrapped accordingly, depending on the value entered here. If this setting is unchecked, each row is allowed to occupy the full width of the screen, excluding the safe area.

The **Line break on colour** option determines whether a line break is automatically inserted whenever the foreground colour changes. If enabled, a new line will be inserted immediately prior to the colour change taking effect, ensuring that text from each different speaker is automatically placed on a new line.

The **Blanks and Spaces rules** are used by the Rows/spaces check.

**Allow blank subtitles** - if unchecked, then blank subtitles are flagged by the Rows/spaces check. This flag also determines if blank subtitles are exported or not in the STL, PAC, 890, TXT and RTF export formats.

**Allow blank rows** - if unchecked, then subtitles containing blank (empty) rows are
flagged by the Rows/spaces check

**Allow extra space... start of line** - if unchecked, then subtitles containing blank spaces at the beginning of a row will be flagged by the Rows/spaces check

**Allow extra space... between words** - if unchecked, then subtitles containing words separated by more than one space will be flagged by the Rows/spaces check

**Allow extra space... end of line** - if unchecked, then subtitles containing one or more spaces at the end of a row will be flagged by the Rows/spaces check
Line 21 conversion

This feature is used to convert files in Closed Caption (Line 21) format to Teletext format.

Start by opening or importing a file in Closed Caption format.

To convert the file to Teletext format, click the **Line21 Conversion** button in the File section of the Toolbox->File Info tab.

Default Settings

Background effect

This topic describes how to configure the default **background effect** for Open Caption subtitles in the current file. A background style is necessary to increase the legibility of Open Caption subtitles, especially against complex background images.

You can override these defaults and change the background effect of individual subtitles within the file by right-clicking on a subtitle and selecting **Background effect...** from the pop-up menu.

For a Wincaps Q4 (W32) file, the choice of background effect is normally determined by the customer template used when the file is created and should not normally need to be changed. If no background effect is defined in the template, Wincaps Q4 defaults to "none".

For a Q-Live (N32) file created via Q-News, these settings are configured in Q-News and should not normally need to be changed.

To configure the default background effect, click the **Background** button in the File Properties section of the Toolbox->File Info tab.

Note that the background button is disabled if the document personality is "Teletext" unless Open Caption subtitles are enabled for the Teletext file. Teletext subtitles only support block backgrounds. Closed Captioning has no variable background capability; the decoder automatically applies a black box around the caption text.

The **File Background** dialog is displayed as shown below:
Select the main style from the **Type** list box and then set the desired attributes which will vary depending on the type selected. You should choose an appropriate style that works well with the assigned foreground and background colours.

**Background styles and effects**

The different background effects are described below.

<table>
<thead>
<tr>
<th>Background style name</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No background</td>
<td></td>
</tr>
<tr>
<td>Surround - Square</td>
<td>Text is surrounded by a contrasting colour, e.g. use black surround to pick out white text against a pale background. You can specify the thickness of the surround</td>
<td><img src="text.png" alt="text" /></td>
</tr>
<tr>
<td>Surround - Smooth</td>
<td>As Surround - Square but with a higher resolution for a crisper result</td>
<td><img src="text.png" alt="text" /></td>
</tr>
<tr>
<td>Shadow - Thin (N,E,S,W,NE,NW,SE,SW)</td>
<td>Adds a shadow to the text - can be shadowed as though the light source is placed at differing points of the compass</td>
<td><img src="text.png" alt="text" /></td>
</tr>
<tr>
<td>Shadow - Full (N,E,S,W,NE,NW,SE,SW)</td>
<td>As Shadow - Thin but with the shadow area blocked in</td>
<td><img src="text.png" alt="text" /></td>
</tr>
<tr>
<td>Block - Solid</td>
<td>A solid background on which the text is displayed</td>
<td><img src="text.png" alt="text" /></td>
</tr>
<tr>
<td>Block - Mesh</td>
<td>A semi-opaque block background</td>
<td><img src="text.png" alt="text" /></td>
</tr>
</tbody>
</table>

The Block style has two options for **Box Shape** as follows:
<table>
<thead>
<tr>
<th>Box</th>
<th>The solid background extends to the full width of the subtitle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row</td>
<td>The solid background only surrounds text where it is shown</td>
</tr>
</tbody>
</table>

You can use the "box width" parameter to add extra pixels to the left and right edges of the block.

Click on one of the links below to learn how the boxing styles translate across different output file formats:

- 890 (Cavena/Scantitling)
- PAC (Screen Systems)

## Character sets

This topic describes the supported character sets for each of the available personalities.

The **Open Caption** character set comprises all characters in the selected font. Invalid characters will be displayed as a 'square box' and may be easily identified using the chars check.

The **Teletext** character set contains all western-language characters defined in the Teletext specification, including national options and packet 26.

The **Closed Caption** character set (EIA608-1) consists of:

- a-z, A-Z, 0-9, á à â ç é è ê í î ñ ó ô ú û
- ! " () [] , . : ; - + / = < > ? ¿ & $ £ % @ # © ™ ®
File personality

Wincaps Q4 allows you to create subtitles in a variety of formats suitable for broadcast or display in a number of video standards. The combination of subtitle type and video standard in Wincaps Q4 is defined as the **File Personality**. According to the chosen personality, Wincaps Q4 adapts its interface and screen layout to provide the necessary tools and functions to work successfully with it.

The available subtitle formats are:

- **Open caption** or burnt-in subtitles, typically used for DVD-Video, DVB and broadcast in-vision translations
- **Teletext** subtitles for viewer selectable captions (typically for the hard of hearing) on PAL broadcasts
- **Closed Caption** or Line 21, used for viewer selectable captions (typically for the hard of hearing) on NTSC broadcast, VHS and some DVDs

For a Wincaps Q4 (W32) file, the personality of a subtitle file is normally determined by the customer template applied when the file is created. If the personality is not defined in the template then the new file will default to Open Caption.

For a Q-Live (N32) file created via Q-News, the file personality is configured in Q-News.

You can change the personality of an existing file via the **File Properties**->**Personality** button in the Toolbox.
Import and Insert basics

Overview

This topic describes how you go about inserting or importing subtitles from other documents into the current file. There are several ways you can do this:

**Import** - Import a third-party file (e.g. STL), replacing the contents of the current file. An Import Wizard will guide you in choosing suitable options for processing the incoming subtitle text and timecodes. GSI information will be imported if present.

**Insert W32** - Use this method to merge two existing WinCaps Q4 (W32) documents together.

**Insert other** - Insert subtitles from a third-party file into an existing document. Inserted subtitles will retain their original colours, positions and timecodes. Subtitles and properties of the existing document will be unchanged.

**Overwrite text from file** - Replace just the subtitle text in the current document with new text whilst leaving the original subtitles and their timecodes unchanged. Useful when producing translation files.

In each case you start with an open WinCaps Q4 target file into which the subtitles will be imported or inserted from a source file that you will select. Certain properties of the target file (e.g. Timing Rules settings) will never be modified by the import process. Other properties (e.g. personality, default positions) may be modified by the choices you make in the Import Wizard. An Insert or Overwrite operation will never modify any of the target file’s properties.

**Supported import formats**

WinCaps Q4 allows you to import/inset subtitles from a wide variety of third-party file formats as detailed in the list below.

- .STL - EBU File Format (Subtitle Exchange Format)
- .PAC - Screen Systems
- .RAC - Screen Systems compressed format
- .FPC - Screen Systems Unipac/Fatpac format
- .CHK - Screen Systems file containing multiple streams
- .890 - Cavena/Scantitling Software System
- .TXT - Text files (ANSI and Unicode)
- .RTF - Rich Text Format
- .HTM - HTML format
- .XML - DFXP (MHF) format
- .SMI - SAMI format
- .SRT
- .WCF - SysMedia WinCAPS Classic files
- .MCA - Line 21 Format
- .SCC - Line 21 Format for use with Daiken/Spruce DVD Authoring System
- .CC - Line 21 Format for use with Sonic Solutions DVD Authoring System
- .CIN
- .ULT - Ultech format
- .CAP - CAP format
- .0 - Evertz CAP format
- .TDS
Import a file

This article describes how you can import another (non-Wincaps Q4) document into Wincaps Q4.

Use the following procedure to import a (non-Wincaps Q4) source document into a new target file.

The source document can be in any of the supported import formats.

Create a new file, selecting the customer and language as required. The properties of the new file will be based on the corresponding customer template, though some of these properties may be overridden by the import process.

Select File : Import from the main menu.

A message is displayed, warning you that any subtitles in the current file will be lost. Click Yes to continue.

Choose the source file to import.

Wincaps Q4 launches the Import Wizard to guide you through the process of importing the source file.

Choose the required options from those presented by the Import Wizard. Click Finish at any step to accept your current choices and continue with the import process.

Wincaps Q4 displays a progress dialog as the source file is imported. Warnings may be displayed if Wincaps Q4 detects that results may not be sensible. The import process is now complete.

The import process obeys the following rules:

- Any existing subtitles in the target file are deleted.
- Any GSI information in the source file is imported and the relevant GSI fields populated.
- The properties (e.g. personality, language) of the target file are set according to the choices made in the Import Wizard.
- Subtitles/text are imported from the source file along with timecodes, if present.
- Subtitle-level style and word-level style settings in the source file are preserved where possible. This includes position, justification and colours.
- Speakers and scene markers are imported if present in the source file. If the target file contains speakers (e.g. from a colour template) they will be merged.
- Imported subtitles are automatically word-wrapped if necessary. If this word-
wrapping results in extra subtitles being created in a timecoded file, these extra subtitles will be assigned "zero timecodes" of 00:00:00:00 and Wincaps Q4 will warn you accordingly at the end of the import process. If the source file contains unformatted (raw) text, Wincaps Q4 will split the text into subtitles using the settings defined in Configure Import for the active customer.

Import Wizard
The Import Wizard is designed to guide you through the process of importing or opening a third-party subtitle file. It displays a series of dialogs that allow you to choose how the incoming data will be processed. The set of dialogs displayed and their sequence will vary depending on the format of the source file and the choices that you make in the Wizard.

Remove first subtitle: (4.23.7 and before, PAC files only)

PAC files contain a special subtitle 0 that contains control information. Releases after 4.23.7 will no longer have the option to remove Subtitle Zero.

With this option checked, the Import Wizard will populate the GSI information from the contents of subtitle 0 but the user-defined subtitle 0 text will be cleared. If you
uncheck this option, the GSI information will be populated as before but in addition, the entire contents of subtitle 0 will be placed into the user-defined subtitle 0 text. Use this option to preserve the subtitle 0 information when the file being imported has a non-standard configuration.

Select Personality:

If the Wizard is unable to determine the personality of the imported file, it will prompt you to choose one. The subsequent Wizard screens will vary depending on the choice of personality. The Wizard defaults initially to Open Caption, then to the last choice you made during the current session.

Select Language:

The Wizard prompts you to choose the language of the imported file. In most cases,
the Wizard is able to determine the language by analysing the file and this will be displayed as the default choice.

**Convert numbers to Arabic:** (PAC files only, Arabic language only)

If you are importing an Arabic PAC file, the Wizard allows you to choose how to process any numerals contained within the subtitle text:

- **Do not convert numbers** - numerals are imported as Western Arabic (0 1 2 3 4 5 6 7 8 9)
- **Convert numbers to Arabic** - numerals are imported as Eastern Arabic (٠ ١ ٢ ٣ ٤ ٥ ٦ ٧ ٨ ٩)

This conversion can also be performed at a later time via the Convert Arabic numbers facility.

**Select encoding:** (text files only)
The Wizard attempts to determine the encoding of the text file and displays the detected format. You can override this if needed, though it should not normally be necessary.

**Configure Character Sets:**

Some file formats (e.g. PAC) support multiple character sets. Normally the Wizard can determine these settings automatically from the file but you have the ability to override the selection if desired. This setting is used to decode the characters in the imported file so it is important that the choice of character set is made correctly.

**Select Font:** (open caption personality only)
Choose the default font and size for the imported subtitles. If the imported data contains font information, subtitles that differ from the default selection will have their properties overridden. If no font information is contained in the file, the Wizard defaults initially to Arial.

The choice of font size may affect the vertical positioning of the imported subtitles. For example, when importing files in PAC format, you should always select a font size of 36 in order to get the best results.

**Surround:** (open caption personality only)

Choose the default background effect for the imported subtitles. The Wizard can sometimes determine this automatically from the file but you have the ability to override the selection if desired. If the imported data contains background information, subtitles that differ from the selection you make will have their properties
overridden. If no background information is contained in the file, the Wizard defaults initially to "Surround", then to the last choice you made during the current session.

**Timecode:**

If the file contains timecodes, the Wizard prompts you to choose how the timecode status is set:

- **All Fixed**: All timecodes will be set fixed
- **All Floating**: All timecodes will be set floating
- **Fixed IN floating Out**: All In times will be set to fixed, all Out times will be set to floating
- **Sequence: Fix First IN only**: Set the In time of the first subtitle in each sequence to fixed and set all other timecodes to floating
- **Sequence: Fix all INs and last OUT**: Set the In time of all subtitles to fixed, set the Out time of the last subtitle in each sequence to fixed and leave all the other Out times to floating
  
  A sequence is formed wherever subtitles have adjacent timecodes, i.e. the Out time of a subtitle is the same as the In time of the next subtitle.

The Wizard remembers the last choice you made during the current session.

**Select PAL/NTSC**: (open caption personality only)
Choose the video standard to use for the imported file. The Wizard defaults to "PAL".

**Select Teletext Code Behaviour:** (STL file import only)

Optionally force a white teletext colour code at the start of each row. The Wizard defaults to unchecked.

**Teletext row height:** (STL file import only)
Optionally import the subtitles as single-height rows. The Wizard defaults to unchecked.

**Position Override: (STL file import only)**

Optionally override the position information in the source file. The Wizard remembers the last choice you made during the current session.
Insert a file

Use the following procedure to insert text or subtitles from the (non-Wincaps Q4) source document into the currently open target file.

The source document can be in any of the supported import formats.

Open the target file and save it with a new name, if desired
Place the cursor at the point in the target file where you want the subtitles from the source file to be inserted. The new subtitles will be inserted after this subtitle. If you want to append the source file to the target file, place the cursor in the last subtitle
Select File : Insert other from the main menu
Choose the source file to insert
A confirmation dialog will be displayed
Click OK to continue. The contents of the source file will be inserted into the target file
Warnings may be displayed if Wincaps Q4 detects that results may not be sensible
The current file now contains the results of the merge operation

The insert process obeys the following rules:

Existing properties, subtitles or GSI information in the target file will remain unchanged
The subtitles/text will be inserted from the source file along with timecodes, if present
Subtitle-level style and word-level style settings in the source file will be preserved where possible. This includes position, justification and colours
Speakers and scene markers will be preserved and merged if present
Inserted subtitles will be automatically word-wrapped if necessary
If a file in a different language is inserted, some of the inserted characters may be invalid in the target language. In this case, an appropriate warning will be displayed
If the source file contains unformatted (raw) text, Wincaps Q4 will split the text into subtitles using the settings defined in Configure Import for the active customer.

This operation cannot be undone except by restoring from the automatic backup
Cue State

This state or mode can be used when On Air to cue out and edit prepared subtitles when using the Live Scroll, Cued Block Live transmission mode.

To use Cue State, you can use the button on the Standard Toolbar

Or you can use the keyboard shortcut 'F8'. The button and the shortcut are both toggles, and toggling out of Cue State will return to Edit mode.

When Q-Live is in Cue State the icon will look like this:

and the file tab will go red. You can now cue and clear prepared subtitles as 'block' subtitles. You can move to Live mode from Cue mode, and Q-Live will insert a blank subtitle with the focus ready for Live input. To move back to Cue State from Live mode, press or F8.

Raising a subtitle to the default raised position using Numpad Enter will change the subtitle on air immediately and the raised position will continue to be maintained until changed.
Changing the colour of the subtitle will take effect with the next subtitle cued and will continue to be maintained until changed.
This is the same behaviour as the colour and vertical position overrides for cued subtitles in Block or Live Scroll, Cued Block mode.
Speaker basics

You can use speaker information to perform automatic colouring of subtitle text. For this to work, each sentence of subtitle text needs to be assigned to a particular **speaker**. You can then assign specific colours to particular speakers, or have Wincaps Q4 automatically colour the text in the most efficient way. The general procedure for doing this is as follows:

Begin by importing a subtitle file that contains speaker information
Review and modify the speaker information as desired using the Speaker List pane of the Toolbox
Use autocolouring to automatically colour the text by speaker

Speakers are automatically created and assigned when you import a file that contains speaker information. The following file formats currently support this:

Protoscript - a text format containing scene and speaker information, generated by the **Screen Systems Script Extractor**.

Wincaps Q4 extracts the Speaker information from the imported file to populate the Speaker List and automatically assigns each sentence of imported text to the corresponding speaker.

You manage speakers using the Speaker List pane of the toolbox. Speakers can be created and text assigned to them on-the-fly by using the F keys.

You can create a speaker list template for each **programme** so that a set of common speakers is created with default colours already assigned each time a new **job** is created for that programme.

Speaker information may also be saved when exporting files in certain formats, e.g. EBU-TT.

**Note that the speaker functionality is only available when the Speaker List pane is active.**

Importing speaker and scene information
The following notes apply when importing or inserting a (source) file that contains speaker and/or scene information into the current file.

If the current file already contains any speakers (e.g. from the speaker template) they will remain unchanged
Speakers that exist in both files will be merged together. Note that speaker names are not case-sensitive, i.e. "SPEAKER" will be merged with "speaker"
After merging, any new speakers will be created in "most common first" order, i.e. the speaker who has the most dialog will be assigned the first empty slot. New speakers will all have a colour of "unassigned"
The total number of speakers cannot exceed 30. Any further speakers beyond this will not be added and their corresponding text will be unassigned
If the source file contains scene break information then a scene marker will be attached to the first subtitle in each new scene

**Scene markers** can be used to split the subtitle file into scenes of related dialogue.
This allows the autocolouring function to intelligently assign colours to speakers so that adjacent speakers use a different colour, whilst keeping the main colour for each main speaker as constant as possible. Scene markers may also be imported or inserted automatically if the source file contains them.

Scene markers are attached to subtitles. If a subtitle has a scene marker then it is considered to be the first subtitle in a new scene. If a subtitle has a scene marker then it will appear as shown below in the subtitle view:

You can toggle the scene marker on/off for the current subtitle in any of the following ways:

Click the **scene marker button** on the timing toolbar.
Press the **Ctrl K** key

**Working with the Speaker List**

The **Speaker List** pane of the Toolbox is where you create and manage the list of speakers for the current subtitle file.

The list may contain a maximum of 30 speakers.

The various elements of the Speaker List are shown below:
The Speaker List pane is divided into three elements: The upper toolbar (used to manage the speaker list), the speaker list itself and the lower toolbar (used to control the autocolouring settings).

The currently selected speaker (for managing the Speaker List) is shown with a grey background, i.e. "Paul" in the above illustration.

The active speaker (i.e. the speaker to which the text at the current cursor position in the current subtitle belongs) is shown with a red background, i.e. "Narrator" in the above illustration.

Each speaker has an F key assigned as shown. Pressing an F key whilst the Speaker List pane is active will have the following effect during subtitle editing/creation:

If the edit focus is in the current subtitle - the speaker corresponding to the F key will be assigned to the text at the current cursor position
If the edit focus is in the SpeakTitle Window - starting from the next spoken sentence, the speaker corresponding to the F key will be used

Pressing an F key that has no speaker currently assigned to it will create a new speaker.

Managing the Speaker List
This topic describes how to navigate the Speaker List and create, rename and delete individual speakers, as well as merging two speakers together.

The controls for managing the speaker list are located in the upper toolbar.

Navigation
You can access the Speaker List and its various buttons using both mouse and
keyboard commands.

Using the mouse:

Click on a speaker to make it the current selection
Click on any of the toolbar buttons to activate

Using the keyboard:

Move the focus to the Toolbox pane by pressing the Esc key until the top of the Speaker List tab is highlighted in orange
Use the Tab key to switch focus between the upper toolbar, speaker list and lower toolbar. The currently selected toolbar button is indicated by a “yellow square” background. The currently selected speaker is indicated by a grey background
Use the Arrow keys to select a particular button or speaker
Press the Space key To activate the selected button
Add a new speaker
To Add a new speaker, press any unassigned F key or click the Add button on the upper toolbar. A new speaker will be added to the bottom of the list as shown below:

| Narrator · F1 | Tanya · F2 | Paul · F3 | Crew · F4 | New 5 · F5 |

The new speaker is created with a default name and with no colour assigned, as indicated by the grey “question mark” icon.

Note that the text at the current cursor position will immediately be assigned to the new speaker.

New speakers are normally appended to the end of the list. However if a speaker is deleted and a new one added, the new speaker will be inserted in the position of the previously deleted speaker. The order of speakers in the list cannot be changed.

Assign a colour to a speaker
To assign a colour to the currently selected speaker, click the corresponding colour button on the upper toolbar. To set a speaker’s colour to “unassigned”, use the clear colour button.

Rename a speaker
To change the name of the currently selected speaker, click the Edit button on the upper toolbar.

Enter the new name into the box and click on OK. Speaker names are case-insensitive. Duplicate speaker names are not permitted.

Delete a speaker
To delete the currently selected speaker, click the Delete button on the upper toolbar. Use the Delete All button to delete all speakers in the file. A confirmation message will be displayed. Note that when a speaker is deleted, any subtitle text assigned to that speaker is automatically de-assigned.

Merge two speakers
To merge two speakers together, select the first speaker, then hold down the Ctrl
key and select the second speaker. The **Merge** button on the upper toolbar will be enabled. Click the **Merge** button and confirm the operation. The second speaker will be deleted and their associated text will be assigned to the first speaker.

**Colour templates**

Wincaps Q4 allows you to create a **colour template** for each programme defined in the system. This allows you to predefine the names of any speakers that appear regularly on the programme and assign colours to them. Then whenever a new job is created for that programme, the speaker list will be automatically populated with the information in the colour template.

Use the following steps to create or modify the colour template for a programme:

1. Open a subtitle file that has the programme assigned
2. Click the **Access colour template** button in the lower toolbar of the Speaker List pane. The **Speaker Colours** dialog is displayed as shown below:

![Speaker Colours Dialog](image)

Create and/or modify the list of speakers and assign colours via the toolbar which functions in a similar way to the upper toolbar in the main speaker list.

Click on the red X in the upper right-hand corner of the dialog to close it and save your changes. The colour template will be saved with the other programme information in the DataStore.

The next time you create a new job for that programme, the speaker list will be populated automatically from the new colour template.

**Note:** There is currently no way to apply a modified colour template to the current subtitle file. Changes made to a template will only be applied when a new file is created using that programme.

**Autocolouring**

Autocolouring allows you to take a file with speaker information and automatically colour the text belonging to each speaker in the most efficient way. Autocolouring scans the file to determine who the most frequent speakers are. It uses the results of this analysis together with the scene information (if present) to work out the optimum way of assigning colours to speakers.

The autocolouring mechanism colours the file according to the following rules:

- Adjacent speakers in the same scene are given different colours
- The most frequent speakers are given the brightest colours (in order
white/yellow/cyan/green/magenta)
The number of times that a particular speaker changes colour throughout the file is kept to a minimum

If a file does not contain any scene markers it is simply considered to be a single long scene.

Workflow
The autocolouring function is most useful after importing a script that contains speaker information. To autocolour such a file you would proceed as follows:

Start by creating a new file based on the appropriate programme. This will initialise the colour template if one is available.
Import the script to create the subtitles and populate the speaker list. The speakers in the imported file will be merged with those in the colour template to set the preferred colours for those speakers.
In the Speaker List, assign any other preferred colours as required. For best results, do not assign too many preferred colours, i.e. you should normally let the system choose.
Select any autocolouring options from the lower toolbar.
Click the Auto Colour button. Wincaps Q4 will colour the file according to the rules described above.

Autocolouring controls
The autocolouring controls are located in the lower toolbar area of the Speaker List pane.

The controls works as follows:

**Enable magenta** - if enabled, autocolouring is permitted to use magenta. If not enabled, autocolouring will not use magenta except where magenta has been explicitly assigned as a speaker's preferred colour.

**Ignore Scenes** - if enabled, autocolouring will ignore any scene markers, i.e. the whole script is considered to be one big scene. If disabled, scene markers are used if present.

**Manual colour override** - if enabled, setting a colour for a speaker will cause all text for that speaker to be coloured immediately in the selected colour. This method will ignore any autocolouring rules. If disabled, setting a colour for a speaker will simply set the preferred colour for that speaker. The preferred colour is used when autocolouring is performed. The text will not be coloured until autocolouring is run.

**Auto Colour** - click this button to autocolour the file. Speakers will be assigned their preferred colours unless a conflict occurs, in which case an alternative colour will be used. Speakers with no preferred colour are assigned a colour automatically by the system.

**Access colour template** - click here to learn about colour templates.
Add-on subtitles

Add-ons are multi-part subtitles where one or more new blocks of text are added to the original text after a period (i.e. the add-on subtitle does not clear the original subtitle). Each add-on sequence consists of an original subtitle and one or more add-on subtitles.

There are situations where the use of this dynamic reveal technique is possibly to be preferred over normal block mode where the whole text is displayed at the same time. An example might be revealing the punch line of a joke at just the right moment - rather than risk that the viewer reads ahead too quickly spoiling the joke or too slowly, missing some of the joke as it is replaced by a subtitle containing only the punch line.

Add-ons are only available in the Teletext personality.

You can run the addons check to verify that any add-ons in the current file are configured correctly with regard to timing and positioning.

Creating an add-on subtitle

To create an add-on subtitle (i.e. make the current subtitle appear without clearing the previous subtitle) press the + key on the numeric keypad. The out time of the preceding subtitle is automatically set to the same value as the out-time of the current subtitle. A + symbol (add-on indicator) is displayed to the left of the row number. To revert back to a normal subtitle press the + key again. The out time of the previous subtitle is then recalculated according to the Timing Rules.

Each add-on in a sequence has its own in time set in the normal way, though all will have the same out time as the original subtitle. When an add-on subtitle exists, the previous subtitle is output in a raised position, as shown in the illustration below:
If a file has unwanted Add-Ons then these can be removed by using the Delete Add-Ons option under the Tools menu options. This will remove all Add-ons but will not change the subtitle row heights. These can be changed by using Edit Properties.
Open / Closed Caption files

Change background effect

This topic describes how to manually change the background effect of individual subtitles in an Open Caption file.

Each file has a default background effect that is inherited by all subtitles. You can override the default and change the background effect of individual subtitles within the file by right-clicking on a subtitle and selecting **Background effect...** from the pop-up menu.

The subtitle background dialog is displayed.

Choose the desired surround type and style for the current subtitle and click **OK**. The chosen background will be displayed when the subtitle is previewed in the Video Window.

Click here to see the list of supported background effects and styles.

To revert to using the default background effect, select type "None".
Configure the subtitle font, style and size

This topic describes how to change the font attributes of individual words or subtitles, overriding the file default settings.

This capability is only applicable to Open Caption files as other personalities use fixed fonts.

The font attributes can be changed using the style toolbar.

In addition, the following shortcut keys can be used:

- **Ctrl B** - bold
- **Ctrl I** - italic
- **Ctrl U** - underline

To change all the text in the current subtitle, simply choose the new attributes via the toolbar or press the appropriate shortcut key.

If the current subtitle is part of a larger sentence, the style change will be automatically applied to the rest of the sentence. If you want to change the style of the current subtitle only, first select the text using **Ctrl A**.

If you first highlight *individual words* then the changes will only be applied to the selected text.

To change *multiple subtitles*, switch to the Compact View and select the subtitles to change. Then choose the new attributes via the toolbar and confirm the changes.

If the current selection is or includes the last subtitle then the new attributes also apply (until changed) to any new subtitles added after that.

You can set more advanced font options for the current subtitle by right-clicking on the subtitle and selecting **Font...** from the pop-up menu. The **Change Subtitle Font** dialog is displayed.
The settings are described here. Click **OK** to apply the changes to the current subtitle.

To change the advanced font options for *multiple subtitles*, switch to the Compact View and select the subtitles to change. Right-click on one of the selected subtitles and choose **Font...** from the pop-up menu.

## Change case

This topic describes how to change the case of subtitle text. This facility can be particularly useful when re-purposing original US Closed Captions, which are often all capitalised.

You can change the text in a couple of ways:

- **Change the case of the current word or current selection**
- **Place the cursor on the word or select a block of text**

Press the **Ctrl M** key

The **Ctrl M** key changes capitalisation, toggling between lower case, **Title Case** and **UPPER CASE**. This action applies on every word in the given selection (including any words that are only partially selected). When changing a single word, the cursor need only be positioned somewhere in that word, there is no need to select the whole word first.

The above operation is supported in all three subtitle views.

- **Change the case of one or more subtitles**
- **Switch to the **Compact View** and select a range of subtitles to change.** You may also marquee select subtitles for this operation.
Press the Ctrl M key to display the Change Case dialog:

Select the required options as follows:

**Lower case** - changes all text to lower case
**Upper case** - changes all text to upper case
**Mixed case sentence** - if enabled when Lower case is selected, changes all text to lower case but retain capitals at the beginning of sentences. Note that capitalisation of proper nouns does not take place in this case

Click on OK to change the case of the selected subtitles. This operation cannot be undone
Create Open Caption subtitles in a Teletext file

This can sometimes be useful when preparing subtitles for output to a variety of different media. Note that the normal restrictions on subtitle timecodes apply so it is not possible to have an Open Caption subtitle and a Teletext subtitle on screen at the same time.

The Enable Open Caption subtitles option must be enabled in the file personality dialog.

To make the active subtitle Open Caption, press the Ctrl T key.

Press the Ctrl T key again to return the Open Caption subtitle to Teletext format.

Safe Area settings can also be configured for Open Caption subtitles.

Forced subtitles (Open Captioning)

A forced subtitle is a term used in Open Caption subtitling. It refers to a subtitle that should be displayed on the viewer's TV screen even if they have subtitles turned off.

Forced flags are used when exporting a file with the DVD Builder (where a DVD export format supports the use of forced subtitles).

Forced flags are also used in Q-Live to allow Dual Open Caption output.

You can make the current subtitle forced by selecting Edit properties... Force On from the right-click menu. You can also use the "toggle force" button located on the file toolbar. A forced subtitle is indicated by an F in the subtitle display as shown below.
To remove the force flag from the current subtitle, repeat the above operation to toggle the flag off.

To remove all force flags from the current file, select Edit properties... Clear all Forced from the right-click menu.

To remove forced flags from a range of subtitles, first switch to the Compact View and select a range of subtitles.

**Closed Caption editing**

Wincaps Q4 supports various Closed Caption display options, the pop-on style being the default. You can select these options via the Line 21 toolbar.

The Closed Caption display options are:

- **Pop on** (default) - the caption appears and disappears like in Open Captioning
- **Paint on** - the caption displays character by character
- **Roll up** - the caption displays 1, 2, 3 or 4 lines at a time, scrolling smoothly upwards

- **Tower/Un-tower Subtitle** - depending on the display of the captions required, you can change the display to form a single line or a block using Tower Subtitle or Un-tower Subtitle as appropriate

- **Tab Align** - *(not currently used)*

- **Re-time sequence** - *(not currently used)*

You can use the **Italic** and **Underline** buttons to set the corresponding styles.

Finally, you can use the toolbar to insert various special symbols.
Comments

Each subtitle has a comments field that you can use to record any notes relating to that subtitle, e.g. reviewers’ comments or translation notes.

Comments are not normally visible. If a subtitle has a comment then the comment indicator icon will appear in the subtitle display view as shown below (Wincaps Q4 Offline only)

![Comment indicator]

Comments can be viewed and edited in the List View / News View. If a subtitle has a comment then it will be displayed above the subtitle text when that subtitle is selected, as shown below.

![Comment display]

Displaying comments

Wincaps Q4 normally only displays the comment for the active subtitle. To display comments for all subtitles, select Tools : Show All Comments from the main menu or click the Show all comments button on the Timing toolbar.

In the Compact View you can view a comment by hovering the mouse pointer over the comment indicator as shown below:

![Comment view]

Navigating comments

You can use the Ctrl D key to quickly jump to the next subtitle in the current file/story that has a comment defined. Press the Ctrl Shift D key to jump to the previous
Adding comments

With the List View / News View active, use the Ctrl Shift C key to add a comment to the current subtitle. The comment field opens ready for you to enter the comment text.

Editing comments

To edit a comment, click inside the comment field and start typing. You can also use the tab key to move the cursor into the comments field. You can use the Shift Return key to insert line breaks into the comment text.

With the cursor in the comment field, press the Return key to save the comment and move the cursor back to the subtitle text. Press the Esc key to return the focus to the subtitle text without saving the current edit.

Clearing comments

To remove the comment text from the current subtitle you can simply delete all the text from the comment field and press the Return key.

To clear the comments from a range of subtitles or the entire file/story, use the Ctrl Alt C key to bring up the Clearing all comments dialog as shown below:

Choose the range of subtitles to affect and click OK. A confirmation message will be displayed, after which all comments will be cleared from the chosen subtitles. Note that this operation cannot be undone.
Exporting files containing comments

Comments are normally lost when exporting the subtitle file to another format. Of the available exports, the various EBU/STL formats (with the exception of the Win2020 variant) support comments, as per the EBU specification.

You can export all the comments (only) in the current file to a text file via the File : Export : Comments menu (Wincaps Q4 only)

Modes

The current mode is shown in yellow on the Modes Toolbar in the top right of the screen. Simply click on the desired button to select a mode.

You will normally work in Edit Mode when creating and editing subtitles. A more limited set of editing features is supported in the other modes.

Fix Mode can be used to capture timecodes manually whilst the video is playing.

You can use Replay Mode to replay the file against the video in order to check the subtitle timings.
Shortforms

Shortforms can be used to reduce the amount of typing required and to ensure consistent spelling of commonly used words or phrases, for example the names of people or places. Shortforms are similar to the AutoText facility in Microsoft Word. Once a shortform has been configured, you just need type the abbreviated “shortform” followed by a space, punctuation or the return key and Wincaps Q4 expands it automatically to the corresponding long form.

For instance, "iag" can be defined as the shortform for "it's a goal", so that when you type iag, the phrase "it's a goal" is produced. Shortforms are particularly useful when the same text (e.g. a scientific term or reference) is used frequently throughout a programme.

The shortform definitions (known as topics) are held in the DataStore. In a multi-user system, each user may have their own set of personal shortform topics which can be activated as required by the current job.

You can run a shortforms check to quickly identify and replace any shortforms in an existing file.

Using shortforms
Shortforms are used whenever you are entering or editing text in the current subtitle using the keyboard. Typing the shortform followed by a space, punctuation or the return key will immediately expand it into the corresponding long-form. For example, if you define a shortform as follows:

![Edit Topic - Diving Doris](image)

Then entering the following text into the active subtitle followed by a space...
... will produce the following results.

There are three levels of Shortforms, Global, Programme and User. If there are any duplicate Shortforms this is the order they will be displayed in.

The Report Clashes option will pick any duplicate Shortforms and produce a report if there are any;

The Report Clash currently saves the report in C:\Users\user.txt in 4.24.9 which standard Windows permissions will not allow. This is being repaired.

Troubleshooting problems

- If the shortform is not being expanded at all, check that the topic containing the shortform is in the active list
- If the shortform is being expanded to the wrong text, check that the shortform is not defined in more than one active topic
- If the case of the expansion is incorrect, check the definition of the shortform to ensure that the case is specified correctly
Stenograph input

Stenograph input to Wincaps Q4 is achieved via the Screen Systems StenoClient software. Configuration and use of the StenoClient software is covered by the StenoClient User Guide. Contact Screen Subtitling Support for assistance with this product.

Operation of StenoClient input to Wincaps Q4 is as follows:

Both Wincaps Q4 and StenoClient need to be configured to use the same port (normally 4000) and StenoClient needs to be aware of the machine name or TCP/IP address of the target Wincaps Q4 client machine. StenoClient should perform a connection to the Wincaps Q4 Client using the normal “Connect” function – at which point a “connected” icon appears in the Wincaps Q4 toolbar.

Text sent from StenoClient passes through the House Styles processing and into the document at the end of the current subtitle. Hash commands sent from StenoClient will affect the input in the normal way that hash commands would work during speech input (e.g. to change colour or take a new subtitle).

At the end of the session, StenoClient should disconnect.

Shortforms are not applied to Steno input.

If the StenoClient software is running on a different machine, then the firewalls must be configured to open the communications port (normally 4000).

If necessary, the port number can be changed by editing the following section in the QuantumDataLocal.ini file and restarting Qu4ntum.

[QuantumData\QuantumSteno]
Host=4000

The status of the Steno input is displayed on the status bar.

The possible status values are:

- Stenograph disconnected
- Stenograph connected
- Stenograph connection error
Text splitting

When creating subtitles, it is desirable to split each row of text so that it is easy to read and remains sensible grammatically and linguistically.

The point at which a row or subtitle is split can always be chosen manually. In addition, Wincaps Q4 provides the powerful capability to automatically split text at sensible points.

Once configured, automatic text splitting is used whenever you:

Enter text at the end of the current subtitle using any method when auto-splitting is enabled
Enter text via the SpeakTitle Window when auto-splitting is enabled
Paste a block of unformatted text from the clipboard into a subtitle

Automatic text splitting whilst entering text can be toggled on/off via the button located on the file toolbar or via the Ctrl L keystroke. The button icon will change to indicate the current state as follows:

- Auto-splitting on and active
- Auto-splitting on but inactive
- Auto-splitting off

Wincaps Q4 remembers the state of this button between sessions.

Automatic text splitting is automatically disabled when you are working in the Timeline and Compact Views.

Automatic text splitting is only active when you are entering text at the end of the current subtitle. If you are entering or editing text in the middle of a subtitle then automatic text splitting will not occur. Automatic text splitting is most useful when you are originating new subtitles. If you are editing and tidying existing text it is normally best to turn it off.

Automatic text splitting must be configured correctly in order for it to work. If it is not correctly configured, Wincaps Q4 will split text using basic rules, i.e. it will simply fit as much text on to each row as possible.

The text splitting settings are held in the DataStore and are global to all users of the system. You can configure Wincaps Q4 so that each different language has its own unique set of text splitting rules.

Example of text splitting
This example shows the difference that automatic text splitting makes when the following text is pasted into the current subtitle:

Yeah Tanya obviously has an attraction. I mean anybody who says that sex
doesn’t sell is a liar because it does.

With no automatic text splitting configured, the results will look like this:

```
Yeah Tanya obviously has an attraction. I mean anybody who says that sex doesn’t sell is a liar because it does.
```

The text is broken using the basic method of fitting as much text onto each line as possible.

With automatic text splitting correctly configured, the results are much better:

```
Yeah Tanya obviously has an attraction.

I mean anybody who says that sex doesn’t sell is a liar because it does.
```

This time the text is split at sensible points meaning that less editing is required to make the subtitles readable.

Text splitting when originating text

Automatic text splitting is most useful when originating text, either by typing it in manually or when respeaking. The following example shows how text splitting works when entering text directly into the current subtitle:

Check that automatic text splitting is enabled (via Ctrl L). In this example the Line break on colour option is enabled to automatically insert a new line when the speaker changes. Place the cursor at the end of the current subtitle and start entering the text. The text will gradually build up in the subtitle as shown below:
Keep entering the text. When it reaches a suitable point (determined automatically by Wincaps Q4) the system "peels off" a new subtitle from the beginning of the text block as shown below:

The average person can hold their breath for 40 seconds.

Tanya Streeter can do it for over six minutes.
It’s just my thing.

The cursor position does not change, meaning that you can continue to enter text and Wincaps Q4 will ensure that it splits at the most suitable places.

The average person can hold their breath for 40 seconds.

Tanya Streeter can do it for over six minutes.
It’s just my thing. I have this unique relationship with the ocean.

When you enter the next character, Wincaps Q4 peels off another subtitle as shown below:
Text splitting via SpeakTitle

This example shows how text splitting works when entering text via the SpeakTitle window:

Check that automatic text splitting is enabled (via Ctrl L). In this example the Line break on colour option is enabled to automatically insert a new line when the speaker changes.
Place the cursor in the SpeakTitle window and start entering the text. The text will gradually build up in the SpeakTitle window as shown below:

Keep entering the text. When it reaches a suitable point (determined automatically by Wincaps Q4) the system "peels off" a new subtitle from the beginning of the text block as shown below:
The average person can hold their breath for 40 seconds. Tanya Streeter can do it for over six minutes. It's just my thing. I have this unique relationship with the ocean.

Continue to enter text and Wincaps Q4 will ensure that the text splits at the most suitable places.

The average person can hold their breath for 40 seconds. Tanya Streeter can do it for over six minutes. It's just my thing. I have this unique relationship with the ocean.

When you enter the next word into the SpeakTitle window, Wincaps Q4 peels off another subtitle as shown below:
Text splitting options

Most of the text splitting options are configured globally, i.e. they will apply to all files. However, some text splitting options may be configured on a per-file basis.

To configure the per-file text splitting options, click the Splitting button in the Subtitle defaults & preferences section of the Toolbox->File Info tab.

The following dialog is displayed:

If **Single sentence text splitting** is checked then a new subtitle will be started after each sentence end. If the option is unchecked then Wincaps Q4 will allow subtitles to contain text from multiple sentences. This setting is configurable in the customer template.

Sentence end characters are as follows:

<table>
<thead>
<tr>
<th>Character</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Full-stop</td>
<td>.</td>
</tr>
<tr>
<td>Exclamation mark</td>
<td>!</td>
</tr>
<tr>
<td>Question mark</td>
<td>?</td>
</tr>
<tr>
<td>Three dots</td>
<td>*...</td>
</tr>
<tr>
<td>Bracket</td>
<td>*)</td>
</tr>
<tr>
<td>Colon</td>
<td>* :</td>
</tr>
</tbody>
</table>

* These characters are optional and are not considered sentence ending by default.
Note that all of the above characters are only considered to be sentence ending when immediately followed by a space, a new line or a new subtitle.

**Timecode**

**Timecodes** determine when a subtitle is to be displayed. The **In time** specifies the moment that a given subtitle is to appear on-screen. The **Out time** determines the point when that subtitle is to be removed from view.

Wincaps Q4 does not allow timecodes to be put out of sequence. A timecode that is edited to be out of sequence will be returned to its original state. See the Messages window for the full explanation.

**Timecodes in offline subtitling**

Fixing the In and Out times of each subtitle correctly is a key part of the offline subtitling process. Different jobs may require timecodes to obey different rules with regards to duration, gaps and proximity to shot-changes. Wincaps Q4 therefore allows you to create a set of **Timing Rules** for the current file. Once defined, these rules are automatically applied whenever you fix a timecode, adjusting the resulting In or Out time if necessary to comply with the rules.

Wincaps Q4 has powerful features for automatically synchronising subtitle text with the corresponding speech in the audio track. Using the **Aligner**, you need define only the start and end times for an entire section of dialogue and Wincaps Q4 will automatically fix the timecodes for each subtitle, aligning the text against the audio track and applying the Timing Rules as it goes along. Depending on the quality of the audio track, this will often produce near-perfect timecodes with the minimum of effort.

Wincaps Q4 allows you to manually capture and/or edit timecodes in a variety of different ways. The most common technique is to **grab** the current timecode from the media via a keypress, but you can also edit timecodes manually and even adjust them graphically in the Timeline View.

Once you have fixed all the timecodes for a file, you can use the **timing checks** to quickly locate and correct any subtitles that don't comply with the Timing Rules.

Special rules apply for Closed Caption (Line 21) subtitles as the subtitle **build-times** need to be taken into account.
Timecode display

The current timecode is shown immediately below the Video Window:

Timecode is displayed as **HH:MM:SS:FF** (hours:minutes:seconds:frames)

When a media file is open, the current timecode tracks the currently displayed video frame. If the media file contains embedded timecode, Wincaps Q4 determines the current timecode directly from the video. If there is no embedded timecode, the current timecode should be synchronised with the burnt-in timecode when the media is indexed.

The timecode settings for each subtitle are shown in the Subtitle Display area:

**Duration** is calculated as the difference between the In and Out times and always adjusts itself automatically with any change to the In time or Out time. The duration will turn red if the Out time of a subtitle overlaps with the In time of the following subtitle. A duration of **??:??** indicates an error such as the current subtitle’s In time being later than its own Out time or later than the In time of the following subtitle (i.e. out of sequence).

**Display rate** provides you with a colour-coded indication as to whether the subtitle duration is acceptable, based on the configured values of default and maximum word rate.

- Cyan - slow ( < 90% of the default rate )
- Green - excellent
- Yellow - average
- Orange - poor
- Red - bad ( > the maximum rate )
Timecode status

The background colour of the In and Out times indicates the timecode status as follow:

Yellow - floating timecodes - are the default for new subtitles and are not subject to the timing rules.

White - fixed timecodes - are either grabbed by the user or set automatically by the Aligner. Fixed timecodes may be modified by the Timing Rules as Qu4ntum sees fit.

Green - explicit timecodes - are set deliberately by the user, typically via an explicit grab or by editing the timecode directly. An explicit timecode will not be changed by the Timing Rules except where an adjacent explicit timecode would cause an overlap or exceed the minimum gap. click here for more details.

When you create a new subtitle, its (floating) In time will be based on the Out time of the previous subtitle plus any minimum gap specified in the Timing Rules. If a subtitle has a floating Out time it will be adjusted automatically as you edit the subtitle text, based on the word rate.

You can toggle a timecode’s status between fixed and floating using the following keys located on the numeric keypad:

Ctrl - toggle the status of the In time
Ctrl + toggle the status of the Out time

Toggling a timecode’s status in this way will not cause the Timing Rules to be applied.

Supported timecode formats

Wincaps Q4 supports all common TV/DVD timecode formats (hh:mm:ss:ff) for 625 line PAL 25fps, 525 line NTSC 29.97fps (drop frame and non-drop frame), and 1080/720 line HD (25i/50p, 30i/60p) plus 24fps for film. Tools are provided to convert a subtitle file from one timecode format to another.

Adjust timecodes for a range of subtitles

Wincaps Q4 allows you to choose a range of subtitles and apply an offset to all timecodes, as well as changing their fixed/floating status.

You can adjust timecodes in one of the following ways:

Press the Ctrl Shift O key
Click the Toolbox->File Info->Timecode modification->Offset & Status button.

Wincaps Q4 will first prompt you to select the range of subtitles to be changed.

If you switch to the Compact View and select a range of subtitles first, then Wincaps Q4 will skip the display of the Choose Subtitle Range dialog.
The default settings will adjust the timecodes for all subtitles in the current file/story.

Choose the range of subtitles to modify and click OK. Wincaps Q4 will now ask you to choose how the timecodes should be modified:

You can specify the offset in either of two ways:

Enter a new In time or Out time for the first subtitle in the chosen range. The Timecode offset (adjust by value) will be calculated accordingly. Simply select Add or Subtract timecode and enter a value into the Timecode box.
Note that the three boxes are linked so that the effect of any change in one is immediately shown in the others.

To change the fixed/floating status of the timecodes, click on the **Fixed Status** tab.

If **Ignore** is selected, Wincaps Q4 will not make any changes to the fixed/floating status.

**Set floating** will set the selected timecodes to be floating. If **Set floating** is selected for the Out time, an additional option is available to **Refloat** the Out times, i.e. re-calculate the Out times based on the current Timing Rules. If you choose not to select this option, the existing Out time of each subtitle will be retained.

**Set fixed** will change the selected timecodes to fixed.

Click **OK** to apply the changes. A confirmation message will be displayed.

Qu4ntum will apply the specified offset to each subtitle in the chosen range, and/or change their status.

This operation cannot be undone except by restoring from the automatic backup.

**Clear timecodes for a range of subtitles**

You can clear timecodes for a range of subtitles via the Toolbox->File Info->Timecode modification->Clear button.

Wincaps Q4 will first prompt you to select the range of subtitles to be changed.
If you switch to the **Compact View** and select a range of subtitles first, then Wincaps Q4 will skip the display of the Choose Subtitle Range dialog.

![Choose Subtitle Range - Clear timecodes](image)

The default settings will adjust the timecodes for all subtitles in the current file/story.

Click on **OK**. A confirmation message will be displayed. The selected subtitles will have their timecodes (In and Out times) set to 00:00:00:00 and the status of all timecodes will be set to "floating".

⚠️ **This operation cannot be undone except by restoring from the automatic backup**

This operation may also be accessed by right-clicking on a subtitle and selecting **Edit Properties->Clear all timecodes** from the pop-up menu.
Edit timecodes graphically

When you are working in the Timeline View, the In times and Out times of each subtitle are plotted accurately against the timeline such that you can immediately see the relative durations of the subtitles by comparing the heights of the subtitle displays. You can also see immediately where the subtitles fall in relation to shot changes and speech presence.

Wincaps Q4 lets you use the mouse to move or resize the rectangle of the current subtitle, changing its In time and Out time accordingly.

To move the subtitle, click and drag inside any non-editable part of the subtitle display, e.g. in the light-grey border area or the check lights.

You can drag the subtitle up or down the timeline as desired, although Wincaps Q4 will not allow it to move out of sequence. When you release the mouse, Wincaps Q4 drops the subtitle in the current location and applies the Timing Rules to the new In and Out times. Whilst you are dragging a subtitle its original duration is maintained, though it may change as a result of the Timing Rules being applied.

To resize the subtitle, move the mouse over the top or bottom edge so that the pointer changes to look like this (top edge) or this (bottom edge). Drag the top edge to change the In time and the bottom edge to change the Out time. Click and drag the mouse to resize the subtitle. When you release the mouse, Wincaps Q4 sets the In or Out time to the current position and applies the Timing Rules to that timecode.

If you hold down the Ctrl key during a resize operation, Wincaps Q4 sets the status of the affected timecode to explicit and does not apply the Timing Rules to the edge that you moved, though the timing rules will be applied to the adjacent edge (i.e. the previous Out-time or the next In-time) where appropriate.

Note the following points when moving or resizing subtitles:

You can’t move or resize the current subtitle so that it goes out of sequence with the previous or next subtitles
When editing a subtitle that was timed using the Aligner, you can't move it outside of its original section.

**Re-Sync timecodes**

You can use the *Re-Sync Timecodes* operation to quickly re-time the file/story from the current subtitle onwards. This is particularly useful in situations where the video has been recut. The current subtitle is given an In Time that matches the current video position and all subsequent timecodes are offset by the same amount.

Use the following procedure to re-sync the timecodes:

1. Select the first subtitle to be re-timed
2. Position the video at the point where you want to set the In time of the current subtitle
3. Activate the *Re Sync* operation via one of the following methods:
   - Press the **Ctrl Shift R** key
   - Click the *Toolbox-* > *File Info-* > *Timecode modification-* > *Re-Sync* button.

   The following dialog is displayed.

   ![Synchronise Timecodes to Video](image)

   The value of **New IN time** is set to the current video timecode. You can adjust it if required before clicking **OK**.

   When you click **OK** the current subtitle is given the new value of In Time and all subsequent timecodes are offset by the same amount.

   **This operation cannot be undone except by restoring from the automatic backup**

**Sort timecodes**

You can use the *Tools : Sort Timecodes* facility located on the main menu to re-sequence the whole of the current file (Wincaps Q4 Offline) or story (Q-Live) by timecode. This function is particularly useful following insertion from another file of a sequence of subtitles that interweave with the timing of the original subtitles. This may be needed for instance where the original video programme contained more than one language to be translated or where songs and dialog are initially translated separately and the files then need to be merged together.

A confirmation message will be displayed before the sort is carried out since this
operation cannot be undone.

Note that if the file contains scene markers or section markers, the sort operation will not affect them and they will remain attached to their original subtitles. You may need to correct any overlaps or discrepancies manually after the sort operation is complete.

**Timecode compression**

This function shortens (or expands) the total duration of the subtitles by simple arithmetical methods, either to allow for PAL 4% speed-up after telecine or to compensate for a minor late edit.

Before using this facility, you should first make a precautionary copy of the subtitle file as the changes cannot be undone.

Click the **Compress** button in the File Info pane of the Toolbox. The following dialog is displayed:

Use the **Digital/Analogue** buttons to quickly select 25fps PAL 4% speed-up from 24fps (analogue) or 23.976fps (digital), based on a user specified single reference frame (or equivalent slow-down). This function does not affect the frame rate selected for the file’s Personality.
Use the **Compress** button to adjust timecodes quickly to compensate for a slightly different edit being made in the final production/broadcast video. This feature simply stretches or contracts the duration of each subtitle and intervening gaps (obeying any minimum gap and/or minimum/maximum duration rules) to attempt to align the subtitle file with the revised video - based on a user specified pair of reference frames (one near the start and one near the end). This timing re-calculation is really suitable only if the edit has just a small effect on the duration of the video. A deleted scene, for example, would require a more significant re-working.

## Set In and Out times

Wincaps Q4 provides various ways to set the In time and Out time of each subtitle. The basic techniques are:

- Use the background Aligner to automatically align subtitles against speech in the audio track of the media. Subtitles processed by the Aligner will be set to **fixed** status and the Timing Rules will be applied.
- Use Fix Mode to quickly set timecodes by manually cueing a sequence of prepared subtitles.
- Manually grab the timecode at the current media position via a key press. A **fixed grab** will apply the timing rules to the captured timecode, whereas an **explicit grab** allows you to override the Timing Rules if necessary.
- Edit timecodes manually by typing an **explicit** value in the subtitle display.
- Nudge timecodes 1 frame at a time using shortcut keys.
- Adjust timecodes graphically by dragging and resizing subtitles in the Timeline View.
- Snap (butt up) the current subtitle to the previous subtitle via a keystroke.

The most efficient combination of techniques to use for any given job will depend on the nature of your workflow.

The various manual techniques are described in the following sections.

**IMPORTANT NOTE:** In **Edit Mode**, Wincaps Q4 always prevents you from changing a timecode if it would cause the subtitle to go **out of sequence** or have a zero or -ve duration. For example, you cannot change the In time of a subtitle if it would precede the In time of the previous subtitle or exceed the In time of the next subtitle. This situation applies even if all the timing rules are disabled. These restrictions do not apply in Fix Mode.

### Grab timecodes

You can **grab** the In time and/or Out time of the current subtitle directly from the current media timecode. Pause the video at the required frame and use the following keystrokes located on the numeric keypad:

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Ins (or Ins) *</td>
<td>grab fixed In time</td>
</tr>
<tr>
<td>Shift Del (or Del) *</td>
<td>grab fixed Out time</td>
</tr>
<tr>
<td>Ctrl Ins</td>
<td>grab explicit In time</td>
</tr>
<tr>
<td>Ctrl Del</td>
<td>grab explicit Out time</td>
</tr>
</tbody>
</table>

* Note that these default keystrokes may be reconfigured to suit your personal preferences.
Edit timecodes manually

You can manually adjust the In time, Out time and duration of the current subtitle by clicking directly inside one of the three timecode fields. Alternatively, use the **tab key** to cycle the input focus between the subtitle text and each of the timecode fields in turn.

Once the cursor is in one of the timecode fields you can enter a value directly using the number keys or use the **up/down arrow keys** to adjust the timecode by 1 frame in either direction. Hold down the **Ctrl key** as well to adjust the timecode by 5 frames at a time.

Adjusting the duration in this way will cause the Out time to change accordingly.

If you edit a timecode manually in this way its status will be set to **explicit** and it will no longer be subject to alteration by the timing rules.

Refer to Keyboard shortcuts for more details of the available keystroke combinations.

Nudge timecodes
You can nudge the timecodes of the current subtitle by one frame at a time via the following keystrokes:

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl 6</td>
<td>increase the In time of the current subtitle by one frame</td>
</tr>
<tr>
<td>Ctrl Shift 6</td>
<td>decrease the In time of the current subtitle by one frame</td>
</tr>
<tr>
<td>Ctrl 7</td>
<td>increase the Out time of the current subtitle by one frame</td>
</tr>
<tr>
<td>Ctrl Shift 7</td>
<td>decrease the Out time of the current subtitle by one frame</td>
</tr>
</tbody>
</table>

**Note:** the 6 and 7 keys are those located on the main keyboard, not the NumPad.

If you nudge a timecode in this way its status will be set to **explicit** and it will no longer be subject to alteration by the timing rules. If you nudge an In time, the timing rules will be applied to the Out time of the previous subtitle, ensuring that overlaps are prevented and/or the minimum gap is maintained. Similarly, if you nudge an Out time then the In time of the next subtitle will be treated in the same way. Note that if these adjacent timecodes are themselves explicit, they will be set back to fixed.

Snap subtitles together (butt up)

Wincaps Q4 provides simple keystrokes to snap the In time of the current subtitle to the Out time of the previous subtitle so that the two subtitles are separated only by the minimum gap. In each case, use the **+ key** located on the **numeric keypad** in combination with the Shift and Ctrl keys as shown below:
Shift + adjust the Out time of the previous subtitle to match the In time of the current subtitle

Ctrl Shift + adjust the In time of the current subtitle to match the Out time of the previous subtitle

Note that the Timing Rules are not applied during this operation. If the timecode being moved is explicit, it will be set back to fixed.

Effect of explicit timecodes when setting In and Out times
Explicit timecodes are not subject to change by the timing rules.

You can set an explicit timecode in any of the following ways:

- Manually grab the timecode via an explicit grab keystroke
- Edit the timecode manually by typing into the subtitle display
- Nudge the timecodes one frame via a keystroke
- Perform an explicit drag operation in the Timeline View (using the Ctrl key)

In each case, the timecode you are changing becomes explicit (green) and is set to the value you have chosen. The Timing Rules are NOT automatically applied to this timecode. However, the Timing Rules are automatically applied to the adjacent timecode (i.e. the previous In time or the next Out time) unless the adjacent timecode is itself explicit. In this case, the adjacent timecode will not be changed by the Timing Rules unless the new timecode violates the minimum gap or causes an overlap. In this situation, the adjacent timecode reverts to fixed status and the Timing Rules are applied.

Effect of splitting and joining subtitles on timecodes
When you split a subtitle, Wincaps Q4 uses the following rules to set the In and Out times of the resulting subtitles. Assuming that the original subtitle is split into two parts, A and B:

When splitting a subtitle with a fixed or explicit Out time:

The In time of part A is set to the original In time and the Out time of part B is set to the original Out time. The Timing Rules are not applied to these (outer) timecodes and their status will not change.

The intermediate timecodes are initially calculated based on the word rate and the timing rules then applied.

The status of the intermediate timecodes is set to fixed.

When splitting a subtitle with a floating Out time, the Timing Rules are not applied. The In time of part A is set to the original In time and the other timecodes are floated according to the word rate.

When you join two subtitles together, Wincaps Q4 sets the In time of the combined subtitle to the In time of the original first part and its status remains unchanged. The Out time is set to the Out time of the original second part if the status is fixed or explicit, otherwise the new Out time is floated according to the word rate. The Timing Rules are not applied during a join.
Timing Rules

This article describes how to use the Timing Rules from the perspective of off-line subtitling. Click here to learn how the Timing rules are applied when capturing timecodes during live subtitling.

Overview
When a timecode is grabbed manually or is generated automatically by text-to-speech alignment, Wincaps Q4 can run this timecode through a set of rules to optimise its relationship to shot changes and adjacent subtitles. These Timing Rules are normally defined as part of the customer template and will be initialised automatically if the correct customer is selected when the subtitle file is first created.

The Timing Rules are designed to summarise all of the various “pulls” on a timecode based on its relationship to shot changes, other subtitles and the effect on reading speed and duration. The rules are applied every time a subtitle timecode is changed, other than when that change is signalled as being explicit (i.e. it overrides the rules) or an offset is being applied. So (for example) if the Aligner creates timecodes based just on speech alignment, they are then run through the Timing Rules. If you grab a timecode or click and drag a subtitle or one of its edges in the Timeline View, the change will be run through the Timing Rules unless you hold down the Ctrl key to signify it as being explicit. If you type in a timecode value, or nudge an existing value, it will be regarded as an explicit change and not subject to the rules.

Because there are a number of possibly competing factors involved, the Timing Rules are applied in sequence and the end result is often a compromise between different parameters. It is not of course mandatory to have all the rules enabled, and you can if you wish restrict the items which are in play.

Whenever Wincaps Q4 applies the Timing Rules to a timecode, it logs a narrative in the Messages pane of the toolbox explaining the changes that have been made. This narrative can be helpful in order to understand why the Timing Rules were applied in a particular way.

Configuration
To configure the Timing Rules for the current file, click the Timing rules button in the File Properties section of the Toolbox->File Info tab. The Timing Rules Configuration dialog is displayed:
Individual rules can be enabled or disabled using the checkbox to the left of the name. **Enable all** and **Disable all** switch all rules on or off.

Note that in Edit Mode, Wincaps Q4 always prevents you from changing a timecode if it would cause the subtitle to go out of sequence or have a zero or -ve duration. For example, you cannot change the In time of a subtitle if it would precede the In time of the previous subtitle or exceed the In time of the next subtitle. This situation applies even if all the timing rules are disabled. These restrictions do not apply in Fix Mode.

**Default subtitle display rate** sets the target reading rate in words per minute or characters per second/minute. Wincaps Q4 uses this value to determine the optimal display time (duration) of each subtitle. Note that the ideal time is not always attainable since it may need to be modified to comply with shot changes and/or the timing of surrounding subtitles. If the reading rate is disabled, a default value of 120 wpm is used to calculate floated out times where necessary. This value is used by the default rate check to identify any subtitles that exceed the default rate.

**Include spaces in display rate** determines if spaces in the subtitle text are included in the reading rate calculations. Note that this option has no effect when calculating the word rate during live transmission in Q-Live, i.e. spaces are never included in this situation.

**Maximum subtitle display rate** controls the size of the steps between green (excellent), yellow, orange and red (too fast) in the colour background to the subtitle reading rate display. The colour bands are calculated as follows, where \( d \) = the value of default display rate, \( m \) is the value of maximum display rate and \( \text{step} = \frac{(m-d)}{3} \). The example numbers are based on a default rate of 120 wpm and a maximum rate of 144 wpm. Values are rounded to the nearest integer.
<table>
<thead>
<tr>
<th>Colour</th>
<th>Meaning</th>
<th>From</th>
<th>To</th>
<th>Example From</th>
<th>Example To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyan</td>
<td>low</td>
<td>0</td>
<td>(d - 10%) - 1</td>
<td>0</td>
<td>107</td>
</tr>
<tr>
<td>Green</td>
<td>excellent</td>
<td>d - 10%</td>
<td>(d + step) - 1</td>
<td>108</td>
<td>127</td>
</tr>
<tr>
<td>Yellow</td>
<td>average</td>
<td>d + step</td>
<td>(d + (step x 2)) - 1</td>
<td>128</td>
<td>135</td>
</tr>
<tr>
<td>Orange</td>
<td>poor</td>
<td>d + (step x 2)</td>
<td>m</td>
<td>136</td>
<td>144</td>
</tr>
<tr>
<td>Red</td>
<td>too fast</td>
<td>m + 1</td>
<td>and up</td>
<td>145</td>
<td>and up</td>
</tr>
</tbody>
</table>

The maximum rate value is also used by the maximum rate check to identify any subtitles that exceed the maximum rate.

In Q-Live, this value sets the maximum transmission rate for subtitles in the transmission queue.

Whenever you change the default rate, the maximum rate will be automatically set 20% higher than the new default. If you want to set a different maximum rate, you can change it without affecting the default. Note however that it is not possible to set the maximum rate less than the default rate.

**Maximum subtitle duration** and **Minimum subtitle duration** allow you to set an upper and lower limit for the display time in seconds/frames and are applied after the display rate has been calculated.

**Maximum alignment delay from section start/end** defines the amount that an automatic alignment is allowed to drift from the section markers that set the start and end times for the aligned sequence. For more details see the topic on Using the Aligner.

**Width of zone of influence before or after a shot change** defines the distance over which a shot change will exert a "snap to" pull on the In or Out time of a nearby subtitle.

Two values allow you to configure the number of frames that an **In time**... **should follow** or an **Out time... should precede** a shot change that causes the timecode to snap to it.

**Minimum gap between two successive subtitles** corrects the timecodes to ensure that the specified number of clear frames are left between adjacent subtitles. **Width of exclusion zone affecting subtitle gap** defines the gap which is not allowed, i.e. either the gap must be the specified minimum value or it must be greater than the exclusion zone value. Note that the minimum gap rule is not applicable to Closed Caption personality files.

The Timing Rules also incorporate implicitly the concept of **magnetism**: Two subtitles which are separated by the minimum gap behave as if they are **magnetised**, such that if the Out time of the first or the In time of the second subtitle is changed (within reason), the other subtitle will follow it and maintain the same spacing. Magnetism is enabled by default but can be turned off if desired. If this is done then edge-moves and whole-subtitle moves are no longer magnetic, though the minimum gap rule will still be applied if enabled.
Example narrative

Whenever Wincaps Q4 applies the Timing Rules to a timecode, it logs a narrative in the Messages pane of the toolbox explaining the changes that have been made. This narrative can be helpful in order to understand why the Timing Rules were applied in a particular way.

The following example shows the narrative produced by aligning a short section of four subtitles (34-37) as shown in the illustration below:

The narrative explains the changes that have been made, and these are annotated line by line below by way of example.

(0): ========= Aligner job 8: [ SM=00:02:09:17  EM=00:02:19:21 ] =========
(This is the eighth section alignment to be run, and the section start and end marker timecodes are given)

(0):

(0): SUBTITLE 34: given In=00:02:09:20  Out=00:02:11:23:
(Subtitle 34 received a "raw" In time of 00:02:09:20 and an Out time of 00:02:11:23 from the Aligner)

(0): - duration less than 70 frames, space after, so Out adjusted to 00:02:12:05
(The duration is less than the ideal, but there is space before the next In time, so Out time is extended)

(0): - duration too short, but subtitle is hemmed in or timecode is explicit
(The duration is still less than ideal but there is no more room to extend this subtitle)

(0): - for In, zone starts at 00:02:09:12 and zone ends at 00:02:09:22
(The nearest shot change(s) before and/or after the In time are at the timecode(s) shown)

(0): - In is between SC at 00:02:09:12 and SC at 00:02:09:22
(The In time falls between the two shot changes at the timecodes given)

(0): - In is modified by shot change at 00:02:09:22 +0f => 00:02:09:22
(The Timing Rules clip the In time to the following – much closer – shot change with a 0 frame offset)

(0): - Out is not in a shot change zone so is unchanged => 00:02:12:05
(The previously modified Out time is not close enough to a Shot Change to be influenced by it)

(0): - actual gap of 0 frames is less than minimum gap of 1 frames
(The In time is the same as the previous Out time)

(0): - gap modified by changing previous Out to 00:02:09:21
(The previous Out time is adjusted to ensure that the required gap is present)

(0): - previous Out set to 00:02:09:21 to allow for preceding shot change
(The previous Out time is inspected to ensure a “double gap” is not needed around the shot change)

(0): - actual gap of 0 frames is less than minimum gap of 1 frames
(The current Out time is the same as the next In time)

(0): - gap modified by changing Out time to 00:02:12:04
(The current Out time is adjusted to ensure that the required gap is present)

(0): SUBTITLE 35: given In=00:02:12:05 Out=00:02:14:09:

(0): - In is not in a shot change zone so is unchanged => 00:02:12:05

(0): - Out is not in a shot change zone so is unchanged => 00:02:14:09

(0): - actual gap of 0 frames is less than minimum gap of 1 frames

(0): - gap modified by changing Out time to 00:02:14:08

(0): SUBTITLE 36: given In=00:02:14:09 Out=00:02:16:02:

(0): - duration too short, but subtitle is hemmed in or timecode is explicit

(0): - In is not in a shot change zone so is unchanged => 00:02:14:09

(0): - for Out, zone starts at 00:02:15:17 and zone ends at 00:02:15:17
(The Out time is within the zone of influence of a single shot change at the timecode specified)

(0): - Out is modified by the shot change at 00:02:15:17 -1f => 00:02:15:16
(The Timing Rules clip the Out time to the frame before the shot change)
(0): SUBTITLE 37: given In=00:02:16:02  Out=00:02:18:14:

(0): - Out is too far from end marker so is adjusted to EM at 00:02:19:21  
(The Out time was further from the Section End than permitted, so is adjusted to the End marker)

(0): - duration less than 108 frames, space before, so In adjusted to 00:02:15:16  
(The duration is less than ideal and a gap exists before the subtitle so the In time is adjusted)

(0): - duration too short, but subtitle is hemmed in or timecode is explicit

(0): - for In, zone starts at 00:02:15:17 and zone ends at 00:02:15:17

(0): - In is modified by shot change at 00:02:15:17 +0f => 00:02:15:17

(0): - for Out, zone starts at 00:02:20:06 and zone ends at 00:02:20:06

(0): - Out is modified by the shot change at 00:02:20:06 -1f => 00:02:20:05

(0): - previous Out set to 00:02:15:16 to allow for preceding shot change

(0): =========================================================
Replay subtitles

Replay Mode provides a WYSIWYG preview of the subtitles overlaid against the video and fully synchronised against the video playback.

Press F7 to enter Replay Mode, or use the appropriate button on the Modes toolbar.

Play the media and view the subtitles in the video window, each subtitle will appear when its In time is reached and disappear when its Out time is reached.

A full screen option is available by pressing Alt Return. (When in full-screen mode, press Alt Return or Esc to revert to the normal window.)

You can choose if you want the video position to automatically track the current subtitle timecode when the media is paused. This is done via the Configure media options.

Text and timecode edits are still possible in replay mode, although some other editing features and options are disabled. These include:

- File exports
- Clear all section markers
- Create file from Shot Changes
- Create File from Speech Onset
- Convert Numbers to Arabic

Some strange behaviour may be apparent if the file contains timing errors (e.g. out-of-sequence subtitles), in which case press F5 to revert back to edit mode and correct the timing anomaly.

Wincaps Q4 DVD Builder

The Wincaps Q4 DVD Builder (referred to hereafter as the DVD Builder) is an application that takes Wincaps Q4 subtitle files and generates bitmap images and control files. These files are typically used to provide subtitle information to a DVD authoring system or subtitle encoder.

You can create a DVD Builder job for the currently open file by selecting File : Send To : WinCAPS Qu4ntum Builder from the main menu. This opens a dialog that guides you through the steps of creating the job. When you click Finish, Wincaps Q4 will send the job to the DVD Builder for processing.

You need to configure the DVD Builder settings before using it for the first time.

Note that this feature is only available when working with Open Caption personality files.

Refer to the Wincaps Q4 DVD Builder Handbook for further information about the
DVD chapter breaks

DVD chapter breaks identify the timecodes for break points such as scene selection and layer transition that can affect the placing of subtitles. The nature of DVD video means that subtitles cannot be used reliably near these points and so Wincaps Q4 provides the necessary tools to ensure that subtitles do not clash with the timing of these breaks.

You can configure a list of these breaks represented by timecodes and a timing variable that specifies the width (in frames) of the chapter break zone either side of the timecodes. You can also import the list of chapter break timecodes from an external file, if available.

Chapter breaks are displayed in the Media timeline as a block filled with diagonal red lines as shown below:

Once you have defined the chapter breaks for a subtitle file, you can run the Breaks check to identify any subtitles that overlap the chapter break zones.

Note that chapter breaks are only available in the Open Caption personality.

Configure chapter breaks
To configure the chapter breaks for the current file, click the Chapter Breaks button in the Media section of the Toolbox->File Info tab.

The Chapter Breaks dialog is displayed as shown below:
This dialog contains a list of timecodes, one for each chapter break.

To define a new chapter break, click the **Add** button. A new dialog opens, into which you can enter the desired timecode. Click **OK** to confirm the timecode and add it to the list of chapter breaks.

Other buttons allow you to **Edit** or **Delete** the currently selected chapter break, or **Clear All** chapter breaks for the file.

The **Gap** control allows you to set the width of the chapter break zone. The zone will occupy the configured number of frames before and after each timecode. For example, if the gap is set to 20 frames then subtitles that extend to within 20 frames before or after a chapter break timecode will be flagged up when the Breaks check is run.

Once all chapter breaks have been defined, click **OK** to save the changes.

**Import chapter breaks**

You can import the list of chapter break timecodes from an external text file, if one is available.

To import the list of chapter breaks for the current file, click the **Import Breaks** button in the Media section of the Toolbox->File Info tab.

A standard **File Open** dialog appears. Browse to the file containing the chapter breaks and click the **Open** button. The chapter breaks will be loaded in from the file and displayed in the **Chapter Breaks** dialog for you to review and edit.

Note that the text file must contain a list of timecodes in the standard hh:mm:ss:ff format, e.g.

00:01:04:02  
00:04:35:23  
00:08:09:13  
...
Clear chapter breaks
You can clear all the chapter breaks from the current file by clicking the **Clear Breaks** button in the Media section of the Toolbox->File Info tab.
Advanced Features

Automatic backup

Wincaps Q4 uses automatic backups to ensure that work is not lost due to accident or error. In addition, you can take a manual backup of the current file at any time.

Note that automatic backup is NOT available in Q-Live.

Automatic backups are enabled by default. You can turn them off via the Configure->User Preferences->Backup button in the Toolbox.

Whenever Wincaps Q4 Prior performs a complicated operation that could potentially affect the whole file (i.e. an operation that cannot be reversed by the standard "undo" facility), it first makes an automatic backup copy in the same location as the original W32 file. Backups are stored in a zip file named `<filename>.backup.zip` where `<filename>` is the name of the original W32 file.

You can restore a backup file by selecting `File : Restore` from the main menu.

Wincaps Q4 first asks you if you wish to save the current state of the file before restoring from the backup:

Click Yes to create a manual backup of the current file.

Qu4ntum now displays a list of all previous backups of the current file, the automatic backup is indicated as shown below:
Select a backup and click **OK** to restore the file to its previous state.

The list of backups includes any previous backups that were taken manually, either by clicking **Yes** to the first dialog or by selecting **File : Backup** from the main menu. It will only ever contain one automatic backup (i.e. the most recent).

Examples of expensive operations are:

- Inserting a file
- Importing a file
- Overwriting text from file
- Performing a timecode offset
- Clearing the alignment of a file or section
- Changes to multiple subtitles made via Edit Properties
- Performing a find and replace
- Performing a check using Check & Review
- Clearing timecodes
- Performing a timecode re-sync
- Resplitting a file
- Clearing multiple forced flags from a file
- Changing the file personality
- Changing the file defaults for colour or position

You can also make a manual Backup using Ctrl+S.
Lock files for editing

Wincaps Q4 allows offline (W32) subtitle files to be locked in order to prevent some or all of the file contents from being modified or deleted. Note that this type of locking is distinct from the file locking performed by the operating system.

The locking attributes are stored with the subtitle file so that the selected elements will remain locked if the file is opened on another system. This mechanism allows users to modify particular elements of a subtitle file (e.g. text, colours or position) without risk of accidentally changing other elements, e.g. the number of subtitles and their timecodes.

To view or change the locking options for the current file, click the Locking button in the File section of the Toolbox->File Info tab. The File Locking dialog is displayed:

![File Locking dialog](image)

The available options work as follows:

- **Lock the file** - if checked, totally locks the file so that NO changes can be made although the file can still be viewed and replayed with the video. This is similar to setting the file to read-only in its properties under Windows
- **Disable subtitle insert or deletes** - if checked, prevents subtitles form being added or deleted, though existing subtitles may be edited and timecodes changed
- **Disable timecode changes** - if checked, prevents any timecodes from being modified
- **Automatically lock file...** - if checked, the Lock the file attribute is set automatically whenever the file is closed. This may be desirable to prevent other users from accidentally changing an important file
- **Disable changes to colour** - if checked, prevents subtitle foreground and background colours from being modified
- **Disable changes to position** - if checked, prevents subtitles from being repositioned
File history (audit trail)

Wincaps Q4 maintains an audit trail for offline (W32) subtitle files. The audit trail information is stored within the subtitle files themselves and allows you to record and review the history of changes made to the files during the authoring process.

To view the audit trail for a file, click the Audit Trail button in the File section of the Toolbox->File Info tab.

The Audit Trail dialog is displayed as shown below:

![Audit Trail dialog]

The audit trail consists of a list of entries, each comprising of a time-stamp, the Windows login name of the user who was editing the file and a brief comment. The audit trail also records the version number of Wincaps Q4 in use at the time.

Wincaps Q4 inserts an initial "File Created" entry when a subtitle file is first created. Subsequently, you can add further entries manually by clicking the Add... button and completing the following dialog:

![Add Entry to Audit Trail dialog]

Enter the comment text and click Yes to create the new audit trail entry.
Entries are displayed most recent first. Note that once created, audit trail entries cannot be edited or removed, although pressing **Cancel** in the main Audit Trail dialog will cancel any comments that were added whilst the dialog was last open.

### Disable subtitles from transmission

To prevent the transmission of the current subtitle press **Ctrl Shift X** (repeat to re-enable). When disabled the subtitle is ignored when transmitting subtitles to an output device (in any mode) and cueing a disabled for TX subtitle will not clear a current cued On Air subtitle. This method can therefore be used to flag any subtitle that is not currently intended for transmission. Any subtitle disabled in this way is displayed with a red background (as shown below) and with a ![TX](icon) icon in the subtitle display.

![Subtitle display](image)

This function should be used with caution when exporting files for use with another system, as it is only supported in Wincaps Q4 itself and in the **EBU Generic** export format.

### Convert Arabic numbers

Wincaps Q4 provides the facility to convert Arabic numerals from Western Arabic notation (0 1 2 3 4 5 6 7 8 9) to Eastern Arabic notation (٠ ١ ٢ ٣ ٤ ٥ ٦ ٧ ٨ ٩) and vice-versa.

You can perform the conversion using the **Tools** menu:

**Convert Numbers to Arabic** - converts any Western Arabic numerals in the file to
Convert Numbers from Arabic - converts any Eastern Arabic numerals in the file to Western Arabic

The conversion operates on the entire file.

Compare Mode and Translation View

Compare Mode basics

**IMPORTANT:** Wincaps Q4 may become unstable if you have more than two files open in Compare Mode.

**Compare Mode** allows you to display and edit two subtitle files side by side, normally for translation work.

To use Compare Mode, you must have two or more file open. Go to the **File : Translation : Compare and Synchronise** menu and select the desired compare mode:

- **Don't compare** - Turn Compare Mode off
- **Compare don't synchronise** - Turn Compare Mode on but don't synchronise
- **Compare by Number** - Turn Compare Mode on, synchronise by subtitle number
- **Compare by Timecode** - Turn Compare Mode on, synchronise by timecodes

When Compare Mode is on, the subtitle view splits in half vertically as shown in the illustration below:

The **primary file** is displayed on the left and the **secondary file** on the right.

The primary file is the one you have selected in the main file tabs located above the
top left of the Video Window.

The secondary file is the one you have selected in the secondary file tabs located at the top left of the subtitle view.

Click on the file tabs to choose a different primary or secondary file - there will be a short delay whilst the screen switches around to show the new selection.

When Compare Mode is active, you may freely edit subtitles and timecodes in both the left and right files. **However, the menus, toolbars, toolbox etc. always operate on the primary file.**

**Translation basics**

You access the Translation functions via the **File : Translation** menu.

Translation assumes that you already have a timed **source file** containing the original text to guide the translation. You then use Wincaps Q4 to create a **target file** containing empty subtitles into which you can enter the translated text.

Wincaps Q4 creates the target file by first prompting you to choose the target language and then making a copy of the source file with a new name (suffixed by the selected language) and based on the relevant customer template for that language. The target file will have the same number of subtitles as the source file but all the original text will be cleared, leaving empty subtitle slots into which you can enter the translated text. The target file retains any section markers and timecodes from the original file. The timecodes will be automatically reprocessed using the Timing Rules for the new language.

Once the target file has been created, Wincaps Q4 uses Compare Mode to display both source and target files side-by-side, as shown below:
You can author the translated text using any of the standard methods. You can choose to synchronise the display of the source and target files either by subtitle number or by timecode, the latter allows the files to remain in step even if subtitles are split or merged.

The Toolbox and Video Window can also be hidden to allow both files to be viewed over the whole application. See Toolbox Collapse.

Create a new translation file
Use the following steps to create a new translation target file:

Open the source file in the normal way
Select **File : Translation : New** from the main menu. You will be prompted to select the language for the target file. If a target file already exists for the chosen language, a warning will be displayed
Click **OK** to create the target file. Note that this process may take a few seconds if the source file contains many subtitles Wincaps Q4 automatically creates the target file as follows:
A new file is created in the same location as the source file and with the same name plus a suffix indicating the target language (e.g. ".de" for German)
The properties of the new file are set according to the appropriate customer template for the target language
All subtitles including text, section markers and timecodes are copied to the target file
The target file is processed against any timing rules specified in the target template, so that (for example) differences in gaps and duration are automatically adjusted for the new language
All the subtitle text is cleared from the target file, leaving timed subtitle slots. Any comments are preserved
Wincaps Q4 switches to Compare Mode and the target file is displayed alongside the source file, ready for editing

Note that the relevant customer/language template needs to be present in the DataStore in order for the properties of the target file to be set correctly.

Open a translation file
Use the following steps to open an existing translation target file in conjunction with its source file:

Open the source file in the normal way
Select **File : Translation: Open** from the main menu. You will be prompted to select the translation file to open.
Select an existing translation file to open
Wincaps Q4 switches to Compare Mode and the target file is displayed alongside the source file, ready for editing

You can quickly access the list of recently opened translation target files from the **File : Translation : Recent Files** menu.

Note that opening a file in this way automatically switches the display to Compare Mode. You can achieve the same results by opening both files in the normal way and then selecting the desired Compare Mode via the **File : Translation : Compare and Synchronise** menu.
Editing translation target files
You can create and edit the text of the target file in the normal way and split/merge subtitles as desired.

Wincaps Q4 will keep the display of source and target files in synch depending on
the selection in the File : Translation : Compare and Synchronise menu as follows:

Don't compare - Turn Compare Mode off
Compare don't synchronise - Turn Compare Mode on but don't synchronise
Compare by Number - Turn Compare Mode on, synchronise by subtitle number
Compare by Timecode - Turn Compare Mode on, synchronise by timecodes

Note that if the files are synchronised by subtitle number, then they may get out of step if you insert or delete subtitles. If they are synchronised by timecode, Qu4ntum will synch to the subtitle in the source file with the nearest timecode to the current target subtitle.

Although it is possible to use the Aligner to re-time sections in the target file, the system will use fallback timings and the section markers will turn yellow. This is because the language of the translated text will differ from the media file and so normal phonetic alignment will not produce useful timecodes in this situation.

Fixing subtitles on the fly (Fix Mode)

You can use Fix Mode to set timecodes quickly by manually cueing a sequence of prepared subtitles. This enables you to "spot fix" prepared text-only subtitles in a single pass through the video (i.e. "on the fly") and can be particularly useful in fast-turnaround situations. After you have captured the timecodes in Fix Mode, you can switch to Edit Mode to review the completed piece and make any fine adjustments.

Wincaps Q4 offers the choice of two different Fix Modes depending on your workflow preference:

Show currently fixed subtitle (WYSIWYG) : In this mode, fixing is driven by the Ins key and Wincaps Q4 displays a preview of the next subtitle beneath the video window.
Del driven : In this mode, fixing is driven by the Del key

The choice of Fix Mode is configured via Toolbox->Configure->User Preferences->Fix and defaults to WYSIWYG mode.

When working in Fix Mode, the Ins and Del keys are always used to grab In and Out times irrespective of the current user options. This is simply for ease of use.

You can configure a reaction delay compensation (via Toolbox->Configure->User Preferences->Fix) that will automatically subtract a few frames from each captured timecode before applying it to the In or Out time.

When fixing subtitles you should normally work in the List View / News View

You activate Fix Mode by clicking the Fix button on the Modes Toolbar or by pressing the F6 key. Note that certain editing functions are unavailable when working in Fix Mode. These include:

Up/down arrows don't move between subtitles
Copy/Paste
Checks
When you activate Fix Mode, the screen layout changes to display the **reading rate bar** and the **next subtitle preview** (WYSIWYG Mode only) below the video window.

In **WYSIWYG Fix Mode**, the current subtitle is the one currently in the process of being fixed. The next subtitle is the one that will be fixed the next time the [Ins] key is pressed. Note that in WYSIWYG Fix Mode, the brown background is split across the current and next subtitles to indicate this. In the special situation where the current subtitle is at the start of the file, the brown background remains wholly on the first subtitle as this will be the first to be fixed in this case.

Note that in **WYSIWYG Fix Mode**, when switching from Edit Mode into Fix Mode, the current subtitle focus is moved up by one. For example, if you are editing subtitle 6 and you select Fix Mode, subtitle 5 becomes the current subtitle. This means that the subtitle you were editing automatically becomes the next subtitle to be fixed. Similarly, when switching from Fix Mode back into Edit mode, the current subtitle focus is moved down by one. In the special case where the current subtitle is at the start of the file, the focus does not switch.

The **reading rate bar** indicates when the reading speed of the current subtitle is acceptable, based on the configured values of default and maximum subtitle display rates. As the media plays, as soon as the In time of the current subtitle is fixed the bar will activate and its colour will change from left to right to indicate the acceptability of the reading rate should the Del key be pressed at the current media position.

The **next subtitle preview** (WYSIWYG mode only) allows you to see the text of the next subtitle whilst keeping your eyes focused on the video window. The preview
windows shows Open Caption subtitles in non-WYSIWYG display mode to ensure that the first two rows of text are always visible.

- When fixing subtitles, you will normally start with a file / story that contains the prepared subtitle text. The file / story should have a media file attached. The initial timecodes should be all be cleared, i.e. set to 00:00:00:00 and floating. If the file / story already contains fixed timecodes then the fixing process may not produce the expected results.

- You can enable some or all of the timing rules and they will be applied each time a timecode is fixed. You should configure a suitable value for display rate or else the Out times may not default to sensible values.

To create "back-to-back" subtitles separated only by the minimum gap, you should enable maximum duration and set it to a suitably high value. Then when you fix an In time, Wincaps Q4 will extend the Out time of the previous subtitle so that it butts up to the current subtitle. The display rate is ignored in this case.

Alternatively, you can create “back-to-back” subtitles by unticking the display rate and

Note that it is not possible to select text in Fix Mode, therefore word and character based formatting changes are not permitted. Changes to colour and position can be made as normal.

Using WYSIWYG Fix Mode

In WYSIWYG Fix Mode, you play the video and grab the subtitle In times at the appropriate cues. You have the option of grabbing the Out times as well if desired.

The subtitle display in the video window always shows the current subtitle, i.e. the one in the process of being fixed. The subtitle text appears in the video window when the In time key [Ins] is pressed and disappear when the Out time [Del] key is pressed.

The procedure for fixing the timecodes is as follows:

Select the List View / News View and position the cursor in the first subtitle that you want to fix.

Activate Fix Mode

Play the video at normal speed and listen to the audio

Press the In time key [Ins] at the start cue for the next subtitle to fix the In time. The next subtitle automatically becomes the current subtitle.

You can optionally press the Out time [Del] key at the end cue of the current subtitle to fix the Out time. If you don't press the [Del] key, Wincaps Q4 will fix the Out time automatically, based on the display rate setting or the minimum duration, whichever is greater.

Repeat steps 4-5 until you have fixed all the required subtitles.

**OPTION - Press-and-Hold Operation:** Instead of using the [Del] key to fix the Out time, you can instead hold down the [Ins] key and release it to set the Out Time as the following workflow demonstrates. Note that you need to hold down the [Ins] key for longer than 0.75 seconds in order for press-and-hold operation to work correctly.

Select the List View and position the cursor in the first subtitle

Activate Fix Mode

Play the video at normal speed and listen to the audio
Press the In time key [Ins] at the start cue for the next subtitle to fix the In time and hold it down. The next subtitle automatically becomes the current subtitle. At the end cue of the current subtitle, release the [Ins] key to fix the Out time. Repeat steps 4-5 until you have fixed all the required subtitles.

OPTION - Timed Sections: (Wincaps Q4 Pro only) When working in Fix Mode you can still take advantage of Wincaps Q4’s auto-alignment capabilities. Rather than having to fix every individual subtitle, where there is a run of continuous dialog you can instead insert section markers and Wincaps Q4 will automatically time the subtitles using fallback alignment. The following example demonstrates this workflow:

Activate Fix Mode
Select the subtitle containing the start of the dialog run
Pause the video at the start cue for the current subtitle
Press the section start key [Shift Ins] to insert a section start marker
Select the subtitle containing the end of the dialog run
Spool the video and pause it at the end cue for the current subtitle
Press the section end key [Shift Del] to insert a section end marker. The Aligner runs automatically to time the subtitles using the fallback alignment method (the section markers will turn yellow when alignment is complete)

You can use the timed sections technique wherever there is a run of continuous text and use the basic fixing workflow described earlier to fix isolated utterances.

Creating a blank timed file
If no prepared script is available, you can use WYSIWYG Fix Mode to quickly create a sequence of blank timed subtitles. You can then go back and fill in the text afterwards. This is particularly useful when carrying out translation work as the subtitles can be created according to the length of the original speech and the translated text can be added later.

You will normally begin with a blank file. You should always configure a suitable value for minimum duration as this will be used to determine the Out times of the subtitles if the [Del] key is not pressed.

The procedure for creating a blank timed file is as follows:
Select the List View.
Activate Fix Mode and position the cursor in the last subtitle.
Play the video at normal speed and listen to the audio
Press the In time key [Ins] at the start cue for the first run of speech to fix the In time. Wincaps Q4 automatically creates a new blank subtitle, selects it and fixes the In time.
You can optionally press the Out time [Del] key at the end cue of the current run of speech to fix the Out time. If you don’t press the [Del] key, Wincaps Q4 will fix the Out time automatically, based on the minimum duration setting.
Repeat steps 4-5 until you have created all the required blank subtitles.

You can use press-and-hold operation instead of the [Del] key if desired.
Using Del driven Fix Mode
In Del driven Fix Mode, you play the video and grab the subtitle Out times at the appropriate cues. You have the option of grabbing the In times as well if desired.

The subtitle display in the video window always shows the current subtitle. The subtitle appears in the video window as soon as you enter Fix Mode and remains visible until the you press the [Del] key to move on to the next subtitle.
The procedure for fixing the timecodes is as follows:

Select the List View / News View and position the cursor in the first subtitle
Activate Fix Mode. (Note, Qu4ntum sets the first In time as soon as you enter Fix
mode, therefore you would normally want to fix the In time of the first subtitle, see
step 4.)
Play the video at normal speed and listen to the audio
You can optionally press the In time [Ins] key at the start cue of the current subtitle to
fix the In time, for example if there was a gap in the audio between the previous and
current subtitles.
Press the Out time key [Del] at the end cue for the current subtitle to fix the Out time.
Wincaps Q4 automatically selects the next subtitle and fixes its In time to be the
previously grabbed Out time plus the minimum gap.
Repeat steps 4-5 until you have fixed all the required subtitles.

If the timing rules are enabled they are applied each time a timecode is fixed.

Splitting and merging subtitles

To create a new subtitle (after the current subtitle), press the Return key. Press
Shift Return to create a new line within the current subtitle or Ctrl Return to split the
subtitle at the current cursor position.
Whenever a new subtitle is created, its initial timecodes are automatically set based
on the Out time of the preceding subtitle and the current timing rules.
To merge two subtitles together, either put the cursor at the start of the second
subtitle and press the Backspace key or position the cursor at the end of the first
subtitle and press the Delete key.

Click here to learn how Wincaps Q4 deals with timecodes when splitting and merging
subtitles.

To move entire subtitles or blocks of subtitles around, use the Compact View.
Moving text between rows ("snake")
You can use the snake keys to easily move words between rows, allowing you to
fine-tune the text formatting for best display.

The Ctrl Down Arrow key pushes the last word in the current row (i.e. the row
where the cursor is currently positioned) down onto the beginning of the next row,
creating a new row if necessary.

The Ctrl Up Arrow key pulls the first word of the next row up and appends it to the
current row. If there is insufficient space on the current row to contain the word the
operation has no effect.

For example, with the cursor in the first row of a subtitle, thus:
pressing **Ctrl Down Arrow** pushes the last word down to the start of the next row, as shown below:

```plaintext
I’m scared that something might happen down there.
```

Successive use of snake will move the last word to the next row until the row width limit is reached, at which point the last word in the next row is pushed down to a third row (if this is permitted).

Four additional snake keys allow you to move words between subtitles:

- **Ctrl 8** - moves the first word of the current subtitle up to the end of the previous subtitle
- **Ctrl Shift 8** - moves the last word of the previous subtitle down to the start of the current subtitle
- **Ctrl 9** - moves the last word of the current subtitle down to the start of the next subtitle
- **Ctrl Shift 9** - moves the first word of the next subtitle up to the end of the current subtitle

Note that the 8 and 9 keys for these keystrokes are those located on the *main keypad*, and not those on the numeric keypad which are used for colouring subtitles.

**Reformatting subtitles**

You can use the **Ctrl R key** (F4 key in Q-Live) (optionally the **Tab key**) to quickly reformat the text in the current subtitle. Reformatting splits the text from the current cursor position into rows, fitting the maximum number of words into each row.

For example, with the cursor in the first row of a subtitle thus:

```plaintext
I’m scared that it’s gonna hurt more than it did yesterday.
```

pressing **Ctrl R** (F4) reformats the subtitle as shown below:

```plaintext
I’m scared that it’s gonna hurt more than it did yesterday.
```

Re-split subtitles

*(Wincaps Q4 Offline only)*
You can use the **re-split subtitles** function to re-split the entire file according to the automatic text splitting rules.

You can access this function by:

Clicking the **re-split** button located on the file toolbar
Selecting **Tools : Re-split subtitles** from the main menu

A re-split works on the whole file and resets all timecodes to zero (unless word timings are present). It also resets other subtitle attributes such as position and removes any section markers. It should therefore normally only be used after importing or inserting an unstructured block of text in order to provide a starting point for further work. This operation cannot be undone except by restoring from the automatic backup.

Click here to learn more about how automatic text splitting works.

Inserting speaker change dashes into dialogue
Wincaps Q4 provides the capability to insert a dash at the start of each row of the current subtitle as described below:

The original text looks like this.

```
Dive safety is Paul’s ultimate responsibility.
```

Press the **Ctrl - key** to insert a dash followed by a single space at the beginning of each row of the subtitle.

```
- Dive safety is Paul’s ultimate responsibility.
```

Press the **Ctrl Shift - key** to insert a dash without the space.

```
-Dive safety is Paul’s ultimate responsibility.
```

Press the keystroke again to remove the dashes. If there is insufficient space on a row to accommodate the dashes the row will be split.
Join or merge two Wincaps Q4 files together

This article describes how you can join two Wincaps Q4 files together or insert subtitles from one Wincaps Q4 file into another.

Use the following procedure to merge the two Qu4ntum (w32) files, referred to as source and target. At the end of the process, the target file will contain the merged text.

Note that an insert operation cannot be undone.

Open the target file and save it with a new name, if desired
Place the cursor at the point in the target file where you want the subtitles from the source file to be inserted. The new subtitles will be inserted after this subtitle. If you want to append the source file to the target file, place the cursor in the last subtitle
Select File : Insert W32 file from the main menu
Choose the W32 source file to insert
A confirmation dialog will be displayed
Click OK to continue. The contents of the source file will be inserted into the target file
Warnings may be displayed if Wincaps Q4 detects that results may not be sensible
The current file now contains the results of the merge operation

The insert process obeys the following rules:

Existing properties, subtitles or GSI information in the target file will remain unchanged
All subtitles will be inserted from the source file together with their timecodes and any scene markers and section markers
Any subtitle-level style and word-level style settings in the source file will be preserved. This includes position, justification and colours
Any comments in the source file will be preserved
Speakers will be merged if present
Inserted subtitles will be automatically word-wrapped if necessary
If a Teletext file of a different language is inserted, some of the inserted characters may be invalid in the target language. In this case, an appropriate warning will be displayed
Overwrite text from file

This article describes how you can replace just the subtitle text in the current document with new text whilst leaving the original subtitles and their timecodes unchanged. This ability is useful for translation work. For example, you may have timed a subtitle file in one language and have the translated text for a second language available as a text file. Using this method, you can easily merge the translated text with the existing timed subtitles.

The source document can be in any of the supported import formats or even another W32 file. In practise however, it is likely to be in text or RTF format.

The source (text) document should have the same number of subtitles as the target W32 file or a warning will be displayed. If the source contains more subtitles than the target then the extra subtitles will not be created. If the source contains fewer subtitles than the target then the original text will remain.

When importing TXT files, you must ensure that the text import options for maximum row length and row count are set greater than the largest subtitle in the source file or else the imported text may wrap onto following subtitles causing the source text to become misaligned with the target subtitles.

Text is overwritten on a subtitle-by-subtitle basis, i.e. the text in subtitle 1 of the source file will replace the text in subtitle 1 of the target file and so on.

All formatting (e.g. position, colour information) will be stripped from the source text except for word-level bold/italic/underline markup. The subtitle-level properties (e.g. position) of the target file will be preserved, e.g. if the target subtitles are center-positioned then they will remain so after the new text has been imported.

Use the following procedure to read in subtitle text from a source document and replace the text in the currently open target file.

Open the target file and save it with a new name
Change the language of the target file to match the source file you are about to import
If necessary, change the font of the target file to one that is able to display the text in the source file
Select File : Overwrite Text From File from the main menu
Choose the source file to import
For non-W32 files, the Import Wizard will be displayed to guide you through the import process
A warning will be displayed if the subtitle counts do not match, click OK to continue
The text in the source file will replace the text in the target file
Warnings may be displayed if Wincaps Q4 detects that results may not be sensible
The current file now contains the new text.

This operation cannot be undone except by restoring from the automatic backup
Editing multiple subtitles

Wincaps Q4 provides the powerful facility to change various, specific properties of multiple subtitles within a subtitle file or story. For example, colour, positioning or timing information can be modified for some or all subtitles in a single operation.

This function can be used to modify the appearance of all subtitles within a range (or through the whole file/story) by changing an individual parameter (e.g. to make all subtitles white), or a number of parameters (e.g. to change all subtitles to Arial at a size 30 and colour white). In addition, you can restrict the changes to subtitles matching a specified criterion (e.g. change all yellow subtitles to white).

The function can also be used to force subtitles to adopt the “default” settings for the file. For example, change the position of all subtitles to “default” instead of “bottom” even though the current default positioning in the File Properties is bottom. Such a change may have no visible effect on the file until a change is next made to the default settings. For instance, in the above example if the default in File Properties is changed from bottom position to top, then any subtitles that are specifically set at the bottom position (rather than default) would not move.

These operations cannot be undone except by restoring from the automatic backup

Edit properties is accessed via the Compact View.

Use the following procedure to change the properties of multiple subtitles:

Select the subtitles that you wish to modify (highlighted in blue in the above illustration)
Right-click on any of the selected subtitles and select Edit Properties from the pop-
Choose the properties you wish to change
A dialog is displayed that allows you to configure the changes (see the following sections for details)
Click OK to confirm the changes
Qu4ntum updates the properties of the selected subtitles

Note that changes made via Edit Properties cannot be undone.

Colours and fonts
Selecting **Colours and fonts** displays the **Change styles** dialog, comprising of up to seven tabs. Note that not all tabs may be displayed, depending on the personality of the subtitle file.

In each of the tabs, "From" and "To" criteria may be specified. "From" will determine which subtitles are changed. "To" will determine how.

The possible "From" criteria are:

- **Ignore**: Don't match this property for any subtitles
- **Default**: Match any subtitles that are currently using the file default setting for this property
- **Any**: Match this property for all subtitles
- **Matching**: Match all subtitles that currently match the specified "From" style (selected from the drop-down list)

Multiple "From" criteria can be selected in different tabs, and if so then these criteria will be logically **ANDed** together. For example, if Fore Colour is set to Matching "Yellow" **AND** Bold is set to Matching "On" then only those subtitles that are currently both Yellow **AND** Bold will be changed.

The possible "To" criteria are:

- **Use Default**: Set this property to the file default
- **Set to**: Set this property to the specified "To" style (selected from the drop-down list)

For example, the following selection will change all "cyan" subtitles to "yellow".
Fore Colour tab
Allows the foreground colour to be changed. Select the old and/or new colours from the drop-down lists.

Back Colour tab
Allows the background colour to be changed. Select the old and/or new colours from the drop-down lists.

Font Face tab
Allows the font face to be changed. Select the old and/or new font faces from the drop-down lists.

Font Size tab
Allows the font size to be changed. Select the old and/or new font sizes from the drop-down lists.

Italic tab
Allows the Italic style to be set or cleared. Select either off or on from the drop-down lists as appropriate.

Underline tab
Allows the Underline style to be set or cleared. Select either off or on from the drop-down lists as appropriate.

Bold tab
Allows the Bold style to be set or cleared. Select either off or on from the drop-down lists as appropriate.

Timecodes
This dialog allows you to adjust the timecodes of the selected subtitles.

Position and justification
Selecting **Position and justification** displays the **Change position** dialog comprised of three tabs.
In each of the tabs, "From" and "To" criteria may be specified. "From" will determine which subtitles are changed. "To" will determine how.

The possible "From" criteria are:

- **Ignore**: Don't match this property for any subtitles
- **Default**: Match any subtitles that are currently using the file default setting for this property
- **Any**: Match this property for all subtitles
- **Matching**: Match all subtitles that currently match the specified "From" position (selected from a drop-down list)

Multiple "From" criteria can be selected in different tabs, and if so then these criteria will be logically ANDed together. For example, if Horizontal Position is set to Matching "Left" AND Vertical Position is set to Matching "Bottom" then only subtitles that are currently both Left AND Bottom aligned will be changed.

The possible "To" criteria are:

- **Use Default**: Set this property to the file default
- **Set to**: Set this property to the specified "To" position (selected from a drop-down list)

For example, the following selection will change all "Left" positioned subtitles to "Centre":

![Change position dialog box](image)

**Horizontal Position tab**
Allows the horizontal position to be changed. Select the old and/or new positions from the drop-down lists.

**Justification tab**
Allows the justification to be changed. Select the old and/or new justification settings from the drop-down lists.

**Vertical Position tab**
Allows the vertical position to be changed. Select the old and/or new positions from the drop-down lists.

Note that the vertical position tab allows you to align subtitle vertically using either the top edges or bottom edges of the subtitles. In other words, for subtitles with different numbers of rows, this lets you choose whether the subtitles "grow up" or "grow down" as desired.

If the position change causes one or more subtitles to violate the Safe Area, a warning will be displayed and details provided in the Messages pane.

**Background Effect**
Selecting **Background effects** displays the **Changing Effects** dialog.

Both "From" and "To" criteria may be specified. "From" will determine which subtitles are changed. "To" will determine how.

The possible "From" criteria are:

- **Ignore**: Don't match this property for any subtitles
- **Default**: Match any subtitles that are currently using the file default setting for this property
- **Any**: Match this property for all subtitles
- **Matching**: Match all subtitles that currently match the specified "From" effect (selected from a drop-down list)

The possible "To" criteria are:

- **Use Default**: Set this property to the file default
- **Set to**: Set this property to the specified "To" effect (selected from a drop-down list)

For example, the following selection will change all subtitles with the "Block" effect to use the "Surround" effect:
Clear All Timecodes

This item allows you to clear all timecodes of the selected subtitles, resetting them to 00:00:00:00 and floating.

Repair a damaged file

In rare circumstances (e.g. following a bad system crash) the currently open subtitle file may become damaged such that Wincaps Q4 is unable to open it after a restart. If this happens, Wincaps Q4 will display the following message when you try to open the file:

Click OK to have Wincaps Q4 attempt to repair the damaged file. You may want to take a manual copy of the damaged file before attempting the repair procedure.

If Wincaps Q4 is able to repair the damaged file it will display a "Succeeded" message and proceed to open the file normally. Note that Wincaps Q4 will repair the file as best as it can but some of the original information may still be lost if the file was badly damaged. In the unlikely event that the file is so badly damaged that Wincaps Q4 is unable to repair it, you will see a "Failed" message indicating that the file was not recoverable.

The repair function can also be accessed from the main menu via Tools : File repair. In this case Wincaps Q4 prompts you to browse to the damaged file and repairs it as described above. In this case Wincaps Q4 does not open the damaged file automatically, i.e. the current file remains loaded.

External video overlay

Wincaps Q4 supports the ability to display the picture from an external video source in the Video window. In order to do this, the host PC must contain a suitable graphics card capable of video overlay using a standard video input (i.e. VIVO).

Screen Systems recommends the BlackMagic DeckLink SDI card (see below for configuration instructions). Other similar cards may work with Wincaps Q4 but support for them is limited.

If the PC contains a compatible card, Wincaps Q4 will detect it automatically and the option will be available whenever you go to open a video. Contact Screen Subtitling support for details of compatible hardware.
The procedure for using the overlay card is as follows:

Connect a suitable external video signal to the input of the overlay card.
In Wincaps Q4/Q-Live, open a file and choose a story (Q-Live).
Click the video play button or press the 5 key on the numeric keypad to start the media. The **Choose Media Type** dialog is displayed:

![Choose Media Type dialog](image)

Select Video Overlay from the drop-down list and click **OK**.
The external picture is displayed in the Video window after a short pause.

You can stop the external video input by right-clicking in the Video window and choosing **Close** from the pop-up menu.

Note that the control of external video sources is not part of Qu4ntum; the keyboard video playback controls are for digital media file only.

Note that when using Q-Live, you can use the Video overlay with some stories and media files with others as required. When you switch between stories, Q-Live loads the appropriate media file or displays the external overlay input as required.

**Configuration**

This topic describes how to set up a **BlackMagic DeckLink SDI card** for use with Wincaps Q4/Q-Live.

Install the card in the host machine following the manufacturer's instructions and connect up the input signal.
Download and install the DeckLink software from the Black Magic website, which includes the driver.
In the Windows Control Panel, open the new item called "BlackMagic Design Control Panel"
Set the "Set default video standard as:" field to match the input signal and click **OK**.
The other settings can normally be left at the defaults.

To verify the installation you can use the **BlackMagic Media Express** software as follows:

Open the BlackMagic Media Express application
Switch to the "Log and Capture" tab
Ensure it displays the desired video stream, if not check the SDI cable is connected to the correct input as selected above in the Control Panel.
Reference

Keyboard shortcuts

Unless stated otherwise, number keys, mathematic symbols, Ins (0) and Del (decimal point) refer to the numeric keypad (Numpad) only. Arrows, PageUp and PageDown etc. refer to the specific keys and not those on the scroll lock of the numeric keypad. The NumLock and Scroll Lock settings are generally irrelevant to the action of these command keys, except on laptop keyboards with no dedicated numeric keypad. Where a shortcut requires the Alt key you cannot use the Alt Gr key.

Opening/Printing

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl N</td>
<td>New W32 subtitle file</td>
</tr>
<tr>
<td>Ctrl O</td>
<td>Open existing W32 file</td>
</tr>
<tr>
<td>Ctrl P</td>
<td>Print current file or current selection</td>
</tr>
<tr>
<td>Alt F4</td>
<td>Exit Wincaps Q4</td>
</tr>
</tbody>
</table>

Window Navigation/Modes

Note: The F keys have alternative functions when the Speaker List is active

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Open help</td>
</tr>
<tr>
<td>Alt 1</td>
<td>List View</td>
</tr>
<tr>
<td>Alt 2</td>
<td>Timeline View</td>
</tr>
<tr>
<td>Alt 3</td>
<td>Compact View</td>
</tr>
<tr>
<td>F5</td>
<td>Edit Mode</td>
</tr>
<tr>
<td>F6</td>
<td>Fix Mode</td>
</tr>
<tr>
<td>F7</td>
<td>Replay Mode</td>
</tr>
<tr>
<td>Ctrl Q</td>
<td>Open House Styles management dialog</td>
</tr>
<tr>
<td>Esc</td>
<td>Cycle between subtitle display, Toolbox and SpeakTitle window</td>
</tr>
</tbody>
</table>

Click here to learn how to navigate around the Toolbox using the Tab and Arrow keys.

Creating/Editing Subtitles

Place cursor at the required position in the text

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+S</td>
<td>Creates a manual Backup of the file</td>
</tr>
<tr>
<td>Return</td>
<td>Create new blank subtitle</td>
</tr>
<tr>
<td>Ctrl Return</td>
<td>Split subtitle, creating new subtitle</td>
</tr>
<tr>
<td>Shift Return</td>
<td>Split row into 2 lines</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete next character (merges with next subtitle if cursor is at end of subtitle)</td>
</tr>
<tr>
<td>Ctrl Delete</td>
<td>Delete forwards word (merges with next subtitle if cursor is at end of subtitle)</td>
</tr>
<tr>
<td>Shift Delete</td>
<td>Delete current row</td>
</tr>
<tr>
<td>Ctrl Shift Delete</td>
<td>Delete current subtitle</td>
</tr>
<tr>
<td>Backspace</td>
<td>Delete previous character (merges with previous subtitle if</td>
</tr>
<tr>
<td>Key Combination</td>
<td>Function</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------</td>
</tr>
<tr>
<td>Ctrl Backspace</td>
<td>Deletes backwards word (merges with previous subtitle if cursor at start of subtitle)</td>
</tr>
<tr>
<td>Shift Backspace</td>
<td>Delete current row</td>
</tr>
<tr>
<td>Ctrl Shift Backspace</td>
<td>Delete all text in subtitle</td>
</tr>
<tr>
<td>Ctrl C / V / X</td>
<td>Copy / Paste / Cut</td>
</tr>
<tr>
<td>Ctrl Z / Y</td>
<td>Undo / Redo</td>
</tr>
<tr>
<td>Ctrl - or Ctrl Shift -</td>
<td>Insert/remove speaker change dashes at start of lines (either with or without space after dash)</td>
</tr>
<tr>
<td>Ctrl Shift H (with cursor on a flagged homophone)</td>
<td>Cycle through homophones</td>
</tr>
<tr>
<td>Ctrl Shift X</td>
<td>Disable subtitle from transmission (toggle)</td>
</tr>
<tr>
<td>Ctrl F7</td>
<td>Run a spell check</td>
</tr>
</tbody>
</table>

## Navigating/Selecting Text

*Place cursor at the required position in the text*

<table>
<thead>
<tr>
<th>Key combination</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>(left arrow)</td>
<td>Move to character on left</td>
</tr>
<tr>
<td>Shift</td>
<td>Select character on left</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Jump to word on left</td>
</tr>
<tr>
<td>Ctrl Shift</td>
<td>Select word left</td>
</tr>
<tr>
<td>(right arrow)</td>
<td>Move to character on right</td>
</tr>
<tr>
<td>Shift</td>
<td>Select character on right</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Jump to word on right</td>
</tr>
<tr>
<td>Ctrl Shift</td>
<td>Select word right</td>
</tr>
<tr>
<td>(up arrow)</td>
<td>Row up</td>
</tr>
<tr>
<td>Shift (down arrow)</td>
<td>Row down</td>
</tr>
<tr>
<td>Shift</td>
<td>Select row down</td>
</tr>
<tr>
<td>Home</td>
<td>Go to start of row</td>
</tr>
<tr>
<td>Ctrl Home</td>
<td>Go to start of subtitle</td>
</tr>
<tr>
<td>Shift Home</td>
<td>Select text from cursor position to start of row</td>
</tr>
<tr>
<td>Ctrl Shift Home</td>
<td>Select text from cursor position to start of subtitle</td>
</tr>
<tr>
<td>End</td>
<td>Go to end of row</td>
</tr>
<tr>
<td>Ctrl End</td>
<td>Go to end of subtitle</td>
</tr>
<tr>
<td>Shift End</td>
<td>Select text from cursor position to end of row</td>
</tr>
<tr>
<td>Ctrl Shift End</td>
<td>Select text from cursor position to end of subtitle</td>
</tr>
<tr>
<td>PageUp/Down</td>
<td>Go to previous/next subtitle</td>
</tr>
<tr>
<td>Ctrl PageUp/Down</td>
<td>Go to start/end of subtitle file</td>
</tr>
<tr>
<td>Ctrl Shift PageUp/Down</td>
<td>Scroll page up/down</td>
</tr>
<tr>
<td>Alt PageUp/Down</td>
<td>Go to previous/next section marker</td>
</tr>
<tr>
<td>Ctrl F</td>
<td>Open Find dialog</td>
</tr>
<tr>
<td>Ctrl G</td>
<td>Go to subtitle/timecode</td>
</tr>
<tr>
<td>Ctrl H</td>
<td>Open Replace dialog</td>
</tr>
</tbody>
</table>

## Compact View Operations

*With the Compact View selected. Hold Ctrl key down to marquee select nodes*

<table>
<thead>
<tr>
<th>Key combination</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl Space</td>
<td>Select/deselect current subtitle node (subtitle turns blue)</td>
</tr>
<tr>
<td>Ctrl A</td>
<td>Select all nodes</td>
</tr>
<tr>
<td>Shift Home</td>
<td>Select all subtitle Nodes from current to top of file</td>
</tr>
<tr>
<td>Shift End</td>
<td>Select all subtitle Nodes from current to bottom of file</td>
</tr>
<tr>
<td>Ctrl (up arrow)</td>
<td>Move to previous subtitle node</td>
</tr>
<tr>
<td>Ctrl (down arrow)</td>
<td>Move to next subtitle node</td>
</tr>
<tr>
<td>Ctrl Shift</td>
<td>Subtitle node range selection</td>
</tr>
<tr>
<td>Ctrl Shift</td>
<td>Subtitle node range selection</td>
</tr>
<tr>
<td>Ctrl Z/Y/C/V/X</td>
<td>Clipboard commands affect all selected subtitle nodes</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete selected nodes</td>
</tr>
</tbody>
</table>

### Speaker Labels/Scene Markers

*With the Speaker List tab selected in the Toolbox*

| F1-F10 | Speaker IDs 1 to 10 |
|Shift F1-F10 | Speaker IDs 11 to 20 |
|Ctrl Shift F1-F10 | Speaker IDs 21 to 30 |
|Ctrl K | Toggle scene marker |
|? | Clear current speaker colour |
|Numpad 1 - 6 | Cycles through colours as per colour order |

### Text Formatting, Style and Colour

*Place cursor at the required position in the text. Note that these keystrokes only function when the current subtitle has focus, i.e. the flashing cursor is displayed.*

| Ctrl B | Bold (not Teletext) |
|Ctrl I | Italic (not Teletext) |
|Ctrl U | Underline (not Teletext) |
|Ctrl T | Toggle between Open Caption and Teletext for current subtitle (Teletext personality only) |
|Ctrl L | Toggle automatic text splitting on/off |
|Ctrl (down arrow) | Snake - move last word of current row to start of next row |
|Ctrl (up arrow) | Un-snake - move first word of next row to end of current row |
|Ctrl 8 (main keyboard) | Move first word of current subtitle to end of previous subtitle |
|Ctrl Shift 8 (main keyboard) | Move last word of previous subtitle to start of current subtitle |
|Ctrl 9 (main keyboard) | Move last word of current subtitle to start of next subtitle |
|Ctrl Shift 9 (main keyboard) | Move first word of next subtitle to end of current subtitle |
|Ctrl M | Change case - toggles Title Case, UPPERCASE and lowercase |
|Ctrl R or Tab* | Reformat from cursor position (* User configurable option) |
|7 (Numpad) | Sentence text colour white |
|Shift 7 (Numpad) | Subtitle text colour white |
|Ctrl 7 (Numpad) | Sentence background colour black |
|Ctrl Shift 7 (Numpad) | Subtitle background colour black |
|8 (Numpad) | Sentence text colour yellow |
|Shift 8 (Numpad) | Subtitle text colour yellow |
|Ctrl 8 (Numpad) | Sentence background colour red |
|Ctrl Shift 8 (Numpad) | Subtitle background colour red |
|9 (Numpad) | Sentence text colour cyan |
### Shift 9 (Numpad)
- Subtitle text colour cyan

### Ctrl 9 (Numpad)
- Sentence background colour blue

### Ctrl Shift 9 (Numpad)
- Subtitle background colour blue

### Shift / (Numpad)
- Sentence text colour green

### Ctrl / (Numpad)
- Sentence text colour magenta

### Ctrl Shift / (Numpad)
- Subtitle text colour magenta

### * (Numpad)
- Sentence foreground colour picker

### Shift * (Numpad)
- Subtitle foreground colour picker

### Ctrl * (Numpad)
- Sentence background colour picker

### Ctrl Shift * (Numpad)
- Subtitle background colour picker

### + (Numpad)
- Toggle add-on status of subtitle (Teletext personality only)

### Comments and Check Marks

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl Shift C</td>
<td>Add a comment</td>
</tr>
<tr>
<td>Ctrl Alt C</td>
<td>Clear comment from current subtitle (or selected subtitles in Compact View)</td>
</tr>
<tr>
<td>Ctrl D</td>
<td>Move to next comment</td>
</tr>
<tr>
<td>Ctrl Shift D</td>
<td>Move to previous comment</td>
</tr>
<tr>
<td>Ctrl E</td>
<td>Move to next check mark</td>
</tr>
<tr>
<td>Ctrl Shift E</td>
<td>Move to previous check mark</td>
</tr>
<tr>
<td>Return (focus in comment field)</td>
<td>Save edit and return focus to subtitle</td>
</tr>
<tr>
<td>Shift Return (focus in comment field)</td>
<td>Create new row in comment field</td>
</tr>
<tr>
<td>Esc (focus in comment field)</td>
<td>Return focus to subtitle without saving edit</td>
</tr>
</tbody>
</table>

### Positioning

*Place cursor at the required position in the text*

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 / 2 / 3 (Numpad)</td>
<td>Left / Centre / Right position</td>
</tr>
<tr>
<td>Shift 1 / 2 / 3 (Numpad)</td>
<td>Left / Centre / Right justification</td>
</tr>
<tr>
<td>Alt arrow keys</td>
<td>Move subtitle 1 unit in given direction (4 Closed Caption horizontal cells)</td>
</tr>
<tr>
<td>Ctrl Alt arrow keys</td>
<td>Move subtitle 10 units / 2 Teletext cells / 1 Closed Caption cell in given direction</td>
</tr>
<tr>
<td>Shift Alt arrow keys</td>
<td>Move current row 1 unit in given direction (4 Closed Caption horizontal cells)</td>
</tr>
<tr>
<td>Ctrl Shift Alt arrow keys</td>
<td>Move current row 10 units / 2 Teletext cells / 1 Closed Caption cell in given direction</td>
</tr>
</tbody>
</table>
# Wincaps Q4 User Guide

<table>
<thead>
<tr>
<th>Shift Alt Home</th>
<th>Move current row to left position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Alt End</td>
<td>Move current row to right position</td>
</tr>
<tr>
<td>Enter</td>
<td>Toggle raise/drop subtitle position</td>
</tr>
<tr>
<td>Shift Enter</td>
<td>Place subtitle at top of video screen</td>
</tr>
</tbody>
</table>

## Audio Alignment

*Focus in SpeakTitle Window and List View*

<table>
<thead>
<tr>
<th>Ins (Numpad) *</th>
<th>Set/clear section start marker</th>
</tr>
</thead>
<tbody>
<tr>
<td>Del (Numpad) *</td>
<td>Set/clear section end marker</td>
</tr>
<tr>
<td>Ctrl Shift S</td>
<td>Clear alignment of current section</td>
</tr>
<tr>
<td>F11</td>
<td>Start Aligner</td>
</tr>
</tbody>
</table>

* Note that these keys are configurable

## Timecodes

*The NumLock key should be enabled in order for these keystrokes to work correctly.*

<table>
<thead>
<tr>
<th>Shift Ins (Numpad) *</th>
<th>Fix IN time at current timecode value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Del (Numpad) *</td>
<td>Fix OUT time at current timecode value</td>
</tr>
<tr>
<td>Ctrl Ins (Numpad)</td>
<td>Set IN time as explicit at current timecode value</td>
</tr>
<tr>
<td>Ctrl Del (Numpad)</td>
<td>Set OUT time as explicit at current timecode value</td>
</tr>
<tr>
<td>Tab (up arrow)</td>
<td>Move focus (cursor) between subtitle, comments, IN time, duration, OUT time</td>
</tr>
<tr>
<td>Tab (down arrow)</td>
<td>Increase the time by 1 frame</td>
</tr>
<tr>
<td>Ctrl (up arrow)</td>
<td>Decrease the time by 1 frame</td>
</tr>
<tr>
<td>Ctrl (down arrow)</td>
<td>Increases the time by 5 frames</td>
</tr>
<tr>
<td>Ctrl 6 (main keyboard)</td>
<td>Increase the IN time by one frame</td>
</tr>
<tr>
<td>Ctrl 7 (main keyboard)</td>
<td>Decrease the IN time by one frame</td>
</tr>
<tr>
<td>Ctrl 6 (main keyboard)</td>
<td>Increase the OUT time by one frame</td>
</tr>
<tr>
<td>Ctrl 7 (main keyboard)</td>
<td>Decrease the OUT time by one frame</td>
</tr>
<tr>
<td>Ctrl + (Numpad)</td>
<td>Toggle the fixed status of the IN time</td>
</tr>
<tr>
<td>Ctrl + (Numpad)</td>
<td>Toggle the fixed status of the OUT time</td>
</tr>
<tr>
<td>Shift + (Numpad)</td>
<td>Adjust OUT time of previous subtitle to match IN time of current subtitle</td>
</tr>
<tr>
<td>Ctrl Shift + (Numpad)</td>
<td>Adjust IN time of current subtitle to match OUT time of previous subtitle</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ctrl Shift O</td>
<td>Display the Adjust Timecodes dialog to modify timecodes for a range of subtitles</td>
</tr>
<tr>
<td>Ctrl Shift R</td>
<td>Display the Re-Sync Timecodes dialog to modify timecodes for a range of subtitles</td>
</tr>
</tbody>
</table>

* Note that these keys are configurable

**Video Controls**

The Video Control keystrokes are described here.

**Speech Input Controls**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause</td>
<td>Toggle microphone on/off</td>
</tr>
<tr>
<td>Alt+I/D</td>
<td>Change Text Size in SpeakTitle Window</td>
</tr>
<tr>
<td>Alt+L</td>
<td>Clears Text from the SpeakTitle Window</td>
</tr>
</tbody>
</table>

**Shot Changes**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl 1 (Numpad)</td>
<td>Go to previous shot change</td>
</tr>
<tr>
<td>Ctrl 3 (Numpad)</td>
<td>Go to next shot change</td>
</tr>
<tr>
<td>Ctrl Shift 1 (Numpad)</td>
<td>Go to previous shot change or speech block IN time.</td>
</tr>
<tr>
<td>Ctrl Shift 3 (Numpad)</td>
<td>Go to next shot change or speech block IN time.</td>
</tr>
</tbody>
</table>

**Timing Rules**

The Timing Rules are applied in sequence, so the effect of one rule may undo the effect of a previous rule. The sequence is chosen so that the most important rules are applied last.

If a given Timing Rule is disabled in the Timing Rules dialogue then it is not applied.

Some rules behave differently when the aligner is running compared to when the user grabs an individual timecode – noted in context below.

The rules have built-in sanity checking to prevent any action from causing a subtitle to go out of sequence or to end up with negative duration: this may explain why some user actions are refused. These restrictions do not apply in **Fix Mode**.

The rules do provide a narrative to explain what they are doing, and people should be encouraged to consult this narrative to see what the system is doing.

**Parameters**
The screenshot below shows the Timing Rules parameters that can be supplied by the user:

![Timing Rules Configuration](image)

Note that the values need to be reasonably self-consistent otherwise the results will not be as expected. For example:

The default text display rate should reflect the programme speech rate as modified by the expected editing percentage: if the programme is around 180wpm verbatim and the subtitlers are expecting to edit by around 10% maximum then a word rate of around 160wpm is sensible. Given the maximum number of subtitle rows plus the number of words per line on average, the nominal maximum duration can then be worked out.

If the programme has large numbers of short video sequences with lots of cuts, then the zone of influence of a given shot change should be shorter than for a programme with fewer cuts, otherwise the zones will tend to overlap.

**Sequence**

The processing sequence is as follows:

1) Sanity check  
2) Section markers  
3) Duration
4) Shot changes
5) Magnetism
6) Gaps
7) Addons

1) Sanity check

If the proposed timecode change would take the subtitle out of sequence or give it a negative duration, then the change is ignored (does not apply in Fix Mode).

2) Section markers

When aligning, the subtitle at the start of a section should have an In time on or after the section start marker and within a defined distance of it. Similarly at the end of the section, the Out time must fall within a distance on or before the end marker. When sliding, a subtitle should not entirely pass out of the enclosing section.

3) Duration

If the duration is too short and there is space after the Out time, Out is extended to a limit of the next In. If duration is still too short and there is space before the In time, and only when aligning, In is reduced to a limit of previous Out. Otherwise report that the subtitle is hemmed in. If the duration is too long, reduce Out. Note that if the next In is floating or when working in Fix Mode, the Out time of the current subtitle is allowed to extend beyond it.

4) Shot changes

In time: Find the nearest shot changes before and after In for which In is in zone of influence. If In is already at correct distance after, do nothing. If only one shot change, clip to it unless a sequence error would occur. If between two shot changes, clip to the later one unless within 1/3 distance of the earlier in which case clip to that instead. Ignore any change if it takes the In time to within 5 frames of next In time or causes a sequence error. If aligning, re-check duration and refloat if now too short.

Out time: Find the nearest shot changes before and after Out for which Out is in zone of influence. If Out is already at correct distance before, do nothing. If only one shot change, clip to it unless a sequence error would occur. If between two shot changes, clip to the later one unless within 1/3 distance of the earlier in which case clip to that instead. Ignore any change if it causes a sequence error.

5) Magnetism

If the original gap before In or after Out was the minimum gap, deem boundary to be magnetic. If magnetic In is moved and previous Out is not explicit then move previous Out to follow it unless that would extend the previous duration to more than twice its float value (or 2 seconds, if float value is very small). If magnetic Out is moved and next In is not explicit then move next In to follow it unless that would extend the next duration to more than twice its float value (or 2 seconds, if float value is very small).

6) Gaps
In: The precedence rules are that an explicit In overrides a previous Out; an explicit previous Out overrides an In, otherwise a previous Out is overridden by a new In. If In changes then remove any overlap using above precedence and then reset the gap to prescribed minimum if too short or if in exclusion zone. If there is an intervening shot change then double the gap provided it would not create a sequence error.

Out: The precedence rules are that an explicit Out overrides a next In; otherwise Out is overridden by next In. If Out changes then remove any overlap using above precedence and then reset the gap to prescribed minimum if too short or if in exclusion zone. If there is an intervening shot change then double the gap provided it would not create a sequence error.

7) Add-ons

Allow for the special case of Add-ons where the Out times of all the subtitles in the Add-on sequence are the same

(AL v1.0 20/09/11) + 6888 + 7156 + 7157 + 7249
Subtitle file formats

This topic describes the level of support for various third-party file formats when importing and exporting subtitle files.

Note that Q-Live supports a limited subset of these third-party formats.

Not all formats are fully detailed in this release of Wincaps Q4 help. These will be expanded in future releases.

Exports marked with a * in the above list are for Line21 (Closed Caption) systems.

General:

Any extra spaces between words are automatically stripped when you import a file. However, extra spaces are retained on export.

Files containing blank subtitles:

If a Wincaps Q4 file contains any blank subtitles they will not be included in the final exported file for most export formats and the remainder of the subtitles will be renumbered automatically by the export process. The exception is when exporting to the STL, PAC, 890, TXT, RTF, DFXP and EBU-TT formats. In these cases the blank subtitles will be exported if the Allow blank subtitles option is selected. If the option is unselected then the blank subtitles will be suppressed in the same manner as the other export formats.

890 (Cavena/ScanTitling)

GSI Information:

The GSI fields map to the 890 file header as follows. The numbers in brackets indicate the length of each field.

Programme title -> TITLE #1 and #2 (43)
Episode title -> EPISODE TITLE #1 and #2 (28)
Translator name -> TRANSLATOR (28)
Start of programme -> START TIMECODE (11)
Contact details -> PRODUCER (28)
Production number -> COMMENTS #1 (24)
Tape Number -> TAPE NR (20)
Programme Length -> PROGRAM LENGTH (8)

Other GSI fields are ignored on export and other 890 metadata header fields are ignored on import.

Background styles:

Wincaps Q4’s background styles map to the 890 boxing styles as follows:

On export:

Block/Solid/Row ->"Automatic Box" (20)
Surround/Any/Any->"Border" (40)
Shadow/Any/Any/Any - > "Shadow" (60)
Block/Solid/Box/Any - > "Fixed Box" (A0)

Other Wincaps Q4 background styles are ignored on export (will be set to "None")

On import:

"Automatic Box" (20) - > Block/Solid/Row
"Border" (40) - > Surround/2/Smooth
"Shadow" (60) - > Shadow/2/South East/Thin
"Wide Border" (80) - > Surround/2/Smooth
"Fixed Box" (A0) - > Block/Solid/Box/4px
"Fixed Height Box" (C0) - > Block/Solid/Box/4px

Wincaps Q4 only supports a boxing transparency (clip level) of 0 (solid) (0x08) which will be converted to "black background" on import. Any subtitles with background styles will be set to "solid" on export.

**Vertical positioning:**

Each subtitle in an 890 file consist of 1, 2 or 4 records, each record contains 2 rows of subtitle text.
This gives a maximum of 8 on-screen row positions where row 1 is at the bottom and row 8 at the top.
Wincaps Q4 positions rows 1-4 at the bottom of the screen and 5-8 at the top
If a subtitle has more than 8 rows then only the first 8 are exported
A simple bottom-positioned subtitle that fits on two rows will be exported as 1 record
A top-positioned subtitle will be exported as 4 records with the top line of text on row 8.
A middle-positioned subtitle will be exported as 4 records with text on row 5 (single row) or 5-6 (two rows)

**Language support:**

Language codes follow the standard EBU specification, e.g. 09 (hex) for English, 27 (hex) for Finnish, 28 (hex) for Swedish etc.

If the **Hard-of-Hearing** checkbox is ticked in the file language properties, the language code will be set as follow for the Finnish and Swedish languages:

<table>
<thead>
<tr>
<th>Language</th>
<th>Language code</th>
<th>Second language code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finnish</td>
<td>47 (hex)</td>
<td>27 (hex)</td>
</tr>
<tr>
<td>Swedish</td>
<td>48 (hex)</td>
<td>27 (hex)</td>
</tr>
</tbody>
</table>

Wincaps Q4 does not currently support secondary languages. Wincaps Q4 will set the "second language" code to the same value as the "language" code except in the special "Hard-of-Hearing" cases noted above.

**Comments:**

Comments are not supported in 890 files.
DFXP (MXF)
This is the **W3C Timed Text Markup Language** (TTML) 1.0 format, also known as
DFXP.

Q4 supports a partial implementation of this format. The list of currently unsupported attributes includes (but is not limited to):

* Text justification
* Surround styles

The following notes apply to DFXP **export** at this time:

* NTSC personality - the exported timecodes show slight inaccuracies
* Vertical positioning - the export contains (up to) three regions for "before", "center" and "after" displayAlign. Each subtitle is assigned the closest matching region. In other words, subtitles that are "top", "middle" or "bottom" positioned will be exported accurately, subtitles with non-standard vertical positions will be assigned the nearest suitable one.

The format of the timecode information ("begin" and "end") is configurable on export, along with the default file extension and the choice of region positioning units as either pixels (default) or percentages.

When the positioning is configured to use percentages, the value of tts:fontSize is calculated as a percentage of the row height. This in turn is calculated as the vertical height of the display in pixels divided by 15 (the default number of screen rows defined by the DFXP specification). For example, a font size of 30 pixels in a 720x576 display equates to 78% (i.e. (30 / (576/15)) * 100)

The following notes apply to DFXP **import** at this time:

The import assumes that all regions are full-screen. Subtitles that have one of the three standard displayAlign attributes will have their vertical position set to top/middle/bottom accordingly. The positioning of scattered and/or split subtitles won't be preserved on import.

Horizontal positioning/justification is set by the textAlign attribute. Subtitles will be positioned L/L, C/C or R/R depending on the setting of textAlign.

There are also extra settings

An example of Wincaps Q4's DFXP output is shown below:
The DLP Cinema export settings can be configured.

Final Cut Pro

This is the **NLE Final Cut Pro** format. This format consists of a set of images (one per subtitle) plus an XML control file.

Options for the FCP format including the choice of image type (tif or png) can be configured here.

In addition, boxing settings can be used to configure the appearance of the resulting image files.

Protoscript

Protoscript is a text-based format that may contain scene and speaker information. An example of a Protoscript file is shown below:

```
00:00:09:09 - 00:00:13:09
NARRATOR: The average person can hold their breath for 40 seconds.

00:00:15:13 - 00:00:18:14
NARRATOR: Tanya Streeter can do it for over six minutes.

00:00:19:14 - 00:00:20:21
TANYA: It's just my thing.

00:00:20:22 - 00:00:23:21
TANYA: I have this unique relationship with the ocean.
```

A Protoscript file may contain scene and speaker information, as well as text and timecodes.

RTF

The example below shows how Wincaps Q4's RTF export appears:
Each subtitle has a header with the following format:

<subtitle number> <in time> <out time>

RTF files should be formatted correctly as per the above example for accurate import.

If the RTF file contains raw unformatted text (i.e. no timecode information) then Wincaps Q4 will attempt to import the text as best it can.

SAMI
The SAMI export settings can be configured.
SRT (SubRip)
SRT is a text-based format, also referred to as SubRip.
In and Out times are saved as hh:mm:ss,ms

Colour, position and markup information is not supported by this format.

An example of a file in SRT format is shown below:

1
10:00:00,000 --> 10:00:02,680
Subtitle one. Normal.
Left, Left, Bottom, White.

2
10:00:02,720 --> 10:00:06,400
Subtitle two. Bold.
Centre, Centre, Middle, Yellow.

3
10:00:06,440 --> 10:00:10,720
Subtitle three. Italic.
Right, Right, Top, Cyan.

When exporting to SRT, you can choose the desired character encoding, i.e. ANSI or Unicode. This is set by the same configuration option as for Text file exports. The default format is UTF-8 with BOM. Note that versions of Wincaps Q4 prior to 4.11 always used UTF-8 no BOM when exporting SRT files.
Note regarding timecodes: If the W32 file has media associated with it then Wincaps Q4 will automatically re-base the timecodes in the exported file to 0 by subtracting the start-time of the media from every timecode. If no media file is attached then the timecodes are exported unchanged.

STL/EBU
There are several 'flavours' of STL export that have minor changes to the EBU STL Specification https://tech.ebu.ch/docs/tech/tech3264.pdf to work with 3rd party systems. The EBU STL Specification only supports 25 and 30 fps and although Wincaps Q4 does allow other frame rates to be exported these cannot be guaranteed to work with other systems.

For Teletext personality files, the 'Standard' export follows the EBU STL spec and for Open Caption personality use the 'Generic' flavour.

There are also STL/EBU export settings which can be configured to make exports compatible with other third-party EBU implementations.

We allow export of Open Caption files with 24 fps although these are not specifically supported by the EBU STL spec. This produces a DFC code in the GSI of 24.01 which may not be read correctly by a third party system.

For best results any file should be converted to a frame rate (25 or 30 fps) that is supported by the EBU STL spec.

Text Export:

Text export offers the choice of plain text (without timecodes) or timecoded text. You can configure the encoding to use when exporting text files. Qu4ntum give you the choice of:

- ANSI no BOM (Byte Order Marker)
- UCS-2 Little Endian with BOM
- UCS-2 Big Endian with BOM
- UTF-8 with BOM (default)
- UTF-8 no BOM

Note that versions of Wincaps Q4 prior to 4.11 offered the choice of "Text" or "Unicode". The old "Text" format is the equivalent of "ANSI no BOM" and the old "Unicode" format is the equivalent of "UCS-2 Little Endian with BOM".

An example of a plain text export is shown below:

```
The average person can hold their breath for 40 seconds.
Tanya Streeter can do it for over six minutes.
It’s just my thing.
I have this unique relationship with the ocean.
```

An example of a timecoded text export is shown below:
When importing a text file, Wincaps Q4 examines the file to determine the type of encoding used. This is displayed in the Import Wizard, where you can override it if necessary. Wincaps Q4 can import text files encoded in any of the formats listed in the "Export" section above.

When inserting a text file, Wincaps Q4 auto-detects the encoding, using the language of the current file to determine the correct code page for ANSI text files.

When importing raw text files, Wincaps Q4 splits the text up into subtitles according the Configure Import - Text settings. These allow you to specify the number of rows of text per subtitle and the maximum number of characters per row.

Ultech DV3000
The Ultech DV3000 export settings can be configured.

Screen Systems

General:

Any extra spaces between words are automatically stripped when you import a file. However, extra spaces are retained on export. Comments are read in on import but are not exported. These file formats do not support black as a foreground colour - black will be replaced by blue on export as per Poliscript. These file formats does not support bold or underline styles and any such markup will be stripped on export.

Uninitialised timecodes in the PAC file are set to 00:00:00:00 on import.

Files containing blank subtitles:

If a Wincaps Q4 file contains any blank subtitles they will not be included in the final exported file for most export formats and the remainder of the subtitles will be renumbered automatically by the export process. The exception is when exporting to the STL, PAC, 890, TXT and RTF formats. In these cases the blank subtitles will be...
exported if the Allow blank subtitles option is selected. If the option is unselected then the blank subtitles will be suppressed in the same manner as the other export formats.

Language codes:

The three-character PAC language codes (e.g. GBR, ESP) are configured in the PoliSTLServerLangs.lst file, located in the Wincaps Q4 "common files" folder. An example of this file is shown below:

<table>
<thead>
<tr>
<th>Language Code</th>
<th>EBU Hex Code</th>
<th>ISO Code</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNK:07:dan</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEU:08:deu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GBR:09:eng</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRC:70:gre</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ESP:0A:spa</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EST:DC:----:estonian</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FIN:27:fin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FRA:0F:fra</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The file format is:

<PAC Language Code>:<EBU Hex Code>:<ISO Code>:<Comment>

Whenever you import or export a PAC file, Wincaps Q4 uses this table to translate between the PAC language code (stored in the LANG: <xxx> field of subtitle 0) and Wincaps Q4's language representation (EBU/ISO). If a language does not have an entry in this file, the language code will be exported as the first three letters of the language name (e.g. "Tig" for Tigrinyan). Unrecognised languages will default to English on import.

Vertical positioning:

The PAC file formats have limited support for vertical positioning. The screen is divided into 11 rows and an individual subtitle may only be positioned on one of these 11 rows.

Because of this limitation, when importing a PAC file using the Import Wizard, you should always select a font size of 36 in order to get the best results. Similarly, when creating subtitles that are intended for export to PAC you should use a font size of 36 to get the best results on export.

PAC

PAC is the main file format used by Screen Systems products, including Poliscript.

Subtitle 0:

Subtitle 0 in a PAC file is used to contain metadata and other control information. This special subtitle is not displayed in Wincaps Q4's subtitle list. Instead, it is constructed automatically on export using the GSI information. In situations where the standard subtitle 0 layout is unsuitable, you can create a user-defined subtitle 0.

Normally the contents of Subtitle 0 is constructed automatically on export from the information contained in the GSI fields as follows:

<gsi programme title>
STORY:<gsi story>
Notes:

If the `<gsi programme title>` is blank then nothing will appear in the subtitle 0 on export.
See the previous section for information on the language codes.
Subtitle 0 rows are centered.
Other GSI fields are ignored on export.
Case is preserved.

**Note:** The automatic language code selection can be overridden by entering a string into the "Reference Code" GSI field.

**User-defined subtitle 0:**

Alternatively, you can define the contents of subtitle zero manually using the **Subtitle Zero** button in the GSI pane of the Toolbox. Manual text will override the GSI fields on export.

**Import of subtitle 0:**

When you import or open a PAC file, The Import Wizard will give you the option to remove the first subtitle (subtitle 0). If you check this option, the import process will populate the GSI information from the contents of subtitle 0 but the user-defined subtitle 0 text will be cleared. If you uncheck this option, the GSI information will be populated as before but in addition, the entire contents of subtitle 0 will be placed into the user-defined subtitle 0 text. Use this option to preserve the subtitle 0 information when the file being imported has a non-standard configuration.

**Horizontal positioning:**

Wincaps Q4's export supports Left, Centre and Right alignment on a per-row basis. It does not currently support PAC "Left Centre Alignment" (ISCLJ) or "Left alignment with column information" (ISALN). Subtitles containing rows that are not Left, Centre or right aligned will cause errors to be reported on export.

**Font 1/2:**

Wincaps Q4 always sets Font1 to Latin in the exported file. Font2 will only be used if the file contains a second (non-Latin) language.

**Background styles:**

Wincaps Q4's background effects map to the PAC outline styles/background types as follows:

<table>
<thead>
<tr>
<th>Wincaps Q4 Background Effect =&gt;</th>
<th>PAC Background Type + (sa3)</th>
<th>PAC Background Style (sa2)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
No background | No control (80) | Outline (80)
Surround/Any/Any | No control (80) | Outline (80)
Shadow/Any/Any/Any | No control (80) | Drop shadow (81)
Block/Solid/Box/Any | Stripe (84) | Outline (80)
Block/Solid/Row/Any | Boxed (82) | Outline (80)
Block/Mesh/Row/Any | Ghost box (83) | Outline (80)

On import:

<table>
<thead>
<tr>
<th>PAC Background Type + (sa3)</th>
<th>PAC Background Style =&gt; (sa2)</th>
<th>Wincaps Q4 Background Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>No control (80)</td>
<td>Outline (80)</td>
<td>Surround/2/Smooth</td>
</tr>
<tr>
<td>Unboxed (81)</td>
<td>Outline (80)</td>
<td>Surround/2/Smooth</td>
</tr>
<tr>
<td>Boxed (82)</td>
<td>Outline (80)</td>
<td>Block/Solid/Row/4</td>
</tr>
<tr>
<td>Ghost box (83)</td>
<td>Outline (80)</td>
<td>Block/Mesh/Row/4</td>
</tr>
<tr>
<td>Stripe (84)</td>
<td>Outline (80)</td>
<td>Block/Solid/Box/4</td>
</tr>
<tr>
<td>Ghost stripe (85)</td>
<td>Outline (80)</td>
<td>Block/Mesh/Box/4</td>
</tr>
<tr>
<td>No control (80)</td>
<td>Drop shadow (81)</td>
<td>Shadow/2/SE/Thin</td>
</tr>
<tr>
<td>Unboxed (81)</td>
<td>Drop shadow (81)</td>
<td>Shadow/2/SE/Thin</td>
</tr>
<tr>
<td>Boxed (82)</td>
<td>Drop shadow (81)</td>
<td>Block/Solid/Row/4</td>
</tr>
<tr>
<td>Ghost box (83)</td>
<td>Drop shadow (81)</td>
<td>Block/Mesh/Row/4</td>
</tr>
<tr>
<td>Stripe (84)</td>
<td>Drop shadow (81)</td>
<td>Block/Solid/Box/4</td>
</tr>
<tr>
<td>Ghost stripe (85)</td>
<td>Drop shadow (81)</td>
<td>Block/Mesh/Box/4</td>
</tr>
</tbody>
</table>

RAC

Subtitle 0:

The RAC subtitle 0 is built up in exactly the same way as for PAC files (see above)

PU2000

GSI Information and subtitle 0:

The labels are fixed. When exporting a file in the PU2000 format, the content of subtitle 0 is automatically derived from the information in the Wincaps Q4 file as follows:

- STORY: - the name of the file without the suffix
- LANG: - OPN for open-caption files or TTV for Teletext files
- <programme title> - from the GSI "Programme Title" field
- EPS: - from the GSI "Story" field or if the "Story" field is empty, the "Episode Title" field
- PROD.NR: - from the GSI "Reference code" field

Other GSI fields are ignored on export.

A user-defined subtitle zero may be defined instead in the same way as for PAC files
When importing a PU2000 file, the GSI fields noted above are populated from the contents of subtitle 0.

Poliscript
The Poliscript export is a custom variant of the EBU file format. It supports Teletext personality files only and is designed for use with Polistream systems that require the presence of a subtitle 0 containing control information.

Subtitle 0 is constructed automatically on export and appears as shown below:

```
Lang: GBR
Config: 0
Story: Programme B
```

The labels are fixed. The content for each row is automatically derived from the information in the Wincaps Q4 file as follows.

Lang: - the PAC language code for the selected file language
Config: - 0
Story: - from the GSI "Programme title" field

Poliscript 2
The Poliscript 2 export is a custom variant of the EBU file format. It supports Teletext personality files only and is designed for use with Polistream systems that require the presence of a subtitle 0 containing control information.

Subtitle 0 is constructed automatically on export and appears as shown below:

```
STORY: STORY
LANG: ENG
TITLE: PROGRAMME TITLE
EPS: EPISODE TITLE
START TC: 10:00:00:00
FIRST TITLE TC: 10:00:05:12
TOTAL No OF TITLES: 253
LAST TITLE TC: 10:27:43:16
```

The labels are fixed. The content for each row is automatically derived from the information in the Qu4ntum file as follows. All content strings are automatically capitalised:

STORY: - from the GSI "Story" field
LANG: - the PAC language code for the selected file language
TITLE: - from the GSI "Programme Title" field
EPS: - from the GSI "Episode Title" field
START TC: - from the GSI "Start of programme" field
FIRST TITLE: - the In time of the first subtitle in the file
TOTAL No OF TITLES: - the total number of subtitles in the file
LAST TITLE TC: - the In time of the last subtitle in the file

Note that if the text in any of the GSI fields is too long to fit on a single row it will be truncated by the export and a "row length exceeded for subtitle 0" will be logged in the export report.

Note that the Poliscrip2 export does not support the custom row zero definition.

On export, the following GSI fields in the subtitle file are automatically populated with the name of the file (observing case), ignoring any information in the corresponding GSI toolbox fields:

"Original programme title"
"Original episode title"
"Translated programme title"
"Translated episode title"

For example, if the name of the exported file is SH_SN_DLLS120100_01_ESP.STL then the above GSI fields will be populated with the string SH_SN_DLLS120100_01_ESP

When importing a STL file that contains a subtitle zero, the GSI information in Wincaps Q4 is populated from the contents of subtitle 0.

CHK

A CHK file contains multiple PAC subtitle streams for different languages. When you open or import a CHK file, the Import Wizard identifies the streams that it contains and prompts you to choose the stream to import. The streams are identified by the three-letter PAC language codes. For example:
The rest of the import process is the same as for importing a normal PAC file.

**EBU-TT**

This is the EBU-TT Subtitling format definition.

Wincaps Q4 supports a **partial** export of this format. The list of current limitations includes (but is not limited to):

- Accurate positioning of split or scattered subtitles is not currently supported
- Surround styles (for Open Caption subtitles) are not supported
- Cumulative subtitles (Add-ons) are not supported - the export will generate a warning if the file contains add-on subtitles

The following issues also apply to EBU-TT export at this time:

- Subtitles that have the TX Disabled attribute set are not exported
- Positioning for mixed-personality files is not fully implemented, hence you should avoid exporting mixed-personality files at this time

Wincaps Q4 does not currently support the importing of EBU-TT files.

Wincaps Q4's export complies with EBU-TT Part 1 with the exception of individual subtitle comments, which are an extension. If you require strict Part 1 compliance, you should remove any subtitle comments from the file before exporting.

Wincaps Q4's EBU-TT export allows you to choose one of three different units systems as follows:

- **Percentages** - appropriate for both Teletext and Open Caption subtitle personalities
- **Cells** - appropriate for Teletext subtitles only
- **Pixels** - appropriate for Open Caption subtitles only

Note: Whilst it is possible to export Teletext subtitles using pixel positioning or Open Caption subtitles using cell positioning, these are not supported configurations.

**Configuration**

There are a number of options for the EBU-TT export that you can configure via the Info->Configure pane of the Toolbox. These settings are stored **per-customer** in the same way as other export configuration settings.

Click the **EBU-TT** button to display the **EBU-TT Settings** dialog as shown below.
Units System: Choose the type units to use for size and positioning information, either "Percentages", "Cells" or "Pixels". Your choice will be used for all such units in the exported file except for the top-level tts:extent which is always specified in pixels.

Timing Mode: Choose the required ttp:timeBase mode for the exported file. Timecodes will be formatted according to the selected mode i.e. as "HH:MM:SS:FF" (frames) or "HH:MM:SS:000" (milliseconds).

Region Type: Choose the type of layout regions to use, either "Safe Area" or "Subtitle".

Cell Resolution: Specifies the dimensions of the x by y "grid" used for calculating subtitle positions and font sizes.

Video Extent Override: Controls the value of tts:extent in the exported file. If left unticked, Wincaps Q4 derives this setting from the media information in the file personality. If overridden, Wincaps Q4 uses the custom values entered here.

Line Height Override: Allows you to override the values of tts:lineHeight in the style section of the exported file.

Colour Format: Chose wether to export colours using names or RGB values.
**Transparency (hex)**: Set a transparency value for background colours

**Transmission/Interchange**: Optimise the output for use with transmission systems

**Clipped background**: Explicitly set all foreground and background colours at the span level rather than the paragraph level

**Strip MultiRowAlign**: Remove all MultiRowAlign elements from the output

**Always Split Subtitles**: This treats each subtitle row as a separate position. This should only be used with 'scattered' subtitles, where rows are positioned differently from the subtitle property.

**Default Style**: Optionally specify a default style for the `div` element. Take care to ensure that the string you enter is valid XML. You can use the **Check** button to confirm this.

**File Comment**: Optionally specify a comment to be included at the start of the exported file.

**Configuration Profiles**

Sometimes you might want to apply the same combination of export settings to different customers. This is easily achieved through the use of **configuration profiles**. The basic method is as follows:

1. In the EBU-TT Settings dialog, configure the export settings as desired
2. In the **Profile** tab, click the **Create** button to create a new profile containing the current settings
3. Open a file that has a different customer assigned
In the EBU-TT settings dialog, switch to the Profile tab and select the profile that you want to apply from the drop-down list. Click the Apply button to apply the chosen configuration profile to the active customer. Once you have created a profile, you can apply it to as many customers as you like by repeating steps 3-5.

Profile: Shows the list of stored configuration profiles and allows you to select one.
Apply: Apply the currently selected profile to the active customer settings.
Save: Save the active customer settings to the selected profile, replacing its existing contents.
Create: Create a new configuration profile based on the current settings for the active customer.
Delete: Delete the currently selected profile.
Import: Create a new configuration profile by importing an .ini file that has been exported from another system.
Export: Save the current settings to a .ini file that can be subsequently imported into another system.

Implementation

This section describes Wincaps Q4’s implementation of the EBU-TT export in more detail.

File comment:

You can optionally define a comment to be included at the start of the exported file. You do this in the Additional Settings tab of the configuration dialog. The comment will appear like this in the exported file:
Top-level attributes:

The table below shows how the top-level attributes of the exported file are populated:

<table>
<thead>
<tr>
<th>top-level attribute name</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>ttp:timeBase</td>
<td>configurable timing mode - either &quot;smpte&quot; or &quot;media&quot;</td>
</tr>
<tr>
<td>ttp:frameRate</td>
<td>as per file personality settings (1)</td>
</tr>
<tr>
<td>ttp:frameRateMultiplier</td>
<td>as per file personality settings (1)</td>
</tr>
<tr>
<td>ttp:dropMode</td>
<td>as per file personality settings (1)</td>
</tr>
<tr>
<td>ttp:markerMode</td>
<td>&quot;discontinuous&quot; (1)</td>
</tr>
<tr>
<td>ttp:cellResolution</td>
<td>configurable - defaults to &quot;50 30&quot;</td>
</tr>
<tr>
<td>tts:extent</td>
<td>defaults to file personality settings unless overridden via the configuration dialog (2)</td>
</tr>
<tr>
<td>xml:space</td>
<td>&quot;preserve&quot; (4)</td>
</tr>
<tr>
<td>xml:lang</td>
<td>derived automatically from the file language setting, e.g. &quot;en-GB&quot; (3)</td>
</tr>
</tbody>
</table>

(1) These elements are only generated if ttp:timeBase is set to "smpte"
(2) This element is only generated if Units System - Pixels is selected
(3) If Transmission/Interchange mode is selected then only the first part of the value will be used, e.g. "en" instead of "en-GB"
(4) These items are omitted from the output if Transmission/Interchange mode is selected

Document Metadata:

The table below shows how the document metadata elements are populated. Unpopulated (i.e. blank) elements will be omitted from the export:

<table>
<thead>
<tr>
<th>ebutchm: element name</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>documentEbuttVersion</td>
<td>v1.0 (1)</td>
</tr>
<tr>
<td>documentIdentifier</td>
<td>contents of GSI &quot;Story&quot; field</td>
</tr>
<tr>
<td>documentOriginatingSystem</td>
<td>WinCAPS Qu4ntum</td>
</tr>
<tr>
<td>documentCopyright</td>
<td>© 2014</td>
</tr>
<tr>
<td>documentTargetAspectRatio</td>
<td>as per file personality settings</td>
</tr>
<tr>
<td>documentOriginalProgrammeTit</td>
<td>le contents of GSI &quot;Programme title&quot; field</td>
</tr>
<tr>
<td>documentOriginalEpisodeTitle</td>
<td>contents of GSI &quot;Episode title&quot; field</td>
</tr>
<tr>
<td>documentTranslatedProgrammeTitle</td>
<td>contents of GSI &quot;Translated programme title&quot; field</td>
</tr>
<tr>
<td>documentTranslatedEpisodeTitle</td>
<td>contents of GSI &quot;Translated episode&quot; field</td>
</tr>
<tr>
<td>documentTranslatorsName</td>
<td>contents of GSI &quot;Translator's name&quot; field</td>
</tr>
<tr>
<td>documentTranslatorsContactDetails</td>
<td>contents of GSI &quot;Translator's contact details&quot; field</td>
</tr>
<tr>
<td>documentSubtitleListReference</td>
<td>contents of GSI &quot;Reference code&quot; field</td>
</tr>
</tbody>
</table>
(1) If **Transmission/Interchange** mode is selected then only those metadata elements indicated by (1) will be included

**Speakers:**

Each speaker in the speaker list is exported as a **ttm:agent** element as shown in the example below. Note that the identifiers ("Sp1", "Sp2" etc.) are not guaranteed to be sequential.

```xml
<ttm:agent type="person" xml:id="Sp1">
  <ttm:name type="other">NARRATOR</ttm:name>
</ttm:agent>
<ttm:agent type="person" xml:id="Sp2">
  <ttm:name type="other">JOHN</ttm:name>
</ttm:agent>
<ttm:agent type="person" xml:id="Sp3">
  <ttm:name type="other">JANE</ttm:name>
</ttm:agent>
```

**Styling:**

On export, Wincaps Q4 analyses the file and creates an optimised set of pre-defined styles which are then applied to the subtitle **div** elements as appropriate. The following example demonstrates this:
In this example subtitle one uses style S1 whereas subtitle two uses a combination of two styles to achieve the desired effect.

You can optionally assign a default style to the div. You configure this default style in the Additional Settings tab of the configuration dialog, e.g.

![Default Style](image)

Note: This is the Div Style in the EBU TT document.

If you specify a default style in this way, Wincaps Q4 assigns it to style "S1" and assigns "S1" as the div style as shown in the example below:

```
<tt:style xml:id="S1" tts:fontFamily="Verdana, Arial, Tiresias"/>
<tt:style xml:id="S2" tts:fontSize="180%" tts:color="white" ebuts:multiRowAlign="center" tts:backgroundColor="black" tts:textAlign="center" tts:lineHeight="125%"/>
```

Wincaps Q4's export uses the following styling attributes:

<table>
<thead>
<tr>
<th>tt:style attribute name</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>xml:id</td>
<td>Unique style identifier (&quot;S1&quot;, &quot;S2&quot; etc.)</td>
</tr>
<tr>
<td>tts:fontSize</td>
<td>(depends on units configuration option - see below)</td>
</tr>
<tr>
<td>tts:color</td>
<td>from subtitle foreground text colour (1)</td>
</tr>
<tr>
<td>ebuts:multiRowAlign</td>
<td>from subtitle justification (3)</td>
</tr>
<tr>
<td>tts:backgroundColor</td>
<td>from subtitle background text colour (2)</td>
</tr>
<tr>
<td>tts:textAlign</td>
<td>from subtitle horizontal position</td>
</tr>
<tr>
<td>tts:lineHeight</td>
<td>(depends on Line Height Override configuration option (4))</td>
</tr>
</tbody>
</table>

(1) Colours can be exported using textual representation (e.g. "black", "white", "red" etc.) or as RGB values depending on the chosen Colour format in the configuration.
dialog. Colours that do not have a defined EBU-TT textual representation are always exported as RGB values.

(2) If the Colour format is set to RGB then you can specify an optional transparency value that will be applied to all background colours.

(3) ebutts:multiRowAlign will be omitted from the output if it has the same value as tts:textAlign. In addition, there is a configuration option to suppress all instances of ebutts:multiRowAlign for use where the target system does not support this attribute.

(4) tts:lineHeight is set to "normal" unless the Line Height Override configuration option is ticked in which case it is set to the entered value.

tts:fontSize is determined as follows, depending on the configured units system:

<table>
<thead>
<tr>
<th>Selected Units system</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentages</td>
<td>&quot;NNN%&quot; where NNN is calculated as follows:</td>
</tr>
<tr>
<td></td>
<td>Teletext personality: &quot;200%&quot; for double-height Teletext, assuming no Line Height Override. If an override value VVV is specified then NNN is calculated as 20,000 / VVV, e.g. if the override is specified as is 125% then fontSize will be 160%</td>
</tr>
<tr>
<td></td>
<td>Open Caption personality: NNN = (font size / (screen height in pixels / vertical cells)) * 100</td>
</tr>
<tr>
<td>Cells</td>
<td>&quot;1c 2c&quot; for double-height Teletext</td>
</tr>
<tr>
<td>Pixels</td>
<td>&quot;NNpx&quot; where NN is the font size of the text</td>
</tr>
</tbody>
</table>

Layout:

Wincaps Q4 uses regions in order to position the subtitles. The export configuration allows you to select between two different types of regions:

**Safe Area**: Wincaps Q4 creates up to three regions, each with the full dimensions of the Safe Area. One region is used for top-positioned subtitles, one for middle-positioned subtitles and one for bottom-positioned subtitles. Note that subtitles with arbitrary vertical positions are assigned to the closest matching region, with the consequent loss of positioning information.

**Subtitle**: Wincaps Q4 creates multiple regions corresponding to the positions (origin) and dimensions (extent) of the subtitles. This allows for more accurate positioning of subtitles that have arbitrary horizontal and vertical positions (i.e. not matching one of left/centre/right or top/middle/bottom).

The values and units for origin and extent will depend on the chosen system units (percentages/cells/pixels) and are calculated using the configured values of Cell Resolution and, for Open Caption subtitles, the dimensions of the Video Extent and the safe area settings configured in the Wincaps Q4 file.

Wincaps Q4’s export uses the following layout attributes:
### tt:region attribute

<table>
<thead>
<tr>
<th>name</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>xml:id</td>
<td>Unique region identifier (&quot;R1&quot;, &quot;R2&quot; etc.)</td>
</tr>
<tr>
<td>tts:origin</td>
<td>(see above)</td>
</tr>
<tr>
<td>tts:extent</td>
<td>(see above)</td>
</tr>
<tr>
<td>tts:displayAlign</td>
<td>from subtitle vertical position</td>
</tr>
</tbody>
</table>

A typical layout for "Safe Area" regions is shown in example one.

### Div:

Individual subtitles are enclosed by a `<tt:p>` element. Subtitle text is always enclosed by a `<tt:span>` element. Line breaks are not enclosed by a span. An empty row is indicated by an empty span `<tt:span />`

The following attributes are present for each subtitle:

<table>
<thead>
<tr>
<th>tt:p attribute name</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>xml:id</td>
<td>Unique subtitle identifier (&quot;C1&quot;, &quot;C2&quot; etc.)</td>
</tr>
<tr>
<td>Region</td>
<td>References a previously defined region</td>
</tr>
<tr>
<td>Begin</td>
<td>from subtitle In time timecode</td>
</tr>
<tr>
<td>End</td>
<td>from subtitle Out time timecode</td>
</tr>
<tr>
<td>style</td>
<td>References a previously defined style</td>
</tr>
</tbody>
</table>

### Notes on positioning of Teletext subtitles:

When exporting Teletext subtitles, you should select either **Cell** or **Percentage** units in the export configuration dialog.

Normally you should leave **Cell Resolution** set to "50 30" (the defaults), since this is the recommended setting for Teletext subtitles (reference EBU-TT part 2.) This surrounds the fixed 40 x 24 Teletext safe area grid as shown below:
Cells are converted to percentages by simple division, i.e. in the standard case, one cell has a horizontal dimension of 2% (100 / 50) and a vertical dimension of 3.3% (100 / 30).

Positioning is achieved as follows:

1. Region type "Safe Area"

In this mode, Wincaps Q4 always creates regions that have the full dimensions of the safe area (i.e. 40 by 24) and uses tts:textAlign, tts:multiRowAlign and tts:displayAlign attributes to position the subtitle text within the regions. This gives accurate results when subtitles are standard positioned and justified in Wincaps Q4 (i.e. one of left/centre/right horizontal position, one of left/centre/right justification and one of top/middle/bottom vertical position).

IMPORTANT: Note that subtitles with non-standard horizontal positions will not be positioned accurately in the export. Such subtitles will be assigned a style in which tts:textAlign is not specified. Furthermore, subtitles with non-standard justification will be assigned a style in which tts:multiRowAlign is set to "start". Subtitles with non-standard vertical positions will be assigned a region whose tts:displayAlign most closely matches the subtitle position (i.e. top/middle/bottom).

IMPORTANT: If the subtitle text is split (i.e. separated by one or more blank rows) then the separating rows will NOT be taken into account in the export, i.e. the exported subtitle text won't be split.

2. Region type "Subtitle"

This mode can give more accurate results where subtitles have non-standard horizontal and/or vertical positions.

Where subtitles are standard horizontal positioned and justified in Wincaps Q4, the export will use regions that have tts:extent set to the full width of the safe area (i.e. 40c or 80%) and height corresponding to the number of subtitle rows. tts:textAlign and tts:multiRowAlign attributes are used to align the subtitle text within
the region. tts:origin is used to position each region at the required vertical row position.

For subtitles that have **other positions** but are still left/centre/right justified, the export will use a region that has positions and dimensions corresponding to the subtitle’s position and size as shown in the Wincaps Q4 status bar. tts:multiRowAlign is set appropriately for the subtitle text. tts:textAlign is not specified.

**IMPORTANT:** For scattered subtitles (i.e. those that have non-standard position and justification settings), the export will use a region as described above. However, the export is currently unable to position the individual rows correctly. Instead, tts:multiRowAlign is simply set to "start" and tts:textAlign is undefined.

**IMPORTANT:** If the subtitle text is **split** (i.e. separated by one or more blank rows) then the separating rows will NOT be taken into account in the export, i.e. the exported subtitle text won’t be split.

**Notes on positioning of Open Caption subtitles:**

When exporting Open Caption subtitles, you should select either **Pixel** or **Percentage** units in the export configuration dialog.

Positioning is achieved in a similar way as described above for Teletext subtitles and the same limitations apply with respect to the positioning of split and scattered subtitles.

**Examples**

1: Export of a Teletext file using "Cell" units and "Safe Area" regions.
Video standards conversion

This operation changes all subtitle timecodes to their equivalent values at a different frame rate, based on a pair of user-specified reference frames. The file Personality is changed to match the new frame rate. This facility is useful in situations where a subtitle file has already been generated and timed against one particular media format and the same programme then requires re-timing for broadcast under a different standard.

In order to use this facility you will need the following:

A matching pair of media files for source and target standards, e.g. one PAL and one NTSC Drop
A completed subtitle file that has been timed against the source media and is still associated with the source media

The procedure for converting the video standard is as follows.

Open the source subtitle file and save it with a new name. This will eventually become the re-timed file.
Find a frame near the start of the file and make a note of the timecode. An unambiguous shot-change is a good choice.
Similarly, find a frame near the end of the file and make a note of the timecode.
Use the Media Wizard to disassociate the source media and associate the target media, indexing the target media if necessary.
Locate the exact corresponding start and end frames in the target media and make a note of their timecodes.
You are now ready to run the conversion.
Click the PAL/NTSC Conversion button in the File Info pane of the Toolbox.

The following dialog is displayed:

![Convert Video Standard dialog]

- **Convert to:**
  - Standard Definition
  - PAL

- **FIRST shot change**
  - Enter the timecode of the FIRST shot change in the source video: 00:00:00:00
  - Enter the timecode of the corresponding shot change in the target video: 00:00:00:00

- **LAST shot change**
  - Enter the timecode of the LAST shot change in the source video: 00:00:00:00
  - Enter the timecode of the corresponding shot change in the target video: 00:00:00:00
Select the target media standard from the drop-down lists. Enter the four timecodes you noted down earlier into the corresponding fields in the dialog, for example:

Click **OK** to convert all timecodes in the file to the new standard. Wincaps Q4 will automatically change the file personality to the new standard.

You can use Replay Mode to check that the conversion was successful. Replay a section of video at the start, middle and end of the media file and check that the subtitles have been re-timed correctly for the new media.

**Text splitting concepts**

**Rules text files**

Wincaps Q4 is supplied with a set of sample text (.txt) files containing rules for the way text should be split under certain conditions. Those conditions are specified in the files.

You can use the sample files provided with the installer to implement basic automatic text splitting for the English language. To configure text splitting for other languages you should create another set of .txt files as appropriate and import them into the DataStore with the corresponding language is active.

A decision to split text can be based on linguistic data associated with grammar or parts of speech, punctuation or the amount of text present. For example, a phrase such as "Man of War" can be specified to be kept together. Splits can be specified to occur towards the middle of a second line of text, potentially reducing the likelihood of an orphaned word following the split. Splits before conjunctions can be favoured and splits following prepositions can be discouraged.

There are four categories of text-splitting rules files, namely:
Word-type files: these specify the grammatical classes of key words

Boundary weights files: these specify the splitting weights used by different word classes

Punctuation weights files: these specify the weightings before and after punctuation

Word-type files

These files each identify a grammatical class of words or phrases that should not be split. The file name conforms to the format TYPEc.txt, where c can be A, B, C, D...Y. Note that Z is not permitted. Thus, a file named TYPEA.txt can be created to contain common multi-word phrases that should not be split. The content of the file is a list and may contain entries as follows:

;TYPEA - Multi-word phrases
    that he
    that she
    that it

Similarly, a TYPEB.txt file can be created to contain articles, as:

;TYPEB - Articles
    a
    an
    the

Additional types can be set up to specify conjunctions, prepositions, compound proper names (Houses of Parliament, Prime Minister etc.).

Boundary weights file

The Boundary weights file is a single file named BOUNDING.txt. This file contains a list of three values for each type file that is defined and a system-related TYPEZ file which is reserved for words that only contain digits. The BOUNDING file contains weighting rules that are defined by values in the range 0 - 9. The higher the weighting at a given inter-word space, the more likely the subtitle is to be split at that point. Each word type is assigned three weights:

before the word: the weight contributed by that word to the space before it
compound: the weight attributed to the spaces within a compound phrase
after the word: the weight contributed by that word to the space after it

Thus, in the case of our TYPEB example (shown above), weightings can be specified to minimise the likelihood of a split occurring after an article and increase the probability of a split being placed before it. A weighting rule might then be defined as 8,0,2 - where 8 is the weight for "before the word", 0 is the weight for compound (no rule required as the article is not part of a compound phrase) and 2 is the weight assigned for "after the word". This would appear in a BOUNDING.txt file as follows:

;Boundary Weights
B 8,0,2

The neutral weight is 4, and a word not appearing in any file (or appearing in more than one and not being resolved) will be given the neutral weighting. Spaces which have a weighting average below 4 are less likely to be selected as the point at which
the subtitle will be split.

**Punctuation weights file**

The PUNCTWGT.txt file contains weightings for punctuation characters. Each line in this file has the format:

ASCII code : is the ASCII character code of the punctuation character  
before : is the weight when it appears as leading punctuation  
after : is the weight when it appears as trailing punctuation

The value -1 for either a "before" or "after" weight means "not applicable" and forces the punctuation to be either trailing or leading (not both) when the text is scrutinised by the application.

Note that the full-stop, question mark and exclamation mark do not need to be defined with any weights as these have already been pre-defined within the application to represent the end of a sentence, that terminates any subtitle.

The following image exemplifies the use of text-splitting rules related to punctuation weights:

![Subtitle break splitting parameters](image)

The subtitle text is too long for a two line subtitle. The comma, open bracket and close bracket all have an influence on where the subtitle should be split. In this case the highest weighting value in the text occurred after the close bracket punctuation (when also multiplying the average weight by the subtitle split parameters). So the split occurs after the closing bracket in this example.
Text splitting reference

Subtitle splitting geometry

When deciding where best to split a subtitle, it is not sufficient only to work on the basis of grammatical weights. The geometry needs to be considered, too. In a two-line buffer, for example, it is best to favour a split somewhere in the middle of the second line, rather than to choose the best word weight from the entire buffer. This avoids splitting off short fragments at either end and keeps the flow of text even. Suitable geometric weights therefore need to be specified in order to make sure a subtitle will be split at the optimum place.

These parameters are entered in the Splitting dialog, comprising a series of comma-separated numbers in the range 1 - 10 for the curve you wish to develop.

More points than those illustrated (above) can be entered to create a smoother curve if required. When analysing the subtitle, the curve will multiply the weight for the available text.

In Wincaps Q4 the splitting files (e.g. the TYPE and WEIGHT files) are held in the DataStore, hence the splitting directory path name is not used.

In the **Subtitle break** and **Format break** sections, the enable check boxes are used to activate the subtitle splitting weightings parameters. The subtitle break applies to
the weighting of the boundary values within the two-line buffer. The format break applies to the weighting of the values within the split-off text.

A curve pattern specified by 1,2,2,3,3,3,2,2,1 influences the splitting decision so that the subtitle split is more likely to occur somewhere near the middle of the subtitle rather than near to the beginning. This also helps minimise the situation where using the weightings specified in the weights file only may cause an undesirable split to be made after the first word of a 2-line subtitle.

Calculating weightings

To work out final weightings after/before each word within a sentence, the system averages the "after" weight of the previous word and the "before" weight of the next word. It then multiplies this figure by a parameter specified by the user in the Curve weights section of the dialog.

The curve weights in the subtitle break effectively split the subtitle buffer into a number of zones - as many zones as weight values, each zone having the corresponding weight. The average inter-word weight is then multiplied by the zone weight to give a resultant weight.

For example, consider the text "The mercenaries insisted Mr. Cook had issued a licence allowing UN Sanctions to be...".

This sentence is too long to fit in the subtitle and Wincaps Q4 must decide where to split the text based on defined rules. Assume the Subtitle break curve weights have been set up to be 1,2,3,3,2,1; words "the" and "a" are specified in TYPEB.txt "articles" file (See Text splitting concepts) and this file has a Type weighting of 9,0,0, and that all other words have neutral weightings as they are not specified in any of the other type files.

Now, Wincaps Q4 uses the final weighting values on which to base its decision for where to split the subtitle.
In the above diagram, the highest weighting occurs between the words "issued" & "a". The way the weighting is calculated is as follows:

1. Add trailing weight of previous word to leading weight of next word: $4 + 9 = 13$
2. Find average of weights: $13 / 2 = 6.5$
3. Multiply the average weight by the parameter for that section of the subtitle: $6.5 \times 3 = 19.5$

The subtitle is split after the word "issued", giving a reasonable split based on grammar and geometry.

**Format break**

The format break tells Qu4ntum how to format the subtitle after the split location has been determined by the subtitle break. If the format break is not enabled, the system will not re-format the subtitle, but simply split it according to the subtitle break weightings and rules.

In summary, the two curves (subtitle and format) modify the syntactic weights as specified in the weights and type files, before the subtitle-break and line-break decisions are made. By an appropriate choice of grammar files and curves, sensitive context-dependent splitting decisions can be made, giving good results in the majority of cases.
Configuration

Microsoft Office for spell check

Wincaps Q4 uses MSOffice to perform the spelling check. Consequently the Wincaps Q4 spelling check will be disabled if:

- MSOffice is not installed
- MSOffice is installed but no lexicons are installed for the current file language

In order for spell checking to work, Wincaps Q4 must have a supported version of MSWord or MSOffice installed. The following versions have been tested and are known to work:

- Word 2000
- Office 2003
- Office 2007
- Office 2010

Note that when installing MSWord from the Office installer, you also need to install the "Office Tools" component.

For languages other than English to work, the relevant MSOffice/MSWord lexicons must be installed on the client machine. These are normally provided as a separate add-on e.g. for Office 2007 the "Office Multi-Language Pack" is required.

The behaviour of the Wincaps Q4 spell check is dependant on the following spelling options configured in MSWord:

- Ignore words in UPPERCASE
- Ignore words that contain numbers
- Ignore internet and file addresses
- Suggest from main dictionary only
- Flag repeated words

You should configure these settings as desired in MSWord and Wincaps Q4 will use them. Note that it is not possible to configure these settings from within Wincaps Q4 itself.

The Wincaps Q4 spell check uses the standard MSWord spelling dictionaries. Wincaps Q4 will also use any active MSWord custom dictionaries, though there is no facility to add words to these dictionaries from within Wincaps Q4.

Note that MSWord stores configuration settings on a per-user basis, so Wincaps Q4’s spelling behaviour will depend on how the active user has configured MSWord on any particular workstation.
Homophones list

This topic describes how to configure the homophone list for each language. Homophones lists are used by the homophones check to identify words that sound alike but have different spelling.

**The homophone lists are held globally in the main DataStore. Any changes made to them will affect all users of the system.**

A homophone list is configured by importing a file into the DataStore.

Use the following steps to import a homophone list. This only needs to be done once for each language unless you choose to make subsequent changes to a list, at which point you will need to re-import it.

Prepare a text file (see below for the format) containing the list of homophones for the target language and locate it in a folder that is accessible to Wincaps Q4.

Start Wincaps Q4, open a subtitle file and change the language to the language for which you want to import the homophone list.

In the Toolbox->Job Info pane, click the Homophones->Import button.

Browse to the folder in step 1 and click OK.

Wincaps Q4 will import the homophone list.

An "Import Successful" message will be displayed.

The above steps should be repeated for each different language. If no homophone list has been imported for a language then the homophones check will be disabled when you open a file in that language.

Once it has been imported into the DataStore, you cannot view or edit a homophone list directly. To edit it, you will first need to export it to a disk folder using the Homophones->Export button. After making your changes, you can re-import it using the same process as described above.

Homophone list format

A homophone list takes the form of a unicode text file. Each Set of matching words should be placed on a new line and separated by commas as shown in the example below:

accessary, accessory
ad, add
ail, ale
air, heir
...

Duplicate entries

A homophone list should not contain duplicate words as this can lead to confusion. If duplicate words do exist in a particular homophone list, Qu4ntum will display a warning in the message window each time that list is loaded, e.g.

(2): Homophone import warning: merging duplicate entries 'beau, bow' - 'bough, bow'
(2): Homophone import warning: merging duplicate entries 'maw, more' - 'moor, more'
(2): Homophone import warning: merging duplicate entries 'read, reed' - 'read, red'

To correct this problem you need to edit the appropriate homophone list file to remove the duplicates and re-import it.
Default File Colours

This topic describes how to configure the default foreground and background colours for the current file. You can override these defaults and change the colours of individual words or subtitles within the file by using the colour toolbar or colour control keystrokes.

For a Wincaps Q4 (W32) file, the default colours are normally determined by the customer template used when the file is created and should not normally need to be changed. If no colours are defined in the template, Wincaps Q4 defaults to "white" on "black".

To configure the default colours, click the Colour button in the Subtitle defaults & preferences section of the Toolbox->File Info tab.

The File Default Colours dialog appears as shown below:

![File Default Colours dialog](image)

Select the desired colours from the drop-down lists. The choice of available colours for foreground text and background surround will vary depending on the subtitle personality.

Open-Captioning offers an extensive colour palette. Teletext provides for only 8 (black, white, red, blue, yellow, green, cyan and magenta) while the Closed Caption standard allows only 7 text colours (white, red, blue, yellow, green, cyan and magenta) that are always displayed against a black box background.

Note that for Open Caption files you will need to specify a background effect so that the selected background colour can be seen.
Text splitting

This topic describes how to configure the text splitting files.

The text splitting files are held globally in the main DataStore. Any changes made to them will affect all users of the system.

Intelligent text splitting is configured by importing a set of special files into the DataStore. Wincaps Q4 allows you to configure the text splitting differently for each language, hence you will need to import a set of splitting files for each language you plan to subtitle in. If you don't import any splitting files for a particular language, intelligent text splitting will not be enabled for that language.

Wincaps Q4 is supplied with a set of default text splitting files which are suitable for general English use. To customise the text splitting for other languages, you should take a copy of these files and modify them according to the guidelines detailed here.

Use the following steps to import and configure the text splitting files. This only needs to be done once for each language unless you choose to make subsequent changes to the files, at which point you will need to re-import them.

Prepare a suitable set of text splitting files for the target language and locate them in a folder that is accessible to Wincaps Q4.

Start Wincaps Q4, open a subtitle file and change the language to the language for which you want to configure text splitting.

In the Toolbox->Job Info pane, click the Text Splitting->Import button.

Browse to the folder in step 1 and click OK.

Wincaps Q4 will import the text splitting files, displaying a progress bar.

An "Import Successful" message will be displayed.

Click the Text Splitting->Configure button and configure the curves and weights as described here.

The text splitting files have now been imported and configured successfully for the chosen language.

The above steps should be repeated for each different language you wish to subtitle in.

Once they have been imported into the DataStore, you cannot view or edit the text splitting files directly. To edit them, you will first need to export them to a disk folder using the Text Splitting->Export button. After making your changes, you can re-import them using the same process as described above.

If the text splitting files have not yet been imported for a particular language, the Text Splitting->Configure button will be disabled.
Spelling supplements

Spelling supplements (also known as lexicons or word lists) are used when you run a spell check. They store unusual or specialised words not found in the standard dictionaries. Wincaps Q4 stores these supplements in the DataStore where they are accessible to all users of the system in a multi-user environment.

There are two types of spelling supplement:

- **Global** - Active for all programmes
- **Programme** - Active only for the currently selected programme

In addition, Wincaps Q4 maintains a global spelling **Exclusion List**. Any words in this list will always be flagged by a spell check and cannot be ignored or added to one of the spelling supplements.

Wincaps Q4 maintains separate spelling supplements and exclusion lists for each language.

You normally add new words to a spelling supplement during the course of a spell check. Whenever an unrecognised word is found, Wincaps Q4 gives you the option of adding it to one of the spelling supplements for the current language.

Spelling supplements are managed via the Job Info pane of the Toolbox.

Click on the **Global** or **Programme** button to display the corresponding **Spelling Supplement dialog** where you can add, delete, edit, import and export the word lists. Note that Wincaps Q4 will load the word lists corresponding to the currently selected language and programme for the currently open subtitle file. If no file is open or if no programme has been assigned then the buttons will be disabled.

If you choose to view a spelling supplement, the system will lock that topic in the Main DataStore to prevent other users from modifying it at the same time. Consequently, you should keep your edits as short as possible. If you try to view a topic that is currently locked by another user, the window will open in **read-only mode** and the title bar will display that user's login name.

Spelling Supplement dialog

The Spelling Supplement dialog allows you to manage the contents of a word list.
The words are displayed alphabetically. The buttons work as follows:

**OK** - Save any changes you have made. If you deleted any words from the list, Wincaps Q4 will display a confirmation message

**Cancel** - discard any changes you made

**Import** - Import a new word list from an external text file. Wincaps Q4 will prompt you for the name of the file to import. Note that any existing words will be lost and replaced by the new ones

**Export** - Export the word list to an external text file. Wincaps Q4 will prompt you for the name of the file to create, which will default to a .txt extension

**New** - Add a new word

**Edit** - Modify the currently selected word

**Delete** - Delete the currently selected word

**Clear** - Delete all words from the list

**File personality**

This topic describes how to set the **personality** of the current subtitle file and configure the various options for each personality.

For a Wincaps Q4 (W32) file, the personality is normally determined by the customer template used when the file is created and should not normally need to be changed. Note that changing the personality of a file may cause existing subtitles to be reformatted and their parameters changed to comply with the requirements of the new personality.
To configure the personality, click the **Personality** button in the File Properties section of the Toolbox->File Info tab.

The **File Personality** dialog is displayed as shown below:

![File Personality dialog](image)

**Subtitle type** - choose the personality type from the available options
- Teletext
- Closed Caption
- Open Caption

**Definition** - specifies whether the output is for *Standard Definition (SD)* (720 pixels wide for the PAL and NTSC standards) or *High Definition (HD)* (1280 or 1920 pixels wide for the 720 and 1080 standards respectively)

**Video Standard** - *(SD only)* specifies the SD broadcast video standard, either 625 line PAL or 525 line NTSC (equivalent to 720 x 576 pixels and 720 x 480 pixels respectively). Both NTSC drop-frame and non-drop-frame are supported.

**HD Type** - *(HD only)* specifies the scanning regime for HD:
- Interlaced (I) *(SD is always Interlaced)*
- Progressive (P)
- Progressive segmented Frame (PsF)

**Aspect Ratio** - specifies the screen presentation for HD or SD:
- 4:3 - traditional TV broadcast *(SD only)*
- 16:9 - widescreen TV *(SD only)*
- 1280x720 - the “720” specification *(HD only)*
- 1920x1080 - the “1080” specification *(HD only)*

**Frame Rate** - specifies the video speed for HD or SD

**Enable Open Caption subtitles** - if the subtitle type is *Teletext* then checking this box will allow you to create Open Caption subtitles in a Teletext file

Configure Teletext personality options

This dialog lets you configure options specific to Teletext personality files. The options are designed to help overcome variations in (a) the practices of different
broadcasters, (b) Teletext transmission systems and (c) Teletext decoders in TV sets.
Teletext subtitles in Wincaps Q4 always feature a double height command code character (unless single height rows are specified) and two start box characters at the beginning of each row plus (by default) a white text colour code. Teletext has a maximum line length of 40 characters including control codes, giving a typical maximum row length of 36 characters for Teletext subtitles (white/colour on black).

Control codes that count as one character each include: double height, single height, colour (text), start box, end box. To change background colour generally needs three control codes: colour (background), new background, colour (text).

**File Personality**

- **Force a white colour code at the start of row** - inserts a white (foreground) colour code at the start of each row of white text even though the Teletext standard assumes that all text is white unless specified otherwise. With this set on (the default), subtitle rows should always align neatly with each other regardless of the colour of the text. Turning this option off allows 1 extra character to be used on rows of white text. However it can also cause a row of white text to appear one character to the left of coloured text.

- **Always show a single end box** - ensures that an end box character is used on every row even though the Teletext standard assumes that any box ends at the end of the row unless an end box appears before that. Turning this option on (default is off) effectively reduces by one the maximum number of characters available for text.

- **Do not allow packet 26 characters** - restricts the character check to the characters native to the defined Teletext language set, disallowing the additional accents and special characters (such as the € symbol) made available by using Packet 26 encoding. Some broadcasters prefer to avoid such characters (the default setting permits their use), possibly because they may not be supported in all decoders or because their use can slow down the transmission and refresh rates of Teletext.

- **Disable add-ons** - subtitles that do not automatically clear the previous one (i.e., add-on subtitles) may be improperly displayed by some decoders. Therefore some broadcasters may wish to avoid using add-ons (the default setting permits their use).
Calculate add-on reading rates... - with this option unchecked, Wincaps Q4 calculates the overall reading rate of add-on subtitles based on the text and duration of the base subtitle plus any add-ons. With this option checked, Wincaps Q4 calculates the reading rate separately for each part of the add-on subtitle.

Single height rows - removes the double height character at the start of each row, favoured in some countries such as Germany. Note that it is not possible to have single height and double height text within the same file.

Force single height code... - ensures that a single height character is used on every row (even though the Teletext standard assumes single height text without a double height character). Turning this option off (default is on) effectively increases by one the maximum number of characters available for text.

Settings and data file locations

This article describes where Wincaps Q4’s various configuration settings and data files are stored. These files are created and maintained automatically by Wincaps Q4 and should not be edited or changed manually under normal circumstances.

You must enable the "show hidden files and folders" option and disable the "hide protected operating system files" option in the Windows Explorer in order to see these files and folders.

User-specific files

Each user of Wincaps Q4 has their own personal set of user configuration files that will follow them around if roaming profiles are used.

The files are located in different places depending on the host operating system.

For Vista/Windows 7:

C:\Users\<USERNAME>\AppData\Roaming\SysMedia

The files have the following functions:

datastore.sdf - the DataStore local cache file
datastoreclient.config - (for system use only)
QuantumUser.ini - user settings file (stores user preferences between sessions)

The Wincaps Q4 subfolder contains the following additional files:

AppProperties.dat - screen layout information
MRUList.txt - most recently opened files list
RecentTranslations.txt - most recently opened translation files list

Workstation-specific files

Settings that apply to the workstation (regardless of user) are stored here:

For Vista/Windows 7:

C:\ProgramData\SysMedia
The workstation-specific settings files are as follows:

- **QuantumLocal.ini** - machine-specific preferences
- **QuantumDataLocal.ini** - stenograph configuration preferences
- **DigiSuiteEffect.ini** - boxing export preferences
- **HiddenRunes.ini** - (for system use only)

Wincaps Q4 uses the following registry setting to obtain the location of the main DataStore:

```
\HKEY_LOCAL_MACHINE\SOFTWARE\SysMedia\DataStore\DataStoreURL
```

This string item contains the URL of the main DataStore web service, e.g.

http://servername/WC4DataStoreService

If the string is left blank or the registry item is omitted entirely, Wincaps Q4 will run in standalone DataStore mode using only the local DataStore cache.

## Export

### Boxing

This topic describes how to configure options for exporting subtitles in certain image-based formats. These options allow you to customise the appearance of the rendered images in various ways.

These settings are accessed via Toolbox->Configure->Customer : Export->Boxing

Currently, the boxing settings apply to the following export formats:

**NLE Final Cut Pro** - this format consists of a set of tif or png images (one per subtitle) plus an XML control file.

![Note that unlike the other Configure Export settings which are stored per-customer, the Boxing settings are stored per-workstation and are global to all users of a particular workstation.](note)

The options allow you to configure the appearance of the images as described below:
Sets the degree of transparency of the subtitle text.

These settings allow you to display a background box around the subtitle text.

An **Effect type** of 'None' selects no boxing, otherwise a box in the chosen style will be displayed. The boxing colour can be selected from the drop-down list.  
**Semi-Transparency** : Sets the transparency level of the background box.
**Extra Spacing...** : Allows the background box to be extended further to the left and right edges of the subtitle text

Use these settings to fine-tune the position of the subtitles.

Use these settings to fine-tune the quality, thickness, brightness and contrast of the subtitle text.
DLP Cinema

This topic describes how to configure the options for exporting subtitles in DLP Cinema format. This is an XML-based format originally designed by Texas Instruments.

These settings are accessed via Toolbox->Configure->Customer: Export->DLP Cinema

Consult the Texas Instruments document *Subtitle Specification (XML File Format) for DLP Cinema Projection Technology* for further information on these setting.

The export options are configured as follows:

This dialog controls the vertical positioning settings.
This dialog controls the timing information. The values of "TimeIn" and "TimeOut" in the exported file will be modified accordingly.

**Fade Up**: Determines the value of the "FadeUpTime" tags in the exported data

**Fade Down**: Determines the value of the "FadeDownTime" tags in the exported data
DVD Builder

This section describes how to configure Wincaps Q4 to export subtitle jobs to the DVD Builder.

These settings are accessed via Toolbox->Configure->Customer : Export->DVD Builder

**Note that unlike the other Configure Export settings which are stored per-customer, the DVD Builder settings are stored per-workstation and are global to all users of a particular workstation. The user needs write access to the HKEY_LOCAL_MACHINE area of the registry in order to change these settings.**

The following dialog is displayed:

![Configure Job File Creation dialog]

**Output directory** : The default folder where the DVD Builder will generate the images and control files for each job. This default path can be overridden if desired at the point where an export is performed.

**Formats directory** : The folder where the DVD Builder format (.dv) files are stored. Wincaps Q4 reads the contents of this folder when an export is performed in order to generate the list of available DVD formats.

**Job files root directory** : The folder where Wincaps Q4 places the exported job files for processing by the DVD Builder.

Note that in a multi user system these folders will be shared between the DVD Builder(s) and the Wincaps Q4 client workstations. Hence they should be located on a network share and permissions should exist to allow read/write access to all clients and DVD Builders.

Refer to the *DVD Builder Handbook* for more information about these settings.
This topic describes the options for exporting subtitles in the EBU file format. These settings can be used to make exports compatible with third-party EBU implementations.

These settings are accessed via Toolbox->Configure->Customer : Export->EBU.

A multi-tabbed dialog is displayed with the following sections:

![EBU Export Options](image)

This tab configures the export options for Open Caption files. The Default button can be used to quickly restore the default settings.

**Maximum number of vertical rows**: This information is stored in the GSI and can be numbered from 1 - 100 and specify the vertical height of the screen. The default is 24 which represents the number of vertical lines for Teletext output due to the fact that not all systems and devices can read the GSI information.

**Maximum row length in characters**: Any characters that exceed this length will be deleted from the end of the line, NOT word-wrapped to the next line.

**Treat rows as double height**: A blank line will be added after each line of a subtitle.

**Insert spaces with control codes**: Spaces will be inserted after EBU control codes for colour and positioning: this may result in double spaces between words if multiple colours are used in a subtitle.

Note: Accented characters are counted as two characters in Open Caption. A line of text with accented characters may therefore exceed the limit set although the file looks correct.
This tab configures the export options for languages with special requirements. The **Default** button can be used to quickly restore the default settings.

**Right to left ordering for Arabic/Hebrew**: The default setting uses left to right ordering, check this box to enable right to left ordering instead.

**Use Arabic numbers**: The default setting uses latin numbers, check this box to enable Arabic numbers instead.

This tab configures how the EBU Justification Flag should be set in the exported file.

**Zero**: Always set the flag to 0 and use spaces to align the subtitles

**Justification**: Flag indicates justification (default)

**Position**: Flag indicates position
FCP

This topic describes how to configure the options for exporting subtitles in the NLE Final Cut Pro format. This format consists of a set of images (one per subtitle) plus an XML control file.

These settings are accessed via Toolbox->Configure->Customer : Export->FCP

A dialog is displayed as shown below:

Image File Type: Select the format of the image files (tif or png) from the drop-down list.

Note that the boxing export settings can also be used to customise the appearance of the image files

MCA

This topic describes the options for exporting US Closed Caption data to .mca format files for Panasonic/Matsushita DVD authoring systems.

These settings are accessed via Toolbox->Configure->Customer : Export->MCA

Consult the authoring system documentation for more specific information on these options.

SAMI
This topic describes how to configure the options for exporting subtitles in **Formatted File** and **Selected Video** SAMI formats. SAMI (Synchronized Accessible Media Interchange) is a structured markup language designed by Microsoft to simplify creating captions for media playback on a PC.

These options do not affect the output of the **Unformatted File** SAMI export.

Note that an exported SMI file will be created in the same folder as its associated media.

These settings are accessed via Toolbox->Configure->Customer : Export->SAMI

Consult the SAMI specification for full details of the SAMI file format.

The export options are configured as follows:

With **Enable vertical formatting...** checked, `<BR>` codes will be used to pad the text to fit the chosen **Number of Vertical Rows**. For example, with the number of rows set to 4, a bottom-aligned single-row subtitle would look like this:

```
<SYNC START="0">
<P CLASS=".GBCC"><BR><BR><BR>Subtitle1.</P>
</SYNC>
```

With **Enable vertical formatting...** unchecked, the export does not include any vertical formatting information.

```
<SYNC START="0">
<P CLASS=".GBCC">Subtitle1.</P>
</SYNC>
```

The chosen **Font Size** is used to set the font-size attribute in the SAMI style definition as shown below. This overrides the choice of font size in the subtitle file.

```
<STYLE TYPE="text/css">
<l--
Configure the foreground colour of the exported subtitles. Either use the colours from the subtitle file or else select a single fixed colour that all the subtitles will use.
These settings are used to set the margin attributes in the SAMI style definition as shown below.

```xml
<STYLE TYPE="text/css">
<!--
P {
margin-left: 8pt;
margin-right: 8pt;
margin-bottom: 2pt;
margin-top: 10pt;
text-align: center;
font-size: 12pt;
font-family: Arial, sans-serif;
font-weight: normal;
color: #ff0000;
}
.GBCC {Name: English; lang: en-GB; SAMI_Type: CC; }
--></STYLE>
```

Configure the horizontal positioning of the exported subtitles. Either use the positioning information from the subtitle file or else select a single position left/centre/right that all the subtitles will use.
Text

This topic describes how to configure the export options for the following formats:

Text -> Plain text
Text -> Timecoded
SRT

These settings are accessed via Toolbox->Configure->Customer : Export->Text

The export options are configured as follows:

Encoding: Choose the desired character encoding scheme from the drop-down list:

- ANSI no BOM (Byte Order Marker)
- UCS-2 Little Endian with BOM
- UCS-2 Big Endian with BOM
- UTF-8 with BOM
- UTF-8 no BOM

The first option uses the ANSI code page corresponding to the language of the file, the other four are Unicode variants. The default setting is UTF-8 with BOM.

Note that earlier versions of Wincaps Q4 gave the choice of "ANSI" or "Unicode". "ANSI" is the equivalent of "ANSI no BOM" and "Unicode" is the equivalent of "UCS-2 Little Endian with BOM".
DFXP

This topic describes how to configure the options for exporting subtitles in the Timed Text Markup Language (TTML) format, created by the W3C. This format is also known as DFXP.

These settings are accessed via Toolbox->Configure->Customer : Export->DFXP

The export options are configured as follows:

**Timecode formatting:**

These options allow you to configure how timecodes appear in the XML output as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Format</th>
<th>Fraction</th>
<th>Sample Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock (HH:MM:SS:FF) Fraction (HH:MM:SS.000)</td>
<td>2</td>
<td>begin=&quot;00:00:00.00&quot;</td>
<td></td>
</tr>
<tr>
<td>Frame (HH:MM:SS.FF)</td>
<td>n/a</td>
<td>begin=&quot;00:00:00.000ms&quot;</td>
<td></td>
</tr>
<tr>
<td>Offset (SSSS.000)</td>
<td>Default (none)</td>
<td>2</td>
<td>begin=&quot;0.00&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>begin=&quot;0.000s&quot;</td>
</tr>
<tr>
<td>Seconds</td>
<td>2</td>
<td>begin=&quot;0.00s&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>begin=&quot;0.000s&quot;</td>
<td></td>
</tr>
<tr>
<td>Millis</td>
<td>n/a</td>
<td>begin=&quot;0ms&quot;</td>
<td></td>
</tr>
<tr>
<td>Frames</td>
<td>n/a</td>
<td>begin=&quot;0f&quot;</td>
<td></td>
</tr>
<tr>
<td>Ticks</td>
<td>n/a</td>
<td>begin=&quot;0t&quot;</td>
<td></td>
</tr>
</tbody>
</table>

**Additional Settings:**

These options allow you to configure other aspects of the exported file.

**File Extension** - specify an alternative default file extension for the exported file

**Force positioning to use percentages** - if unticked, region positioning is specified in pixels. If ticked, region positioning is specified using percentages.

**Netflix:**

These options are designed to match the requirements for Netflix.

**Remove 'tt:' prefix from attributes** - if ticked this removes all the 'tt:' prefixes to match the Netflix interpretation of the spec. This setting is not ticked by default.
Ultech DV3000

This topic describes the options for exporting subtitles in the Ultech DV3000 .uyc format.

These settings are accessed via Toolbox->Configure->Customer : Export->Ultech DV3000

This export creates a control file (\<filename>.usf) plus one or more subtitle image files (\<nnnnn><xxx>.uyc) where <filename> is the name of the Wincaps Q4 file, <nnnnn> is the first five characters of <filename> and <xxx> is the subtitle number (1-999).

Base path for output files: The root folder where the exported file will be created. This folder must exist or an error will be reported when you run the export.
Create an extra directory using the file name: If checked, an additional subfolder will be created to contain the exported files else the files will be created in the root folder.
Clear old images when exporting: If checked, clear all existing file in the export target folder before performing the export.
Zip exported files: If checked, automatically create a zip file to contain the export.
This dialog allows you to choose the background colour for the subtitle image files.

**Ultech L21**

This topic describes the options for exporting subtitles in the .ult format for Closed Caption encoders and subtitle generators.

These settings are accessed via Toolbox->Configure->Customer : Export->Ultech L21

The chosen values should correspond with those set on the target equipment – consult the Ultech documentation for further information.

The **Default** button can be used to quickly restore the default settings.
Import

PAC

This setting is used when importing a PAC file into an open Wincaps Q4 file. This setting is off by default.

When this option is enabled, if the 'Remove first subtitle' option is not ticked, then the Subtitle Zero information will be displayed as the first subtitle in the List, Timeline and Compact view.

NB: If there are no settings in the GSI for Subtitle Zero then Wincaps Q4 will automatically add 'Story' and 'Lang' information to the PAC file on export.
Text

These settings are used when importing or inserting unformatted (raw) text files into Wincaps Q4.

![Import options](image)

The settings are used to control how many rows of text each subtitle will contain and the maximum length of the text on each row.

The Remove Extra Spaces option is on by default and will strip any extra spaces when importing a Text File. If the option is disabled then extra spaces will be imported when Importing into a file that is open. Disabling this option will not work using File>Open and selecting a Text file.

Print options

This topic describes the various options for printing subtitle files or stories. These include:

- Choice of default printing font or actual font used in the file (Open Caption subtitles)
- Printing an optional cover page
- Customisable page headers and footers
- Including colour codes and other indicators (e.g. Add-On markers) in the printout
- Including GSI information in the printout

You configure the printing options by selecting File : Printing : Print Layout from the main menu or by clicking on the Printing button in the Toolbox->Configure tab.
You will see a multi-tabbed dialog. The option tabs are described in the sections below.

Print options are stored in the same way as the user settings, meaning that Wincaps Q4 will always remember your most recent preferences in a multi-workstation environment.

Print options tab

![Print options dialog](image)

Font options:
- **Use the font stored in the file** - enable this option to print subtitles in the actual font specified in File Properties->Font, otherwise the default printing font will be used (only applicable for Open Caption subtitles)
- **Use the font from the subtitle** - enable this option to print subtitles in the font specified for each subtitle. This selection is always linked to the one above so that the document font is used if no specific font attribute is set at the subtitle level
- **Show font styles** - enable this option to print subtitle text in the style (e.g. italics) applied to each word. This selection is always linked to the two above in order to use the matching subtitle font
- **Default Font** - allows you to configure the font to be used for printing files if **Use the font stored in the file** is not selected

Layout options:
- To print a **cover page**, or add a **header** or **footer** to each printed page, select the corresponding options and then go to the specific tabs to configure the required fields
- **Colour code** - enable this option to indicate colour codes in the printout by using letters. For example, ‘Y’ indicates yellow
- **Extra indicators** - enable this option to indicate Add-On subtitles in the printout with a ‘+’ sign
Print cover page tab

If you enable a cover page in the Print options tab, these settings allow you to define the text and layout of the cover page.

Enter the cover page text into the left-hand box. In addition, you can insert fields to display file and/or subtitler information contained in the General Subtitler Information (GSI) properties. To choose which fields to display, click on the Add Field... button to display the Insert object dialog as shown below:

These object fields relate to information stored in the GSI properties of the current subtitle file. If this information has not been set, then the resulting text in the printout will be blank.

The vertical position buttons allow you to control the vertical alignment of the cover-page text.
Show boxes enables the printing of a surround border
Font... allows you to select the font to use for the cover-page text

A preview of the current cover page layout is displayed in the right hand box.

Header tab

If you enable a header in the Print options tab, these settings allow you to define the text and layout of the page header.

Enter the header text into the top box. In addition, you can insert fields to display file and/or subtitler information contained in the General Subtitler Information (GSI) properties in the same way as described above for the cover page.

The Justify buttons allow you to control the justification of the header text
Show lines enables the printing of a horizontal line below the header text
Font... allows you to select the font used to print the header text

A preview of the current header layout is displayed in the lower box.
Footer tab

If you enable a footer in the Print options tab, these settings allow you to define the text and layout of the page footer.

Enter the footer text into the top box. You can insert fields to display file and/or subtitler information contained in the General Subtitler Information (GSI) properties in the same way as described above for the cover page.

The **Justify** buttons allow you to control the justification of the footer text. The **Show lines** enables the printing of a horizontal line above the footer text. The **Font...** allows you to select the font used to print the footer text.

A preview of the current footer layout is displayed in the lower box.
VPedal Video Controller

The VPedal is a third-party USB foot pedal that can be used for controlling the playback of digital media.

Further details on the VPedal can be found here at www.vpedal.com

To use the VPedal, simply plug it into a free USB port on the host workstation before you start Wincaps Q4/Q-Live. The VPedal uses the standard Windows joystick interface so no special drivers are needed.

When used in conjunction with Wincaps Q4 or Q-Live, the buttons on the VPedal can be used to mimic the following video control keystrokes:

<table>
<thead>
<tr>
<th>VPedal button</th>
<th>Wincaps Q4 Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play (middle)</td>
<td><strong>Numpad 5</strong> (play/pause)</td>
</tr>
<tr>
<td>Rewind (left)</td>
<td><strong>Numpad 4</strong> (rewind/frame-step back)</td>
</tr>
<tr>
<td>Fast forward (right)</td>
<td><strong>Numpad 6</strong> (fast-forward/frame-step forward)</td>
</tr>
</tbody>
</table>
Wincaps Q4 Professional tools

Speech input basics

Wincaps Q4 supports the use of third-party speech recognition technology such as Dragon NaturallySpeaking to input subtitle text.

Wincaps Q4 supports two speech input modes:

Respeaking via the SpeakTitle Window - this is the traditional entry mode and can be used with Dragon or other third-party speech engines
Respeaking via integrated Dragon input - this mode embeds the functionality of Dragon directly into Wincaps Q4

If Wincaps Q4 detects that a compatible version of Dragon is installed it will default to integrated Dragon mode though this can be changed via the Toolbox->Info->Configure->General->Speech options. If Dragon is not installed, only the SpeakTitle mode is available.

You can use special voice hash command macros (see below) to change foreground colours, perform editing functions or toggle markers.

House Styles may be activated during speech input. A house style is a phrase that is automatically replaced by another phrase. These can be very useful for correcting common errors in the speech recognition input.

Note that speech input will create text in whichever document is currently selected. You should therefore take care when using speech input with multiple documents open.
Hash commands (macros)
You can use special voice hash command macros to change foreground colours, perform editing functions or toggle markers. These hash commands are designed to function in both Edit Mode and Live Mode (Q-Live only) except where noted.

The following hash commands are available. Note that the commands are not case-sensitive, e.g. #ColourYellow and #colouryellow will both have the same effect. However, initial capitals are used below for better readability.

Change foreground colour:

#ColourWhite
#ColourYellow
#ColourCyan
#ColourGreen
#ColourMagenta
#ColourRed
#ColourBlue

Note that these colour changes will take effect immediately in Live mode, i.e. from the next word following the macro.

Numpad colour keys from using the keyboard colour keys which normally take effect
from the start of the next sentence when speech input is active.

Editing and output control:

#SendSubtitle - commit the current text buffer (same as Return)
#BackspaceWord - delete the last word from the buffer
#CapNext - capitalise the first letter of the next word (n.b. also cancels #CapsLockOn if currently in effect)
#CapsLockOn - capitalise all following words
#CapsLockOff - cancel the #CapsLockOn command
#RaiseSubtitle - raise the current subtitle (same as NumPad Enter)
#TopSubtitle - move the current subtitle to the top screen position
#BottomSubtitle - move the current subtitle to the bottom screen position
#NewLine - insert a line break (same as Shift Return).
#SendClear - clear the current subtitle text from air in Live Mode (Q-Live only)
#InsertBlankSubtitle - inserts a blank subtitle before the current subtitle, placing the focus in the blank subtitle.
#AppendBlankSubtitle - appends a blank subtitle after the subtitle with focus. Focus is then in the blank subtitle.

Notes:

1) In Live Mode (Q-Live only), #newline also forces a new row on the transmitted output in both block and word scroll transmission modes.

2) In Live Mode (Q-Live only), #RaiseSubtitle, #TopSubtitle and #BottomSubtitle control the Live Mode vertical position override rather than the vertical position stored in the file.

3) In Cue State (Q-Live only), #SendSubtitle will not send the text to air.

Markers:

#SectionStart - toggle section start marker for the current subtitle (Wincaps Q4 Pro only)
#SectionEnd - toggle section end marker for the current subtitle (Wincaps Q4 Pro only)
#SceneMarker - toggle scene marker for the current subtitle (Wincaps Q4 Pro only)

If you are using Dragon you can configure the Vocabulary Editor to access some or all of these macros as desired. An example of this is shown below:
So in this example, speaking the phrase "mac yellow" will change the text colour to yellow in Qu4ntum.

Colour With Speech
As stated before, Hash Command colour changes will take effect immediately in Live mode, i.e. from the next word following the macro.

In Live Mode in Q-Live or with Integrated Dragon and the Mic On in Offline, Numpad Colour Keys will change the colour after sentence ending punctuation, so the new sentence will begin with the selected colour. For example, if the current colour is white during speech and Numpad 8 (yellow) is pressed, the colour will continue to be white but the colour will change at the beginning of the new sentence.

Note: Re-speaking using the SpeakTitle Window in offline the colour commands are slightly different when the Mic is On. Numpad colour commands change the sentence and Shift+Numpad change the Subtitle. Colours can not be changed at sentence ending punctuation in Offline with SpeakTitle.

In Live mode with Scrolling subtitles (Scroll or Live Scroll, Cued Block) in Q-Live, Shift+Numpad Colour Keys will change the colour immediately.

In Live mode with Block subtitles in Q-Live, Shift+Numpad Colour Keys will change the colour of the Subtitle.

This is with Integrated Dragon and SpeakTitle input.
Configure Dragon Naturally Speaking

This topic describes how to configure Dragon NaturallySpeaking for use with Wincaps Q4.

These instructions apply to version 11.5 of Dragon NaturallySpeaking.

You should install Dragon and then create and train your voice profile in the normal way.

You should configure Dragon as follows before using it with Wincaps Q4:

**Tools : Options : Commands**

Disable all checkboxes
Configure a short pause before a command

**Tools : Options : Miscellaneous**

Speed vs Accuracy slider - configure to approx. 25% (i.e. favour speed over accuracy)

**Tools : Options : Data**

Save recorded dictation with document - set to "Never" or "Ask" as this could affect performance
Advanced options - ensure these are all disabled

**Tools : Options : Hot keys**

Clear the following hot keys as they clash with Qu4tum's keyboard shortcuts:
Microphone on/off
Correction
DragonBar menu
Microphone sleep/on

You should always select **Dictation Mode** when respeaking into the SpeakTitle Window.

**Vocabulary : Open Vocabulary Editor...**

Delete the following entries as they can cause problems in Wincaps Q4:
no space on (see below)
This article describes how to configure and control the Dragon speech engine when operating in integrated Dragon input mode.

In direct Dragon mode, the speech engine is integrated into Q4antum and respoken text is inserted directly into the current subtitle. The SpeakTitle Window is replaced by the Dragon control panel shown below:
The controls operate as follows. Note that where the description reads "Same as Dragon..." you should refer to the corresponding Dragon function for further information.

**Microphone on/off** - click this button to turn the microphone on and off. The button turns green when the microphone is on. Wincaps Q4 will start Dragon automatically (if necessary) when the microphone is turned on. You can also toggle the microphone on/off via the **Pause** key. Note that turning the microphone off will reset any persistent Dragon commands currently in effect (e.g. "All Caps On") and these will need to be reactivated after turning the microphone on again.

**Volume level display** - when the microphone is on, shows the current volume level of the voice input

**Status messages** - displays Dragon status and error messages

**Open user speech profile** - select the user speech profile to use and start/stop Dragon

**Corrector mode on/off** - enable correction mode during live subtitle transmission.

When active, the button will appear with a border thus: 

**Auto session save on/off** - toggle creation of DRA files (used for retraining). When active, the button will appear with a border thus:

**Dragon commands on/off** - toggle this button to enable/disable Dragon commands (e.g. "scratch that") which may sometime cause problems if enabled. When active, the button will appear with a border thus:

**Profile menu** - displays the following menu options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Same as Dragon Profile:</th>
</tr>
</thead>
<tbody>
<tr>
<td>New User Profile...</td>
<td>New User Profile...</td>
</tr>
<tr>
<td>Open User Profile...</td>
<td>Open User Profile...</td>
</tr>
<tr>
<td>Save User</td>
<td>Save User Profile</td>
</tr>
</tbody>
</table>
Profile...

Manage
Same as Dragon Profile: Manage User Profiles

Start Dragon
Start the speech engine.

Stop Dragon
Stop the speech engine. This will save workstation memory.

Vocabulary menu - displays the following menu options:

<table>
<thead>
<tr>
<th>Add New Word</th>
<th>Same as Dragon Vocabulary: Add new word or phrase...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Editor</td>
<td>Same as Dragon Vocabulary: Open Vocabulary Editor...</td>
</tr>
</tbody>
</table>

Audio menu - displays the following menu options:

<table>
<thead>
<tr>
<th>Playback</th>
<th>Same as Dragon Audio: Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read That</td>
<td>Same as Dragon Audio: Read That</td>
</tr>
<tr>
<td>Check Microphone...</td>
<td>Same as Dragon Audio: Check Microphone...</td>
</tr>
<tr>
<td>Improve recognition...</td>
<td>Same as Dragon Audio: Improve Recognition of word or phrase...</td>
</tr>
<tr>
<td>Read Text...</td>
<td>Same as Dragon Audio: Read text to improve accuracy...</td>
</tr>
<tr>
<td>Launch Accuracy tuning...</td>
<td>Same as Dragon Audio: Launch Accuracy Tuning...</td>
</tr>
</tbody>
</table>

Auto Session Save
When this option is enabled, all speech input produced during the current Wincaps Q4 session will be saved to a DRA file. DRA files are used to retrain Dragon. They contain a combination of the text and the audio recording which can be loaded into DragonPad and used to refine the voice model.

Note, this option places an additional load on the system, you may want to ensure that it is disabled during critical periods (e.g. when respeaking a live broadcast).

The DRA file will be created in the Dragon logs folder and will be named <filename>-YYYY-MM-DD-HH-MM.dra where <filename> is the name of the current W32/N32 file. The Dragon logs folder is located here:

C:\Users\<USERNAME>\AppData\Roaming\SysMedia\DragonLogs

The DRA file will be saved when Dragon is stopped or else when Wincaps Q4 exits. Wincaps Q4 will use a new DRA file each time Dragon is started. Note that if you are working with multiple documents, the log file will be named after the first document you open.

Respeak text via integrated Dragon input
This topic describes how to respeak text into Wincaps Q4 Offline using integrated Dragon input.

In this mode, the speech engine is integrated into Q4antum and respooken text is
inserted directly into the current subtitle. The SpeakTitle Window is replaced by the Dragon control panel.

**IMPORTANT:** You must configure Dragon NaturallySpeaking correctly for use with Wincaps Q4.

Wincaps Q4 has been tested in integrated mode with versions 11, 11.5 and 12.5 of Dragon NaturallySpeaking.

When working in this mode, Dragon should **not** be running. You should close Dragon if necessary before starting Wincaps Q4.

On startup, Wincaps Q4 will automatically load the last Dragon voice model that was used on the workstation. If necessary you should select your own voice model via the Dragon control panel.

The general procedure for entering spoken text using integrated Dragon input is as follows:

Select the List View

Check that automatic text splitting is toggled **on** via the button located on the file toolbar or via the **Ctrl L** keystroke

Activate House Styles to perform automatic text substitutions if desired

Select the subtitle where the newly respoken text should appear

Turn the microphone **on** via the Dragon control panel (microphone button turns green). This will start the Dragon speech engine if it is not already running

You can now begin speaking. After a short pause, the spoken text will start to appear at the end of the current subtitle. The spoken text will gradually build up in the current subtitle as you speak. You can edit or correct the text manually via the keyboard if desired.

When the buffer is full (or when you trigger a deliberate newline), Wincaps Q4 splits the current subtitle, peeling off a block of text at the start of the current subtitle to create a new subtitle. The input focus remains on the current subtitle and you can continue to respeak new text.

You can pause the speech input at any time by turning the microphone off. The speech engine will stay running in the background.

Note that respoken text is always ** appended** to the current subtitle, you cannot insert spoken text into the middle of existing text.

Note that it is not possible to select or correct text using Dragon's "select" or "correct" commands when working in direct mode.

When the microphone is active, you can use the normal keystrokes to change the foreground colour of the spoken text. If you do so, the colour change will take effect from the start of the next sentence.

If you use the macro hash commands to change the foreground text colour they will take effect immediately.

If you are using House Styles, you will see the substitutions being made as you speak. The replacement text will appear once the last word of the House Style plus a
space has been entered, or when you press the Return key or use the \#sendsubtitle macro.

If the Line break on colour option is enabled, Wincaps Q4 automatically inserts line breaks whenever the foreground colour changes. This ensures that the text for each speaker is placed on a new line.

Speech input with the Aligner
The procedure for creating and timing subtitles using direct Dragon speech input in conjunction with the Aligner is as follows:

In the List View, select the subtitle where the new text should be created (normally the last subtitle in the file). Check that automatic text splitting is toggled on and that the Aligner is enabled. Turn the microphone on. You are now ready to begin.

Pause the media just before start of the speech for the section and create a section start marker (i.e. press the SectionStart (Ins) key or say the \#sectionstart macro) Speak and/or type in the text for the section, using \#sendsubtitle or Return if required to split the subtitles. If you don't use Return, the system will automatically split the text at appropriate points.

Pause the media just after the end of speech for the section and press Return or say the \#sendsubtitle macro in order to split it. The system will split the text and leave you on a new blank subtitle.

Create a section end marker (i.e. press the SectionEnd (Del) key or say the \#sectionend macro. The system will put a section end marker after the last subtitle that contains text. The Aligner will automatically run in the background to align the section.

Pause the media just before start of the speech for the next section and create a section start marker (i.e. press the SectionStart (Ins) key or say the \#sectionstart macro
Continue as of step 2 above

Respeak Text via SpeakTitle Window

This topic describes how to respeak text via the SpeakTitle Window, located at the bottom of the List View. In this mode, all interaction between Wincaps Q4 and the speech software takes place through the SpeakTitle Window.
When the SpeakTitle Window has focus, its background colour changes to yellow for visibility.

⚠️ **Before using speech input via SpeakTitle, you should ensure that your speech engine is installed and working correctly. You can check this by respeaking some text into Windows Notepad.**

The general procedure for entering spoken text via the SpeakTitle Window is as follows.

1. Check that automatic text splitting is toggled on via the button located on the file toolbar or via the Ctrl L keystroke.
2. Select the subtitle where the newly respoken text should appear.
3. Give the input focus to the SpeakTitle Window.
4. Activate the microphone and begin speaking. After a short pause, the spoken text will start to appear in the SpeakTitle window. You will also see it appear in the current subtitle. At this stage the text is buffered, allowing you to review and correct any errors before committing the text to the file.
5. When the buffer is full (or when you trigger a deliberate newline), Wincaps Q4 splits the current buffer of text, possibly creating several new subtitles in the process. The buffer is then cleared so you can start inputting the next run of text.

You can use the keyboard to correct the text in the SpeakTitle window at any time before it is committed to the file.

A limited set of keyboard commands are available whilst the SpeakTitle window has
focus. You can use **PageUp** and **PageDown** to change the current subtitle. Full keyboard control of the video is also provided. You can use the normal keystrokes to change the position of the spoken text, including raising the subtitle. It is not possible to change justification when the SpeakTitle Window has focus.

You can use the normal keystrokes to change the foreground colour of the spoken text. If you do so, the colour change will change immediately in the file using the standard colour changing functionality. It is not possible to change the background colour when the SpeakTitle Window has focus.

If you use the macro hash commands to change the foreground text colour they will take effect immediately.

If you are using House Styles, you will see the substitutions being made as you speak. The replacement text will appear once the last word of the House Style plus a space has been entered, or when you press the **Return** key or use the **#sendsubtitle** macro.

If the Line break on colour option is enabled, Qu4ntum automatically inserts line breaks whenever the foreground colour changes. This ensures that the text for each speaker is placed on a new line.

**SpeakTitle Window Settings**

It is possible to alter the size of the text in the SpeakTitle window if required. Right click or use Alt+I to increase or Alt+D to decrease.

Text can also be cleared from the SpeakTitle Window using the Right click ‘Clear’ option or Alt+L.

Speech input with the Aligner

The procedure for creating and timing subtitles using speech input in conjunction with the Aligner is as follows:

In the List View, select the subtitle where the new text should be created (normally the last subtitle in the file). Set the input focus to the SpeakTitle Window. Check that automatic text splitting is toggled on and that the Aligner is enabled. You are now ready to begin.

Pause the media just before start of the speech for the section and create a section start marker (i.e. press the SectionStart (**Ins**) key or say the **#sectionstart** macro) Speak and/or type in the text for the section, using **#sendsubtitle** or **Return** if required to split the subtitles. If you don't use Return, the system will automatically split the text at appropriate points.

Pause the media just after the end of speech for the section and press **Return** or say the **#sendsubtitle** macro in order to split it. The system will split the text and leave you on a new blank subtitle.

Create a section end marker (i.e. press the SectionEnd (**Del**) key or say the **#sendsubtitle** macro in order to split it. The system will split the text and leave you on a new blank subtitle.
#sectionend macro. The system will put a section end marker after the last subtitle that contains text. The Aligner will automatically run in the background to align the section.

Pause the media just before start of the speech for the next section and create a section start marker (i.e. press the SectionStart (Ins) key or say the #sectionstart macro).

Continue as of step 2 above

**OPTION - Auto-insert section start marker:** Wincaps Q4 provides a user option that will automatically create a new section start marker whenever you create a new section end marker at the end of the file. If this option is enabled, Wincaps Q4 will automatically attach a new section start marker to the next (blank) subtitle. The timecode of the new section start marker will be the same as the previous section end marker, i.e. the new section will follow on immediately. Enabling this option may be more efficient for certain types of workflow. Note that this option only applies when you are entering text via the SpeakTitle Window. With the option enabled, the modified workflow is as follows:

Pause the media just before start of the speech for the section and create a section start marker (i.e. press the SectionStart (Ins) key or say the #sectionstart macro)

Speak and/or type in the text for the section, using #sendsubtitle or Return if required to split the subtitles. If you don't use Return, the system will automatically split the text at appropriate points.

Pause the media just after the end of speech for the section and press Return or say the #sendsubtitle macro in order to split it. The system will split the text and leave you on a new blank subtitle.

Create a section end marker (i.e. press the SectionEnd (Del) key or say the #sectionend macro. The system will put a section end marker after the last subtitle that contains text and a section start marker on the new blank subtitle. The Aligner will automatically run in the background to align the previous section.

If needed, pause the media just before start of the speech for the next section and update the position of the section start marker (i.e. press the SectionStart (Ins) key or say the #sectionstart macro). This is recommended if there is a gap of more than a few sections in the speech, otherwise you can skip this step.

Continue as of step 2 above

### Using the Aligner

The Aligner can significantly reduce subtitle preparation time for suitable programme material. Generally this is material which contains reasonably clear dialogue without invasive music and effects, where fairly uninterrupted runs of dialogue stretching to say 6-12 utterances are routinely achieved. If there are isolated sections where speech is difficult to distinguish from noise, these can be timed manually.

You can use the Aligner to assist with timecoding any sequence of subtitle texts, be they from a script import, typed from the keyboard, generated by speech recognition or transcribed by Stenograph. The principle is the same in all cases:

Identify a reasonably clear run of dialogue without long pauses (greater than 2-3 sec) and without significant invasive noise

Create or identify the corresponding subtitle texts

Mark the start and end of the dialogue at the start and end of the corresponding text sequence
The run of dialogue and text identified for alignment is called a section. Keystrokes or voice commands can be used to define the start and end of a section, these section markers are stored in the file and shown on the screen. You should always use the List View when working with the Aligner.

Originating text and aligning

If you are originating the text and aligning subtitles section-by-section, it is recommended to configure the Numpad ins/del keys pressed alone to control the section start/end marking. Set the current subtitle position to be the last subtitle in the file, and then the workflow is as follows:

Play the media until you identify the start of the next sequence of dialogue, then jump back and pause on or just before the start of speech - the position need not be exact. The green blocks in the media timeline give you a cue by showing when the next speech segment begins.

If you are originating from the keyboard, press the section start key, or if you are respeaking, say your chosen “section start” command. Either way, because you were on the last subtitle, the system will create a new subtitle and a cyan “section start” marker will appear at the current timecode. You can then type in or respeak the text. The display will be similar to that shown below:

![Image](image)

Note that this screen shot has been produced while respeaking via the SpeakTitle input window - there is no need to segment into separate subtitles unless you wish to, since the system will do this automatically using the text-splitting rules. If you are originating from the keyboard, you can either type into SpeakTitle window if you want automated text-splitting to occur or you can enter the text directly into subtitles. In both cases, automatic text splitting needs to be enabled via the button located on the file toolbar.

When the run of dialogue reaches a gap, or after about 12-16 subtitles as a sensible maximum, pause the media just after the end of the final utterance, and with the
current subtitle being the last in the sequence. If you are working in the SpeakTitle window, press Return to ensure the last sequence has been split. Then press the Section End key or respeak the “section end” command.

This adds an end marker to the previous non-blank subtitle (Section End normally works on the current subtitle but there is a special case where the current subtitle is blank and is the last in the file). The Aligner then runs, and when it finishes the section markers will be green (success) or yellow (fallback timecodes were calculated).

At this point you would then continue the process for the next speech segment. Remember that once the Aligner starts to run (section markers turn mauve) you do not need to wait for it to finish before you carry on with the creation of the next section.

Switching to the Timeline View in the above example we can see how the Timing Rules have been applied in order to conform the speech-aligned texts to the presentation style you wish to achieve.

**Aligner basics**

The Aligner is a powerful tool that can significantly reduce subtitle preparation time where suitable media is available. The Aligner operates in the background to automatically synchronise entire sections subtitles with the spoken dialogue. There is no need to grab individual In and Out times when using the Aligner. Instead, you simply define the start and end points of an entire section of dialogue and the Aligner will automatically set the In and Out times of each subtitle in the section for you, applying the Timing Rules as it goes.

You can use the Aligner to assist with timing any sequence of subtitle texts, be they from a script import, typed from the keyboard, generated by speech recognition, transcribed by Stenograph or downloaded from a Newsroom System (Q-Live only).

For best results, the media should contain reasonably clear dialogue without invasive music and effects and where fairly uninterrupted runs of dialogue stretching to say 6-12 utterances are routinely present. If there are isolated sections where speech is difficult to distinguish from noise, these can be timed manually in the normal way.

The following supported languages are available by default:

- Danish
- English
- French
- German
- Spanish

Additional languages are added periodically, contact Screen Systems Subtitling Support for further information.

If the Aligner is unable to successfully match the subtitle text against the audio track, it will assign fallback timings based on the word rate.
The Aligner supports a "cartoon voice" mode that gives improved results when aligning media containing high-pitched audio.

Timing toolbar
The **Timing toolbar** gives access to the Aligner functions as follows:

From left to right, the functions of the toolbar controls are as follows:

- **Clear section alignment** - clear the alignment status of all subtitles in the current section. The section markers will be reset to cyan (unaligned) and the aligner will be triggered automatically to realign the section.
- **Clear all sections** - as above, but clear all sections in the file (Toggle scene marker)
- **Enable/Disable Aligner** - toggle the Aligner on/off
- **Enable/Disable Cartoon Voice mode** - gives improved results with high-pitched audio

You should always use the List View when working with the Aligner.

The basic procedure for using the Aligner is as follows:

- Identify a reasonably clear run of dialogue without long pauses (greater than 2-3 sec) and without significant invasive noise
- Create or identify the corresponding subtitle texts
- Mark the start and end of the dialogue section at the start and end of the corresponding subtitle sequence
- As soon as you mark the end of the dialogue, the Aligner runs in the background to align the subtitles
- Repeat the above process for the next run of dialogue.

The run of dialogue and text identified for alignment is called a **section**. You can use keystrokes, voice commands or toolbar buttons to define the start and end of a section. These section markers are stored as part of the subtitle file.

Some general guidelines for using the Aligner are as follows:

For alignment to operate, the Aligner must be enabled via the toolbar
You should work in the List View. The input focus must be set to the subtitle list or the SpeakTitle window in order to be able to use the **Ins** and **Del** keys to create section start/end markers. Alternatively you can use the corresponding toolbar buttons or the #SectionStart / #SectionEnd macros
Section start markers should be placed just before the start of speech for that section. You can use the green rectangles in the media timeline to help determine where speech is present
Section end markers should be placed just after the end of speech for that section
Avoid gaps in speech of > 2-3 second within a section, i.e. split it into smaller sections instead
A section should contain no more than 12 or so subtitles
The Aligner will run automatically in the background whenever it detects that a valid pairing of start/end section markers have been added. However, it can also be triggered manually by pressing the **F11 key**
If Wincaps Q4 is unable to add a section marker for some reason then a warning will be displayed in the Messages pane of the Toolbox
Similarly, if an error occurs during the alignment process then a message will be displayed.

**Enable/Disable Aligner**

You can enable or disable the Aligner via the Timing toolbar. With the Aligner disabled, you can still add and remove section markers as normal but the aligner will not run automatically when a valid End Section marker is added and the section markers will remain cyan. When the Aligner is enabled again, any cyan (unaligned) sections will be processed immediately, starting from the top of the file.

**Cartoon Voice mode**

The Aligner supports a “cartoon voice” mode that gives improved results when aligning media containing high-pitched audio, e.g. cartoons. This mode is disabled by default but can be toggled on/off via the button on the Timing toolbar.

If you enable the button, the Aligner will slow down the audio track when aligning, thus producing better results for high-pitched voices. If the media contains a mixture of high-pitched and normal voices, you should ensure that you set the button appropriately.

**Section markers**

You should always use the List View when working with section markers. They are not displayed in other views.

Section markers are displayed as shown in the illustration below:
A section marker is always associated with a subtitle. A **Section Start** marker is shown above the subtitle and a **Section End** marker below. The media timeline displays indicators showing the precise positions of the section markers with respect to the media timecode.

The colour of a Section Marker pair indicates the alignment status for that section. The possible colours are:

- **Cyan** - not yet aligned
- **Magenta** - alignment in progress
- **Green** - alignment succeeded
- **Yellow** - alignment failed (fallback timings were used instead)
- **Red** - mismatched marker (should be deleted manually)

Add and remove section markers

You can use keystrokes, voice commands or toolbar buttons to define the **start** and **end** of a section. These commands **toggle** a section marker on or off for the current subtitle.

The default keystrokes for defining section markers in Edit Mode are as follows:

- **Section Start** - Numpad **Ins**
- **Section End** - Numpad **Del**

Note that alternative keystrokes may be configured to suit your personal preferences. The alternative keystrokes are always used in Fix Mode and in Q-Live.

The corresponding toolbar buttons are located on the File toolbar:

- ![Set or clear Section Start marker](image)
- ![Set or clear Section End marker](image)

To add a **Section Start** marker:

Select the first subtitle in the new section (i.e. make it the active subtitle)
Pause the media just before the start of speech for the corresponding dialogue
Insert the Section Start marker

To add a **Section End** marker:

Select the last subtitle in the new section (i.e. make it the active subtitle)
Pause the media just after the end of speech for the corresponding dialogue
Insert the Section End marker

If Wincaps Q4 is unable to add the section marker for any reason, the Messages pane will display a warning message.

There is a user option to automatically add a new section start marker when working at the end of the file. Note that you **must** be working at the end of the file for this option to work, i.e. you must only have a single blank subtitle at the end of the file.

To remove a section marker, simply select the subtitle with the section marker and
use any of the appropriate methods to toggle the section marker off.

Note that you can't remove a section start marker from the very last subtitle in the file/story as in this case the section start time is recaptured at the current media position rather than toggled off. To remove such a section marker you can create a new blank subtitle at the end of the file/story first, then PageUp and remove the unwanted section marker as normal.

Wincaps Q4 will try to ensure that section markers are created in a sensible way. For example, if you are working at the end of the file/story and you try to insert a new section start marker at an earlier timecode than the previous section end marker, Wincaps Q4 will not create the start marker and the messages window will report a warning as follows:

⚠️ The section time is less than the end of the previous section

If for some reason a section marker does get inserted out-of-sequence, the section indicator will be coloured red as shown below. If you see this problem you should correct it by deleting and recreating the bad section marker or else the automatic alignment may not work correctly.

Re-time/realign a section
Sometimes you may want to re-time a section that has already been aligned. For example, if you have subsequently edited some of the text or split/joined some of the subtitles. You can do this as follows:

Edit the subtitles in the section as desired
Select any subtitle in the section and use the Clear Section Alignment toolbar button or press the Ctrl Shift S key. The section start/end markers will be reset to cyan and the timecodes of all subtitles in the section will be set to floating
The Aligner automatically runs to re-time the section

⚠️ This operation cannot be undone except by restoring from the automatic backup

Re-time/realign the entire file or story
Sometimes you may want to realign the entire file (Offline) or current story (Q-Live), for example, if you have made changes to the timing rules. You can do this as follows:

Click the Clear All Sections toolbar button or select Tools : Unalign All Sections from the main menu. All section start/end markers in the file / story will be reset to cyan and the timecodes of all subtitles will be set to floating
The Aligner automatically runs to re-time the file

⚠️ This operation cannot be undone except by restoring from the automatic backup
Split a section
Sometimes you may want to split an existing section into two, for example if the section contains long pauses in speech. You can do this as follows:

Select the subtitle above the point at which you want to split the section
Pause the media at the start of the speech for that subtitle
Create a section start marker. The system will automatically create a section end marker after the previous subtitle
Select any subtitle in the first section and use the Clear Section Alignment toolbar button, press Ctrl Shift S or select Tools : Unalign Current Section from the main menu. The section start/end markers will be reset to cyan and the timecodes of all subtitles in the section will be set to floating
The Aligner automatically runs to re-time the section
Repeat step 4 for the second section
Clear all section markers
You can remove all section markers from the file (Offline) / current story (Q-Live) by selecting Tools : Clear All Section Markers from the main menu.

This operation cannot be undone except by restoring from the automatic backup

Manage House Styles

House Styles are lists of word and/or phrase substitutions that are active when entering text into the SpeakTitle window or during Speech input. House Styles are stored in the DataStore. A typical system may have many House Style lists (or topics) defined. Global and Programme House Styles are shared between all users of the system whereas User House Styles are only available to the user that created them. Each user of the system has their own individual set of active House Styles which may be freely selected from any of the three categories.

If you activate this topic, then Wincaps Q4 will automatically apply the listed substitutions whenever you enter text via the SpeakTitle window or direct speech input.

The "replace" portion of a house style is always stored as lower-case. The "with" portion is stored using the case you define. When Wincaps Q4 performs a substitution, the input match is case-insensitive but the resulting output uses the defined case. The exception is when the match text is all upper case. In this situation, the output will also be in upper case.

For example:

Replace "house of commons" with "House of Commons"

<table>
<thead>
<tr>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>house of commons</td>
<td>House of Commons</td>
</tr>
<tr>
<td>house of COMMONS</td>
<td>House of Commons</td>
</tr>
<tr>
<td>HOUSE OF</td>
<td>HOUSE OF</td>
</tr>
</tbody>
</table>
House Styles are managed via the Job Info pane of the Toolbox.

Click on the House Styles button or press the Ctrl Q key to display the House Styles Window where you can add, delete, edit, activate and deactivate House Styles.

A House Styles check is also available. This allows you to apply the currently active set of house styles to existing subtitles, for example after importing or inserting a file.

House Styles window
The House Styles window is shown below:

House Styles are grouped into three categories (profiles):

- **Global** - Available to all users, apply to all jobs
- **Programme** - Available to all users, each programme has its own distinct set of topics
- **User** - Available only to the current user, apply to all jobs

Select the desired category to view or edit using the drop-down list. Wincaps Q4 displays the currently active topics for the selected category in the box below.

Topics are displayed in the order in which they were activated, most recently activated at the bottom of the list. Note that the topic order is important when determining precedence. Use the Manage Topics... button to activate topics or create a new topic. Use the Remove Topic button to deactivate topics. Note that Wincaps Q4 allows you to marquee-select multiple topics for removal. Use the Edit Topic... button to add, delete or modify individual House Styles within the currently highlighted topic. Use the View... button to view the contents of the currently highlighted topic without locking it for other users.

If you choose to Edit a Global or Programme House Style topic, the system will lock that topic in the Main DataStore to prevent other users from modifying it at the same time. Consequently, you should keep your edits as short as possible. If you just want to check the contents of a House Style topic, use the View... button as this will not lock the topic.

If you try to edit a topic that is currently locked by another user you will see an error message informing you of that user's login name.

Each group has a special DEFAULT topic that is always active, i.e. it cannot be removed like the other topics.

Edit/View topics
Select a topic and click on the Edit... or View... buttons to display the list of contained House Styles as shown below:
House Styles are listed alphabetically. In edit mode, you can create, edit and delete House Styles as required.

To create a House Style, enter the word or phrase you wish to replace in Replace and the word or phrase you wish to replace with, in With and press the Add button.

To edit a House Style, highlight the entry you wish to change. Editing in the Replace field will give the option to Add and the original House Style will remain.

Editing in the With field will give the option to Replace and will overwrite the previous House Style.

To delete a House Style, highlight the entry and press Delete.

Manage topics
Use the Manage Topics... buttons to activate or create topics as shown below:

Available topics are listed alphabetically. The buttons work as follows:

**Activate Topic** - Activate the selected topic (or topics if marquee selection used). The topic(s) will be added to the bottom of the active list and hence will take priority for topic precedence

**Create Topic** - Create a new (empty) topic. Topic names are case insensitive and may contain spaces

**Delete Topic** - Delete the selected topic (or topics of marquee selection used)

**View Topic** - Display the contents of the selected topic in read-only mode

**Import Overwrite** - Import a list of House Styles into the selected topic from an external text file. Qu4ntum will prompt you for the name of the file to import. Note that any House Styles already existing in the topic will be replaced

**Export** - Export the list of House Styles in the selected topic to an external text file. Wincaps Q4 will prompt you for the name of the file to create, which will default to a .sfm extension

**Topic precedence**
If the same House Style exists in more than one category, the following rules of precedence apply:

**User** (top priority)

**Programme**

**Global** (lowest priority)

If the same House Style exists in more than one topic within the same category, the topic nearest the **bottom** of the list will take precedence, i.e. the DEFAULT topic (which is always at the top of the list) will have the lowest priority.

Note that when new topics are activated they are always placed at the bottom of the list, i.e. the last topic that you add will have the highest priority.

The **Report Clashes** option will flag up any duplicate House Styles and produce a report if duplicates are found;

Selecting ‘Yes’ displays a TXT file that shows the clashes and can be saved.

Use the **Print** button to produce a print out of the House Styles in a topic.

**Reference manual**

The Timing Rules are applied in sequence, so the effect of one rule may undo the effect of a previous rule. The sequence is chosen so that the most important rules are applied last.

If a given Timing Rule is disabled in the Timing Rules dialogue then it is not applied.

Some rules behave differently when the aligner is running compared to when the user grabs an individual timecode – noted in context below.

The rules have built-in sanity checking to prevent any action from causing a subtitle to go out of sequence or to end up with negative duration: this may explain why some user actions are refused. These restrictions do not apply in **Fix Mode**.

The rules do provide a narrative to explain what they are doing, and people should be encouraged to consult this narrative to see what the system is doing.
Parameters
The screenshot below shows the Timing Rules parameters that can be supplied by the user:

![Timing Rules Configuration](image)

Note that the values need to be reasonably self-consistent otherwise the results will not be as expected. For example:

The default text display rate should reflect the programme speech rate as modified by the expected editing percentage: if the programme is around 180wpm verbatim and the subtitlers are expecting to edit by around 10% maximum then a word rate of around 160wpm is sensible. Given the maximum number of subtitle rows plus the number of words per line on average, the nominal maximum duration can then be worked out.

If the programme has large numbers of short video sequences with lots of cuts, then the zone of influence of a given shot change should be shorter than for a programme with fewer cuts, otherwise the zones will tend to overlap.

Sequence
The processing sequence is as follows:

1) Sanity check
2) Section markers
3) Duration
4) Shot changes
5) Magnetism
6) Gaps
7) Addons

**Sanity check**
If the proposed timecode change would take the subtle out of sequence or give it a negative duration, then the change is ignored (does not apply in Fix Mode)
Section markers
When aligning, the subtitle at the start of a section should have an In time on or after the section start marker and within a defined distance of it. Similarly at the end of the section, the Out time must fall within a distance on or before the end marker. When sliding, a subtitle should not entirely pass out of the enclosing section.

Duration
If the duration is too short and there is space after the Out time, Out is extended to a limit of the next In. If duration is still too short and there is space before the In time, and only when aligning, In is reduced to a limit of previous Out. Otherwise report that the subtitle is hemmed in. If the duration is too long, reduce Out. Note that If the next In is floating or when working in Fix Mode, the Out time of the current subtitle is allowed to extend beyond it.

Shot changes
In time: Find the nearest shot changes before and after In for which In is in zone of influence. If In is already at correct distance after, do nothing. If only one shot change, clip to it unless a sequence error would occur. If between two shot changes, clip to the later one unless within 1/3 distance of the earlier in which case clip to that instead. Ignore any change if it takes the In time to within 5 frames of next In time or causes a sequence error. If aligning, re-check duration and refloat if now too short.
Out time: Find the nearest shot changes before and after Out for which Out is in zone of influence. If Out is already at correct distance before, do nothing. If only one shot change, clip to it unless a sequence error would occur. If between two shot changes, clip to the later one unless within 1/3 distance of the earlier in which case clip to that instead. Ignore any change if it causes a sequence error.

Magnetism
If the original gap before In or after Out was the minimum gap, deem boundary to be magnetic. If magnetic In is moved and previous Out is not explicit then move previous Out to follow it unless that would extend the previous duration to more than twice its float value (or 2 seconds, if float value is very small). If magnetic Out is moved and next In is not explicit then move next In to follow it unless that would extend the next duration to more than twice its float value (or 2 seconds, if float value is very small).

Gaps
In: The precedence rules are that an explicit In overrides a previous Out; an explicit previous Out overrides an In, otherwise a previous Out is overridden by a new In. If In changes then remove any overlap using above precedence and then reset the gap to prescribed minimum if too short or if in exclusion zone. If there is an intervening shot change then double the gap provided it would not create a sequence error.
Out: The precedence rules are that an explicit Out overrides a next In; otherwise Out is overridden by next In. If Out changes then remove any overlap using above precedence and then reset the gap to prescribed minimum if too short or if in exclusion zone. If there is an intervening shot change then double the gap provided it would not create a sequence error.

Add-ons
Allow for the special case of Add-ons where the Out times of all the subtitles in the Add-on sequence are the same

(AL v1.0 20/09/11) + 6888 + 7156 + 7157 + 7249
System types and licensing

Wincaps Q4 can be used in two main ways:

As a standalone system running on a single workstation
As part of a multi-user system, comprising several workstations networked together with a shared Main DataStore

A licensing scheme controls how many clients of each type may run concurrently and which optional features are available.

Standalone systems
In a standalone system, all Wincaps Q4 components are installed on a single workstation. There is no Main DataStore, instead the client operates using the local DataStore cache.

Standalone systems have a single fixed licence of the appropriate type (either Lite, Standard, Pro or Q-Live) enforced by a plug-in hardware key ("dongle) or else locked to the machine ID or licensed remotely via Cetus.

Multi-user systems
A multi-user Wincaps Q4 system consists of a number of client workstations networked together. A Main DataStore allows the clients to share information such as templates, house styles and spelling supplements. In this environment, roaming profiles can be configured to make each user's personal settings available on whichever Wincaps Q4 workstation they log on to.

Multi-user systems are normally configured to use a Licence Server. The License Server maintains a shared pool of Wincaps Q4 licences, allowing any Wincaps Q4 workstation to take on any role, subject to there being sufficient licences available.

Licensing configuration
Licensing is configured when you install the Wincaps Q4 client and the information is stored in system environment variables. There are two choices depending on whether or not your system has a Licence Server.

If your system has a License Server then the LSHOST system environment variable will contain the name of the Licence Server machine (or the main/standby pair if redundant licence servers are being used).

For example:

LSHOST=ALCOR   Single license server on ALCOR
LSHOST=DENEH~HA Redundant license servers on DENEH and HAZEL

If your client is operating standalone then licensing is controlled by a license file that is locked to either a USB "dongle" or the workstation ID.

In both cases, the installer will prompt you to select the license file which will then be copied into the Wincaps Q4 installation folder. The environment variables will be configured as follows:

LSHOST=NO-NET
LSERVRC=<full path and name of the
license file>

If Wincaps Q4 is unable to obtain a license for any reason at startup, it will exit with an error message. See the troubleshooting section for further information.

DataStore configuration
The DataStore configuration (i.e. Main DataStore or standalone operation using the local cache only) is chosen when you install the Wincaps Q4 client and the information is stored in the Windows registry.

Troubleshooting common problems

This article describes how to go about resolving some of the problems that you might encounter when using Wincaps Q4.

If Wincaps Q4 is not behaving as expected, there are some basic things you can check:

Look at the Messages Window - this is where Wincaps Q4 displays errors and warnings.
Look in the Windows Event Log - Wincaps Q4 logs error messages under Application and Services Logs -> WinCAPS Qu4ntum

Error 6

- Failed to Poll Licence - this is caused when Wincaps Q4 polls for the licence and checks that the dongle it is locked to is available, but cannot find it.

Common issue with dongles - try plugging the dongle into a different port, try reinstalling the drivers, which can be found on original installation disk or at this external link.

Error 4

- Licence not available - the usual cause of an issue like this is that the licence has expired, or the lock code of the PC and the lock code of the licence do not match.

Run the Rainbow report, this will confirm if a licence is loaded and what the expiry date is. The Rainbow report utility is located in the "Utilities" sub-folder in the Wincaps Q4 install area.

Error 1A Clock Tampering

- this is caused if the PC clock is altered when a time limited licence is installed. Contact Subtitling Support for assistance.
If you are connected to a licence server and the connection is lost for some reason (e.g. loss of network) then Wincaps Q4 will shut down after 10 minutes.
Video playback

See Media Basics for information on supported media. The issues below are typically due to the limitations of the native Direct Show and QuickTime playback engines. From 4.23.7 onwards there is an alternative playback engine using MediaLooks MultiFormat.

With Mpeg-1 or WMV media, confirm that the video plays in Media Player, with MOV and MP4 media, confirm that the video plays in QuickTime.

WMV issues are usually due to a lack of external graphics card (this is a pre-requisite) or poor video encoding.

Some MOV and MP4 issues are due to high resolution encodings, typically HD resolution. It is unlikely that the PC will be powerful enough for Wincaps Q4 to play them back.

Codec issues are rare, but 3rd party video playback software can cause issues. We advise against installing codec packs such as FFDShow and K-Lite as they can interfere with playback in Wincaps Q4.

Issues have been seen with ‘round midnight’ timecodes, i.e. where videos start before 00:00:00:00. One way of avoiding this problem is to change the timecode to 01:00:00:00 and subtract this at the end.

Text splitting

If text splitting or single sentence splitting is not working, reload the text splitting files. A message will appear to say that they have been loaded.

File Export

If the required export option is greyed out, make sure file personality is supported, for example, Closed Caption (Line 21) export options will be greyed out in Teletext and Open Caption personalites.

FCP and SAMI exports will not work if no video is associated with the subtitle file.

Qu4ntum uses different ‘flavours’ of STL export to match different systems. The purest Teletext export is the ‘Standard’ export, and this matches the spec. exactly. For Open Caption files, use the ‘Generic’ export.